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With lots of  outstanding advantages compared with other materials, steel is increasingly used in civil and industrial 
buildings. Over the past hundreds of  years, a vast majority of  researches on steel structure conducted in order to 
improve safety for the structure as well as decrease cost of  the building. To pursue the dream of  becoming the 
largest steel company in Vietnam and over the world, design department made effort continuously to both finish 
all projects on schedule and study and apply newest achievements over the world to buildings. Standards and 
documents from the most developed country in steel field America used to guarantee the stability of  the structure 
as well as strict requirements of  architects and weight from customers.
From the first design guide published in 2011 in this latest design guide, there are more additional theories and 
guidelines for constructing SAP model and calculating connection, mezzanine floors, loads for building, etc.…
according to the newest standards. In addition, many practical pictures, tables, serving for computing and calculating 
supplemented as well as mistakes are also updated and revised. The object of  this editing is to make a standard 
of  designing for all designers and support the other department to understand more about the processing of  the 
design department.
In the compilation process, mistakes cannot be avoided so it would be so helpful to receive any feedback from 
readers to more complete in the next edition.

Thanks and Best regards,

Chief  of  Approval Design, 

Mai Xuan Quang
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GENERAL INFORMATION
Introduction

Scope of the design manual

(1) The Design Department manual outlines the design process 
requirements of the BMB&A Standard in BMB&A J/S CO.
(2) The Design manual establishes rules and standards to ensure 
that parameters and figures are presented uniformly throughout 
in BMB&A J/S CO. 
(3) The design manual is binding for all Design Team, Estimator 
Team and Office in the BMB&A J/S CO.
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CHAPTER 1. MATERIALS 

CHAPTER 1. MATERIALS  -

1.1. Materials

1.2. Plates

Table 1 1 Material Specifications (unless indicated in drawings)

Materials

Built-up Member 

	  

Steel Plate For Connection	

Hot Rolled Member 	  

Cold Formed Light Gauge Shapes, Purlin

& Girt Bracing 

Roof Sheeting 	  

Decking	  

Checker Plate	

X - Bracing Rod 	  

X - Bracing Cable  	  

Bracing (Steel Pipe or Steel Angle)	

Anchor Bolt Grade 5.6

Machine Bolts for Purlin/Girt Connections	  

High Strength Bolt Grade 10.9

High Strength Bolt Grade 8.8	  

Minimum Flow Strength of Welding

Specifications 

(or equivalent)

ASTM-A572 GR50 (Q345) 	   

ASTM-A36 (Q235) 	  

ASTM-A572 GR50 (Q345) 	   

JIS G3101/SS400 	  

JIS G3302 (G450, Z275) 	  

ASTM A792M/755M 	 

JIS G3302	  

SS400	  

JIS G3101/SS400   	  

ASTM A416  	  

JIS G3101/SS400	  

TCVN 1916-1995	  

DIN 933 TYPE 4.6	  

DIN 933 TYPE 10.9	  

DIN 933 TYPE 8.8	  

AWS A5.17 & AWS A5.20 (E60XX)

Minimum Strength

= 234.5 /Fy kN cm
223.5 /Fy kN cm=
234.5 /Fy kN cm=
223.5 /Fy kN cm=
245.0 /Fy kN cm=

230.0 /Fy kN cm=
223.5 /Fy kN cm=
223.5 /Fy kN cm=

240 /Fu kN cm=
254 /Fu kN cm=

223.5 /Fy kN cm=
250 /Fu kN cm=
240 /Fu kN cm=

2100 /Fu kN cm=
280 /Fu kN cm=

234.5 /Fy kN cm≥

Thickness (mm) Order Size (m) Specifications

3 14 35 W =  1m; 1.5m; 2m; 2.5m; 3m
L = 6m; 9m; 12m

ASTM-A572 Gr50 (Q345)
ASTM-A36 (Q235)4 16 40

5 18 50

6 20 52

8 22 55

10 25

12 30
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1.3. Hot Roll Members
Refer Appendix A for more sections.

Type (mm)

I section

Tube

Channel

Angle

Pipe

Order size (mm)

IPE 150x75x5x7

IPE 200x100x5.5x8

IPE 200x200x8x12

IPE 250x125x6x9

IPE 300x150x6.5x9

IPE 300x300x10x15

IPE 400x200x8x13

 100x100x2.5

 150x150x2.8/3.5

 200x100x2.8

U 100x50x5x7.5

U 125x65x6x8 

U 150x75x6.5x10 

U 200x73x6.5x8

U 200x73x8.5x10

U 250x78x7x11

V 50x50x5/6

V 60x60x5

V 63x63x5/6

V 75x75x6/7

V 90x90x6/7

V 100x100x8/10

Ø 22x2.0

Ø 32x2.0

Ø 42x3.2

Ø 60x3.0

Ø 90x2.0/2.3/3.0/3.2/4.0

Ø 114x2.5/2.9/3.18/3.96

Ø 141x3.96

Ø 168x3.96

Ø 219x4.78

Ø 273x6.35

Usage

Wind column, end wall rafter, mezzanine 

joist, & sub-structure

EB bracing, man door/ window/ shutter 

door frames, sub-structure

Joist

A Cap channel for crane beams, a stringer 

for the staircase

Flange braces, X bracing & open web joist 

members

Steel handrail

X bracing, Space frame, diagonal member
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1.4. Cold Form Sections

(*) Not available at Hung Yen Factory.

Sym.

C100

C120

C150

C150

C150

C180

C180

C200

C200

C200

C200

C250

C300

Z150

Z150

Z175

Z175

Z200

Z200

Z200

Z250

Z250

Z300

Z300

WB-WT

50*

50*

50*

65

75*

50*

65

50*

65

70*

100*

65

65

50-56

62-68*

50-56

62-68*

50-56*

62-68

72-78*

62-68

72-78*

62-68

72-78*

1.5

2.593

2.833

3.193

3.553

3.793

3.553

3.913

3.793

4.153

4.273

4.993

4.753

-

3.265

3.553

3.553

3.853

3.853

4.153

4.393

4.753

4.993

-

-

1.8

3.111

3.399

3.831

4.263

4.552

4.263

4.696

4.552

4.984

5.128

5.992

5.704

6.424

3.918

4.263

4.263

4.624

4.624

4.984

5.272

5.704

5.992

6.424

6.712

2

3.457

3.777

4.257

4.737

5.057

4.737

5.217

5.057

5.537

5.697

6.658

6.338

7.138

4.353

4.737

4.737

5.137

5.137

5.537

5.857

6.338

6.658

7.138

7.458

2.3

3.975

4.344

4.896

5.448

5.816

5.448

6.000

5.816

6.368

6.552

7.656

7.288

8.208

5.006

5.448

5.448

5.908

5.908

6.368

6.736

7.288

7.656

8.208

8.577

2.5

4.321

4.721

5.321

5.922

6.322

5.922

6.522

6.322

6.922

7.122

8.322

7.922

8.922

5.441

5.922

5.922

6.422

6.422

6.922

7.322

7.922

8.322

8.922

9.322

2.8

-

-

-

-

-

-

-

7.080

7.752

7.976

9.321

8.873

9.993

-

-

-

-

7.192

7.752

8.200

8.873

9.321

9.993

10.441

3

-

-

-

-

-

-

-

7.586

8.306

8.546

9.987

9.506

10.707

-

-

-

-

7.706

8.306

8.786

9.506

9.987

10.707

11.187

Thickness/Quantity (kg/m)
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1.5. Sheeting

Type Usage

Seam

Roof panel

Clicklock

Roof + Wall

5 Ribs Panel 

Roof panel

Wall panel

Specifications

G300

G500 

G500 

Order size (mm)

480480

65

71 65 65 65 6526 26 26 71
480

65
24

R2

R2

R2

22
63

14

20 20 20

3

315 315315

41

250 250 250 250

1000

32

230yF kN cm=

= 250yF kN cm

= 250yF kN cm
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7 Ribs panel 

Roof, wall panel

9 ribs panel

Wall panel

11 ribs panel

Wall panel

Skylight

Roof, wall panel

G500 

G500

G300 

Size 940

Size 470

230yF kN cm=

= 250yF kN cm

= 250yF kN cm

= 250yF kN cm

= 250yF kN cm
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1.6. Slab 

Type 

Decking 

Checker

Grating

Specifications

JIS G3302 

SS400 

Order size (mm)

 

Thickness: 0.75, 0.95, 1.15mm.

 

Thickness: 4, 5, 6, 8mm

Typical size: 32x5 space 40mm

 

Other sizes:

25×3 space 30mm; 25×4 space 40mm; 25×5 space 30mm

30×3 space 30mm; 30×5 space 30mm; 

40×3 space 30mm; 40×5 space 30mm

A

223.5yF kN cm=

223.5yF kN cm=
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1.7. Bolts

Cast-in 

Anchor 

Bolt

Post-

installed 

Anchor 

Bolt

Machine 

bolt

High 

strength 

bolt

Type

Headed bolt

 

& Hooked bolt

  

Chemical bolt

 

Expansion bolt

 

Usage

Anchor bolt for 

end wall frame 

& partitions, 

column bases

Anchor bolt 

for mainframe 

& mezzanine 

column bases

Anchor bolt 

for partitions 

& stair column 

bases

Connect to RC 

column

Purlin/girt 

connection

Mainframe 

connection

Specifications

TCVN 1916-1995

(Grade 5.6)

 

(Grade 4.6)

 

 

DIN 933 Grade 4.6

DIN 933 Grade 8.8

DIN 933 Grade 

10.9

Bolt

diameter

(mm)

M16

M20

M24

M27

M30

M36

M42

M48

M16

M20

M24

M27

M30

M12

M16

M20

M12

M16

M20

M24

M27

M30

M36

Order

length

(mm)

400

500

600

700

800

900

1000

1200

190

260

300

340

380

106

145

184

60

70

90

90

100

100

CHAPTER 1. MATERIALS  -

223.5yF kN cm=

223.5yF kN cm=

= 250uF kN cm

= 240uF kN cm
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1.8. Bracing

Type 
(mm)

Order size 
(mm)

Tension 
strength (kN) Usage Specifications

Rod Ø16

Ø20

2Ø16

Ø25

2Ø20

30.16

47.12

60.32

73.63

94.25 X-bracing in roof  and 
wall

JIS G3101/SS400
240uF kN cm=

Cable Ø16

Ø20

2Ø16

Ø25

2Ø20

40.72

63.62

81.43

99.4

127.23

ASTM A416
254uF kN cm=
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CHAPTER 2. CODES AND LOADS
2.1. Codes and Manuals

2.2. Design Loads

2.2.1. Dead load (DL)

CHAPTER 2. CODES AND LOADS -

The Pre-Engineered Building described in these calculations was designed according to the latest U.S.A. Buildings 
and Design Codes that have been referred to in the design:
1.	 “Minimum Design Loads for Buildings and Other Structures”, ASCE 7-10.
2.	 “International Buildings Code”, IBC– 2012.
3.	 “Metal Building Systems Manual 2012” issued by MBMA.
4.	 “American Institute of  Steel Construction” - Allowable Stress Design, AISC 360-10.
5.	 Cold formed components have been designed in accordance with:
	 “American Iron and Steel Institute” Cold Formed Steel Design Manual, AISI S100-2007
6.	 Welding has been applied in accordance with:
	 “American Welding Society”, AWS-2010.
7.	 Wind speed & live load for Vietnam Project has been applied in accordance with: 
	 “Load and Effects - Design Standard” TCVN 2737:1995.
8.	 Earthquake load has been considered in accordance with:
	 “Uniform Building Code”, UBC 1997 Edition.
The above codes are to be used for the design of  buildings by BMB&A design engineers unless otherwise specified 
in the Contract Information Form.

BMB&A Pre-Engineered Buildings are designed according to ASCE 7-10.

Dead Load on Roof  Sheeting
This includes the self-weight of  rigid frames and imposed dead load due to secondary elements like roof  sheeting, 
purlins, insulation…
Following are some standard dead loads (in kN/m2) as below:

* Calculate manually dead load when using 2 layers insulation and purlin spacing is smaller than 1.2 m

Purlin spacing Insulation DL (kN/m²)

1.2m>  1 layer of  (Fiberglass/Air bubble/PE/Sandwich) 0.10

1.2m>

 2 layers of  (Fiberglass/Air bubble/PE/Sandwich)
 PU (2 layers sheeting) 
 Rock Wool 

0.15

 1 layer of  (Fiberglass/Air bubble/PE/Sandwich)* 0.15

Fiberglass Air Bubble PU (Poly Urethane)

≤1.2m
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Figure 2.1 Types of Insulation

Mezzanine dead load
Concrete slab (in kN/m2)
Decking panel/ Checker plate/ Grating (in kN/m2)
Finishing (in kN/m2)
Wall load on beams, joists (in kN/m)
Stair/ elevator (in kN)
These values are determined depending on the specific weight & the sizes of  material.
Following are some specific weight that BMB&A is used to calculate:

2.2.2. Collateral load (AL)
Collateral load here means superimposed dead load (in kN/m2) includes:
	 Ceiling (Gypsum board)
	 HVAC duct
	 Lighting fixtures
	 Sprinklers
Besides, some collateral systems (such as HVAC duct, sprinklers) have live load; we calculate them into live 
load (LL).

PE (Poly Ethylene) Sandwich Rock Wool

Material Uniform Load

Reinforced concrete 25.00 kN/m³

Brick wall 18.00 kN/m³

Tempered glass 25.00 kN/m³

Solar cell 0.23-0.27 kN/m²

Grating 0.45-0.82 kN/m²

Insulation

Fiberglass thickness 50mm/ 100mm 0.12 ÷ 0.24 kN/m³

Air bubble P2/A2 0.002 ÷ 0.004 kN/m²

PE foam thickness 5mm 0.20 ÷ 0.30 kN/m³

Sandwich 0.16 kN/m³

Rock wool 0.27-0.35 kN/m³

PU thickness 50mm 0.38-0.40 kN/m³

Sheeting thickness 0.45mm 0.05 kN/m²
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2.2.3. Live load
Roof  live load (LLr)
The roof  live load is used to design purlin, depends on the tributary area of  rigid frames. It includes the weight of  
labor & accessary to install, repair the roof.

Refer to ASCE 7-10, Table 4-1 Minimum Uniformly Distributed Live Loads, L0, and Minimum Concentrated Live Loads. 
For built-up frames, minimum uniformly distributed live load on the roof  is 1.0 kN/m2. ASCE 7-10 section 4.8.2 
allows the use of  0.57kN/m² as live load for roof  and purlins. Roof  live loads as per other building codes should 
be verified before proceeding with your design. Some customers/consultants may require pattern loading in live 
load applications.

Live load on frame (LL)
Refer to TCVN 2737:1995 (Load and Effects - Design Standard), section 4.3.1, minimum uniformly distributed live load 
on the frame is 0.3 kN/m2.

Mezzanine live load (FL)
For floor loads of  different occupancy, refer to CHAPTER 6. MEZZANINE FLOOR DESIGN.

Country

United States

Vietnam

Thailand

Myanmar

Cambodia

Indonesia

Philippines

Code

ASCE 7-10

TCVN 2737:1995

~ ASCE 7-10

MNBC 2016 ~ ASCE 7-10

~ ASCE 7-10

~ ASCE 7-10

NSCP 2015 ~ ASCE 7-10

LL on roof (kN/m2)

0.57 - 1

0.57

0.57

0.57

0.57

0.57

0.75-1.00

LL on frame (kN/m2)

0.57 - 1

0.3

0.3

0.3

0.3

0.3

0.6

CHAPTER 2. CODES AND LOADS -
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2.2.4. Wind load (WL)
The wind load pressure is determined  in accordance with Chapter 26-Chapter30, ASCE 7-10. Wind loads are 
governed by wind speed, roof  slope, wave height and open wall conditions of  the building. BMB&A’s steel 
buildings are not designed for a wind speed less than 110 km/h.  

Wind load on frame W  depends on importance factor wI .

Where: - W = wind design pressure on frame

- zq  = velocity pressure evaluated at height z above ground (N/m2);
2 20.613 ( / )z z zt dq K K K V N m= × × × ×  ; V  in m/s.	 (27.3-1, ASCE 7-10)

- pfGC = product of  the equivalent external pressure coefficient and gust-effect factor to be used in 
determination of  wind loads for MWFRS of  low-rise buildings

- piGC = product of  the internal pressure coefficient and gust-effect factor to be used in determination of  wind 
loads for buildings
- B = bay spacing (m)

( )W z pf piq GC GC B= × − ×

Figure 2.4 Outline of process for determining Wind load
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Risk categorization
Building and other structures shall be classified, based on the risk to human life, health, and welfare associated 
with their damage or failure by nature of  their occupancy or use, refer to Table 1.5-1, ASCE 7-10 for purposes 
of  applying flood, wind, snow, earthquake, and ice provisions. Each building or other structure shall be assigned 
to the highest applicable risk category or categories.

 Buildings and other structures containing toxic, highly toxic, or explosive substances shall be eligible for 
classification to a lower Risk Category if  it can be demonstrated to the satisfaction of  the authority having 
jurisdiction by a hazard assessment as described in Section 1.5.2 ASCE 7-10 that a release of  the substances is 
commensurate with the risk associated with that Risk Category.

Table 2 1 Risk Category of Buildings and Other Structures in Flood, Wind, Snow, Earthquake, and Ice Loads (Table 1.5-1, 
ASCE 7-10)

Use or Occupancy of Buildings and Structures

Buildings and other structures that represent a low risk to human life in the 
event of failure

All buildings and other structures except those listed in Risk Categories I, III, 
and IV

Buildings and other structures, the failure of which could pose a substantial risk 
to human life.
Buildings and other structures, not included in Risk Category IV, with potential 
to cause a substantial economic impact and/or mass disruption of day-to-day 
civilian life in the event of failure.
Buildings and other structures not included in Risk Category IV (including, but 
not limited to, facilities that manufacture, process, handle, store, use, or dispose 
of such substances as hazardous fuels, hazardous chemicals, hazardous waste, 
or explosives) containing toxic or explosive substances where their quantity 
exceeds a threshold quantity established by the authority having jurisdiction 
and is sufficient to pose a threat to the public if released.

Buildings and other structures designated as essential facilities.
Buildings and other structures, the failure of which could pose a substantial 
hazard to the community.
Buildings and other structures (including, but not limited to, facilities that 
manufacture, process, handle, store, use, or dispose of such substances as 
hazardous fuels, hazardous chemicals, or hazardous waste) containing
sufficient quantities of highly toxic substances where the quantity exceeds 
a threshold quantity established by the authority having jurisdiction to be 
dangerous to the public if released and is sufficient to pose a threat to the 
public if released. a
Buildings and other structures required to maintain the functionality of other 
Risk Category IV structures.

Risk Category

I

II

III

IV

a
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Wind Importance Factor, I

1.00

1.00

1.00

1.00

Seismic Importance Factor, I

1.00

1.00

1.25

1.50

Minimum design loads for structures shall incorporate the applicable importance factors given in Table 1.5-2, 
ASCE 7-10.

Exposing categories 1

Table 2 2 Risk Category of Buildings for different codes

Table 2 3 Importance Factors by Risk Category of Buildings and Other Structures for Snow, Ice, and
Earthquake Loads

Table 2 5 Comparison of Exposure between TCVN2737 and ASCE7-10 Standard Codes

  1ASCE 7-10, Section 26.7.3.

Table 2 4 Exposure Categories

a

w e

Country

United States

Vietnam

Thailand

Myanmar

Cambodia

Indonesia

Philippines

Risk Category

I

II

III

IV

 

TCVN2737:1995

ASCE7-10

Unobstructed areas

A

D

Rural areas

B

C

Urban areas

C

B

Exposure

B

C

D

Code

ASCE 7-10 (Table 1.5-1)

TCVN 9386:2012

(Appendixes E, F)

~ ASCE 7-10

MNBC 2016 (Table 3.1.2)

~ ASCE 7-10 (Table 1.5-1)

~ ASCE 7-10 

NSCP 2015 (Table 103-1)

Risk category

I

IV

I

I

I

I

V

II

III, II

II

II

II

II

III, IV

III

I

III

III

III

III

II

IV

Special

IV

IV

IV

IV

I

Description

Urban and suburban areas, wooded areas, or other terrain with numerous 

closely spaced obstructions having the size of single-family dwellings or larger.

Open terrain with scattered obstructions having heights generally less than 30ft 

(9.1 m). This category includes flat open country and grasslands.

Flat, unobstructed areas and water surfaces. This category includes smooth mud 

flats, salt flats, and unbroken ice.

For a site located in the transition zone between exposure categories, the category, resulting in the largest wind 
forces shall be used.
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Basic wind speed V
Basic wind speed depends on every national standard. So we need to convert it into the value V50y,3s in ASCE 
7-10 with design 3-second gust wind speeds (m/s) at 10m above ground for Exposure C. In this manual, we will 
summarize by below table.

Example
Vietnam Location: converting 20 years return period to 50 years return period by following a formula:

According to the above diagram, we see 

Thailand Location: If  converting gust duration from 1h to 3s.
See Figure C26.5-1 (ASCE 7-10). Maximum speed average over ts to hourly wind speed

(C26.5-2, ASCE 7-10)

50y,3s

Table 2 6 Wind return period for different codes

Figure 2.5 Converting gust duration diagram

Country

United States

Viet Nam

Thailand

Myanmar

Cambodia

Indonesia

Philippines

Code

ASCE 7-10

TCVN 2737:1995

~ ASCE 7-10

MNBC 2016 ~ ASCE 7-10

~ ASCE 7-10

~ ASCE 7-10

NSCP 2015 ~ ASCE 7-10

T years return period

50

20

50

50

50

50

Search PHL map in NSCP 2015

Gust duration

3s

3s

1h

3s

3s

3s

( )
50

0.36 0.1 ln 12TV T
V

= + ×

( ) ( )20 20
50

50

0.36 0.1 ln 12 0.36 0.1 ln 12 20 0.908
0.908

V VT V
V

= + × = + × × = → =

3
3 1

1

1.52 1.52s
s h

h

V V V
V

= → =
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Velocity pressure conversion factor:

→  Design wind speed:

Design wind speed VTy,3s

Using the Figure 26.5-1A, 1B, 1C ASCE 7-10 to determine the design wind speed, it depends on risk category of  
building

(C26.5-2, ASCE 7-10)

Table 2 7 Design wind returns period

T year return period

(ASCE 7-10)

50

50

50

Design T year return 

period

300

700

1700

Gust duration

3s

3s

3s

Risk category 

of building

I

II

III, IV

( ),3

50 ,3

0.36 0.1 ln 12Ty s

y s

V
T

V
= + ×

( ),3 50 ,3 0.36 0.1 ln 12Ty s y sV V T= × + ×  
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Velocity pressure exposure coefficient Kz
According to Table 27.3-1, ASCE 7-10, Velocity pressure exposure coefficient Kz depends on exposure and 
height of  building above the ground. 

NOTE
1. The velocity pressure exposure coefficient Kz may be determined from the following 
formula:

	 For  15 . gft z z≤ < ,  ( )2
2.01z gK z z

α
=  		

	 For  15 .z ft< ,   ( )2
2.01 15z gK z

α
=

2. α   and gz   are tabulated in Table 26.9.1 – ASCE 7-10.
3. Linear interpolation for intermediate values of  height z is acceptable.
4. Exposing categories are defined in Table 2 4.

Table 2 8 Velocity pressure exposure coefficients, Kh and Kz (Table 27.3-1, ASCE 7-10)

Height above ground level, z

(m)

0-4.6

6.1

7.6

9.1

12.2

15.2

18.0

21.3

24.4

27.4

30.5

36.6

42.7

48.8

54.9

61.0

76.2

91.4

106.7

121.9

137.2

152.4

Exposure

B

0.57

0.62

0.66

0.70

0.76

0.81

0.85

0.89

0.93

0.96

0.99

1.04

1.09

1.13

1.17

1.20

1.28

1.35

1.41

1.47

1.52

1.56

C

0.85

0.90

0.94

0.98

1.04

1.09

1.13

1.17

1.21

1.24

1.26

1.31

1.36

1.39

1.43

1.46

1.53

1.59

1.64

1.69

1.73

1.77

D

1.03

1.08

1.12

1.16

1.22

1.27

1.31

1.34

1.38

1.40

1.43

1.48

1.52

1.55

1.58

1.61

1.68

1.73

1.78

1.82

1.86

1.89
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Topographic factor Kzt
The topographic factor for the site ztK  is taken to be 1 in most cases. For more detail, see Section 26.8.1 ASCE 7-10.

Wind directionality factor Kd
Wind directionality factor dK  depends on type & shape of  the building, see table below.

Gust effect factor
The gust-effect factor for a rigid building or low-rise building is permitted to be taken as 0.85.
For flexible or dynamically sensitive building or high-rise building, calculate G value according to section 26.9 
ASCE 7-10.
Enclosure classification
For the purpose of  determining internal pressure coefficients, all buildings shall be classified as enclosed, partially 
enclosed, or open

Table 2 9 Wind Directionality Factor, Kd (Table 26.6-1, ASCE 7-10)

Structure type

Buildings

Main wind force resisting system

Components and cladding

Arched roofs

Chimneys, tanks, and similar structures

Square

Hexagonal

Round

Solid freestanding walls and solid freestanding and attached signs

Open signs and lattice framework

Trussed towers

Triangular, square, rectangular

All other cross sections

Enclosed Building

Partially Enclosed 

Building

Open Building

A building that does not comply with the requirements for open or partially 

enclosed buildings

A building that complies with both of the following conditions:

1. The total area of openings in a wall that receives positive external pressure 

exceeds the sum of the areas of openings in the balance of the building 

envelope (walls and roof ) by more than 10%.

2. The total area of openings in a wall that receives positive external pressure 

exceeds 4 ft² (0.37 m²)

A building having each wall at least 80% open. This condition is expressed for 

each wall by the equation  0.8o gA A>  , where:

oA   = total area of openings in a wall that receives positive external pressure. 

gA   = the gross area of that wall in which A  is identified.

Directionality factor Kd

0.85

0.85

0.85

0.90

0.95

0.95

0.85

0.85

0.85

0.95

0
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Internal pressure coefficient (GCpi)
Internal pressure coefficients, (GCpi), shall be determined from Table 26.11-1 ASCE 7-10 based on building 
enclosure classifications.

NOTE:
1. Plus and minus signs signify pressures acting toward and away from the internal 
surfaces, respectively. 
2. The values  of  (GCpi) shall be used with qz or qh as specified. 
3. Two cases shall be considered to determine the critical load requirements for the 
appropriate condition:

(i) A positive value of  (GCpi) applied to all internal surfaces 
(ii) A negative value of  (GCpi) applied to all internal surfaces

Table 2 10 Internal pressure coefficients, GCpi (Table 26.11-1, ASCE 7-10)

GC

0.00

+0.55

-0.55

+0.18

-0.18

Enclosure classification

Open buildings

Partially Enclosed Buildings

Enclosed Buildings

pi

2.2.5. Crane load (CR)

2.2.6. Earthquake

2.2.6.1 Seismic design concept

Crane loads are determined using the crane data available from the crane manufacturer. Crane data include wheel 
load, curb weight, crane weight, wheelbase, ends hook approach (used when two cranes operate in one aisle) and 
minimum vertical and horizontal clearances.
Refer CHAPTER 5. CRANE SYSTEMS DESIGN for more detail.

An effective seismic design generally includes:
1.	 Selecting an overall structural concept, including the layout of  a lateral-force-resisting system that is 
appropriate to the anticipated level of  ground shaking. This includes providing a redundant and continuous 
load path to ensure that a building responds as a unit when subjected to ground motion2.	 Determining code-
prescribed forces and deformations generated by the ground motion, and distributing the forces vertically to the 
lateral-force-resisting system. The structural system, configuration, and site characteristics are all considered when 
determining these forces.
3.	 Analysis of  the building of  the combined effects of  gravity and seismic loads to verify that adequate vertical 
and lateral strength and stiffness are achieved to satisfy the structural performance and acceptable deformation 
levels prescribed in the governing building code.
4.	 Providing details to assure that the structure has the sufficient inelastic deformability to undergo fairly 
large deformations when subjected to a major earthquake. Appropriately detailed members possess the necessary 
characteristics to dissipate energy by inelastic deformations.
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2.2.6.2 Structural Response

2.2.6.3 Load path

If  the base of  a structure is suddenly moved, as in a seismic event, the upper part of  the structure will not respond 
instantaneously but will lag because of  the inertial resistance and flexibility of  the structure. The resulting stresses 
and distortions in the building are the same as if  the base of  the structure was to remain stationary while time-
varying horizontal forces are applied to the upper part of  the building. These forces, called inertia forces, are equal 
to the product of  the mass of  the structure times acceleration, i.e., F = ma (the mass m is equal to weight divided 
by the acceleration of  gravity, i.e., m = w/g). Because earthquake ground motion is three-dimensional (one vertical 
and two horizontal), the structure, in general, deforms in a three-dimensional manner. Generally, the inertia forces 
generated by the horizontal components of  ground motion require greater consideration for seismic design since 
adequate resistance to vertical seismic loads is usually provided by the member capacities required for gravity load 
design. In the equivalent static procedure, the inertia forces are represented by equivalent static forces.

Buildings are generally composed of  vertical and horizontal structural elements.
The vertical elements commonly used to transfer lateral forces on the ground are:
	 1) Shear walls;
	 2) Braced frames;
	 3) Moment-resisting frames.
The horizontal elements that distribute lateral forces to the vertical elements are:
	 1) Diaphragms, such as floor and roof  slabs;
	 2) Horizontal bracing that transfers large shears from discontinuous walls or braces.
The seismic forces that are proportional to the mass of  the building elements are considered to act as 
their centers of  mass. All of  the inertia forces originating from the masses on and off  the structure must 
be transmitted to the lateral-force-resisting elements, and then to the base of  the structure and into the 
ground.
A complete load path is a basic requirement for all buildings. There must be a complete lateral-force-
resisting system that forms a continuous load path between the foundation, all diaphragm levels, and all 
portions of  the building for proper seismic performance. The general load path is as follows. Seismic 
forces originating throughout the building, mostly in the heavier mass elements such as diaphragms, are 
delivered through connections to horizontal diaphragms; the diaphragms distribute these forces to vertical 
force-resisting elements such as shear walls and frames; the vertical elements transfer the forces into the 
foundation; and the foundation transfers the forces into the supporting soil.
If  there is a discontinuity in the load path, the building is unable to resist seismic forces regardless of  
the strength of  the elements. Interconnecting the elements needed to complete the load path is necessary 
to achieve good seismic performance. Examples of  gaps in the load path would include a shear wall that 
does not extend to the foundation, a missing shear transfer connection between a diaphragm and vertical 
elements, a discontinuous chord at a diaphragm’s notch, or a reentrant corner, or a missing collector.
A good way to remember this important design strategy is to ask yourself  the question, “How does the 
inertia load get from here (meaning the point at which it is generated) to there (meaning the shear base of  
the structure, typically the foundations)?”
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2.2.6.4 The design base shear according to UBC 97

2.2.6.5 Seismic coefficient (Cv, Ca)

The total design base shear in a given direction shall be determined following section 1630.2 UBC 97:

vC IV W
R T
×

= ×
×  

(kN)

Besides, V value must be satisfied below equation:

 2.5
0.11 v a

a
C I C IC I W V W W
R T R
× ×

× × ≤ = × ≤ ×
×

For seismic zone 4, the total design base shear shall also not be less than the following:

 0.8 vZ N IV W
R
× ×

≥ ×

The seismic coefficient is determined by Table 2 11 and Table 2 12, it depends on soil profile type (Table 2 13) and 
seismic zone factor Z (Table 2 15).

Table 2 11 Seismic coefficients, Cv (Table 16-R, UBC 97)

Table 2 12 Seismic coefficients, Ca (Table 16-Q, UBC 97)

Seismic zone factor, Z

Refer to site-specific Geotechnical investigation and dynamic site response 

analysis to determine Cv

Z=0.075

0.06

0.08

0.13

0.18

0.26

Z=0.075

0.06

0.08

0.09

0.12

0.19

Z=0.15

0.12

0.15

0.25

0.32

0.50

Z=0.15

0.12

0.15

0.18

0.22

0.30

Z=0.2

0.16

0.20

0.32

0.40

0.64

Z=0.2

0.16

0.20

0.24

0.28

0.34

Z=0.3

0.24

0.30

0.45

0.54

0.84

Z=0.3

0.24

0.30

0.33

0.36

0.36

Z=0.4

0.32Nv

0.40Nv

0.56Nv

0.64Nv

0.96Nv

Z=0.4

0.32Nv

0.40Nv

0.40Nv

0.44Nv

0.36Nv

Soil profile type

SA

SB

SC

SD

SE

SF

Soil profile type

SA

SB

SC

SD

SE

SF

Seismic zone factor, Z

Refer to site-specific Geotechnical investigation and dynamic site response 

analysis to determine Cv
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The seismic coefficients Cv and Ca, given in Tables 16-R and 16-Q UBC 97, are site-dependent ground motion 
coefficients that define the seismic response throughout the spectral range. They are measures of  expected 
ground acceleration at a site.

For a given earthquake, a building on soft soil types such as SC or SD experiences a greater force than if  the same 
building were located on a rock, type SA or SB. This is addressed in the UBC through the Ca and Cv coefficients, 
which are calibrated to soil type SB with a value of  unity. Instead of  a single coefficient, two coefficients, Ca and 
Cv, are used to distinguish the response characteristics of  short-period and long-period buildings. Long period 
buildings are more affected by soft soils than short-period buildings.

In SAP software, a designer needs to choose Soil profile type & Seismic zone factor, the program will calculate 
Ca, Cv automatically according to UBC 97.
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2.2.6.6 Soil profile types
Table 2 13 Soil profile types (Table 16-J, UBC 97)

NOTE
Use Soil Types SD if  there is not any requirement from customers.

Table 2 14 Soil profile types for different codes

Country

United States

Vietnam

Thailand

Myanmar

Cambodia

Indonesia

Philippines

Code

UBC 97 (Table 16-J)

TCVN 9386:2012 (Table 3.1)

UBC 97 (Table 16-J)

MNBC 2016 (Table 3.4.2)

UBC 97 (Table 16-J)

UBC 97 (Table 16-J)

NSCP 2015

SA

-

SA

A

SA

SA

SA

SB

A

SB

B

SB

SB

SB

SC

B

SC

C

SC

SC

SC

SD

C

SD

D

SD

SD

SD

SE

D

SE

E

SE

SE

SE

SF

E,S1,S2

SF

F

SF

SF

SF

Soil profile types

Soil profile type Soil profile name/Generic description

SA Hard rock

SB Rock

SC Very dense soil and soft rock

SD Stiff  soil profile

SE Soft soil profile

SF Soil requiring site – specific evaluation. See section 1629.3.1 UBC 97
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2.2.6.7 Seismic zone & Seismic zone factor (Z)

Table 2 15 Seismic zone factor, Z (Table 16-I, UBC 97)

Figure 2.6 The United States Seismic zones map with 500-year return period

Zone

Z

1

0.075

2A

0.15

2B

0.20

3

0.30

4

0.40

Note: The zone shall be determined from the seismic zone map in Figure 16-2 UBC 97
The map accounts for the geographical variations in the expected levels of  earthquake ground 
shaking and gives the estimated peak horizontal acceleration on a rock having a 10% chance of  
being exceeded in a 50-year period (or 500-year return period).
The value of  the seismic zone coefficient Z can be considered the peak ground acceleration of  the 
percentage of  gravity.
It means, the peak ground acceleration: ga Z g= ×  
For example, Z = 0.4 indicates a peak ground acceleration of  0.4g equal to 40% of  gravity.
For the buildings are not located in the United States, refer to Appendix Chapter 16 UBC 97 to 
determine seismic zone.
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Table 2 16 Seismic zones for different codes

Country

United States

Vietnam

Thailand

Myanmar

Cambodia

Indonesia

Philippines

Code

UBC 97

(Table 16-I)

ag =

TCVN 9386:2012

(Appendix G, H)

~ UBC 97

MNBC 2016

(Fig. 3.4.1.5)

~ UBC 97

~ UBC 97

NSCP 2015

(Table 208-3)

1

0.075g

1

1

I

-

1

-

2A

0.15g

2A

2A

II

-

2A

-

2B

0.2g

2B

2B

III

-

2B

2B

3

0.3g

-

3

IV

-

3

-

4

0.4g

-

-

V

-

4

4

Seismic zones & peak ground acceleration
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Table 2 17 Seismic zone in Thailand

Figure 2.7 Thailand Seismic zones map with 500-year return period

Area

Bangkok

Chiang Mai

Udorn

Zone

1

2A

1

Vietnam
Use Appendix H - TCVN 9386:2012 to determine ground acceleration for every area in Vietnam.
In this standard, the peak ground acceleration was surveyed considered on rock, 500-year return period.
Thailand
According to Section 1653 UBC 97, we have a seismic zone for some areas in Thailand.
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Myanmar
The seismic zone of  Myanmar is divided into I, II, III, IV, V corresponding to seismic zone 2B, 3, 4 of  UBC 97.

Figure 2.8 Myanmar Seismic zones map with 500-year return period (Figure 3.4.1.5 MNBC 2016)
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Philippines
The Philippines archipelago is divided into 2 seismic zones only. Zone 2 covers the provinces of  Palawan (except 
Busuanga), Sulu and Tawi-Tawi while the rest of  the country is under zone 4.

Figure 2.9 Philippines Seismic zones map with 500-year return period (Figure 208-1 NSCP 2015)

Table 2 18 Seismic zone factor, Z in Philippines (Table 208-3, NSCP 2015)

Zone

Z

2

0.20

4

0.40
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Cambodia
Use UBC 97 to design a building in Cambodia. Almost buildings no need to design earthquake.
Indonesia
According to Section 1653 UBC 97, we have a seismic zone for some areas in Indonesia.

Table 2 19 Seismic zone in Indonesia

Figure 2.10 Indonesia Seismic zones map with 500-year return period

Area

Bandung

Jakarta

Medan

Surabaya

Zone

4

4

3

4
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Table 2 20 Occupancy category (Table 16-K, UBC 97)

Occupancy 
category

1. Essential
facilities 2 

2. Hazardous
facilities

3. Special
occupancy
structures3

4. Standard
occupancy
structures3

5. Miscellaneous
structures

Occupancy or functions of structure

Group I, Division 1 Occupancies having surgery 
and emergency treatment areas
Fire and police stations
Garages and shelters for emergency vehicles 
and emergency aircraft
Structures and shelters in emergency-
preparedness centers
Aviation control towers
Structures and equipment in government 
communication centers and other facilities 
required for emergency response
Standby power-generating equipment for 
Category 1 facility
Tanks or other structures containing housing 
or supporting water or other fire-suppression 
material or equipment required for the 
protection of Category 1, 2 or 3 structures

Group H, Divisions 1, 2, 6 and 7 Occupancies 
and structures therein housing or supporting 
toxic or explosive chemicals or substances
Non-building structures housing, supporting 
or containing quantities of toxic or explosive 
substances that, if contained within a building, 
would cause that building to be classified as a 
Group H, Division 1, 2 or 7 Occupancy 

Group A, Divisions 1, 2 and 2.1 Occupancies
Buildings housing Group E, Divisions 1 and 3 
Occupancies with a capacity greater than 300 
students
Buildings housing Group B Occupancies used 
for college or adult education with a capacity 
greater than 500 students
Group I, Divisions 1 and 2 Occupancies with 50 
or more residents incapacitated patients, but 
not included in Category 1
Group I, Division 3 Occupancies
All structures with an occupancy greater than 
5,000 persons
Structures and equipment in power-generating 
stations, and other public utility facilities not 
included in Category 1 or Category 2 above, 
and required for continued operation  

All structures housing occupancies or having 
functions not listed in Category 1, 2 or 3 and 
Group U Occupancy towers

Group U Occupancies except for towers

Seismic 
importance 

factor, I

1.25

1.25

1.00

1.00

1.00

Seismic 
importance 
factor, Ip1

1.50

1.50

1.00

1.00

1.00

Wind 
importance 
factor, Iw

1.15

1.15

1.00

1.00

1.00

2.2.6.8 Important factor (I)
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For steel building, we usually use important factor 1I = .

According to section 1630.1.1 UBC 97, we can determine total seismic dead load W through mass source in SAP.

2.2.6.9 The total seismic dead load (W)

NOTE
Load Pattern FL is fully applied floor load.
Each Crane will contribute one Crane Load Pattern.

W = Mass source = DL + AL + 0.25 (LL + FL + CR) (kN)
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The coefficient R shown in Table 16-N UBC 97 is a measure of  ductility and over strength of  a structural system, 
based primarily on performance of  similar systems in past earthquakes.

A higher value of  R has the effect of  reducing the design base shear. For example, for a steel special moment-
resisting frame, the factor has a value of  8.5, whereas for ordinary moment-resisting frame, the value is 4.5. This 
reflects the fact that a special moment-resisting frame performs better during an earthquake.

2.2.6.10 Numerical coefficient representative of the inherent over strength and global ductili-
ty capacity of lateral force-resisting systems (R)

Table 2 21 Structural systems  (Table 16-N UBC 97)

Basic structural 
system

1. Bearing wall 
system

2. Building frame 
system

3. Moment-
resisting frame
system

4. Dual systems

Lateral force resisting system description

1. Light-framed walls with shear panels
a. Wood structural panel walls for structures 
three stories or less
b. All other light-framed walls
2. Shear walls
a. Concrete
b. Masonry
3. Light steel-framed bearing walls with tension-
only bracing
4. Braced frames where bracing carries gravity 
load
a. Steel
b. Concrete
c. Heavy timber 

1. Steel eccentrically braced frame (EBF)
2. Light-framed walls with shear panels
a. Wood structural panel walls for structures 
three stories or less
b. All other light-framed walls
3. Shear walls
a. Concrete
b. Masonry
4. Ordinary braced frames
a. Steel
b. Concrete
c. Heavy timber
5. Special concentrically braced frames
a. Steel

1. Special moment-resisting frame (SMRF)
a. Steel
b. Concrete
2. Masonry moment-resisting wall frame 
(MMRWF)
3. Concrete intermediate moment-resisting 
frame (IMRF)
4. Ordinary moment-resisting frame (OMRF)
a. Steel
b. Concrete
5. Special truss moment frames of steel (STMF)

1. Shear walls
a. Concrete with SMRF

R

5.5
4.5

4.5
4.5
2.8

4.4
2.8
2.8

7.0

6.5
5.0

5.5
5.5

5.6
5.6
5.6

6.4

8.5
8.5
6.5
5.5

4.5
3.5
6.5

8.5

2.8
2.8

2.8
2.8
2.2

2.2
2.2
2.2

2.8

2.8
2.8

2.8
2.8

2.2
2.2
2.2

2.2

2.8
2.8
2.8
2.8

2.8
2.8
2.8

2.8

Height limit for 
seismic zones 3 and 

4 (feet)
x 304.8 for mm

65
65

160
160
65

160
-

65

240

65
65

240
160

160
-

65

240

N.L.
N.L.
160
—

160
—
240

N.L.

0Ω
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5. Cantilevered 
column building
systems

6. Shear wall-
frame interaction
systems

7. Undefined 
systems

b. Concrete with steel OMRF
c. Concrete with concrete IMRF
d. Masonry with SMRF
e. Masonry with steel OMRF
f. Masonry with concrete IMRF
g. Masonry with masonry MMRWF
2. Steel EBF
a. With steel SMRF
b. With steel OMRF
3. Ordinary braced frames
a. Steel with steel SMRF
b. Steel with steel OMRF
c. Concrete with concrete SMRF
d. Concrete with concrete IMRF
4. Special concentrically braced frames
a. Steel with steel SMRF
b. Steel with steel OMRF

1. Cantilevered column elements

1. Concrete

See Sections 1629.6.7 and 1629.9.2 UBC 97

Structure type

1. Vessels, including tanks and pressurized spheres, on braced or unbraced legs.

2. Cast-in-place concrete silos and chimneys having walls continuous to the foundations.

3. Distributed mass cantilever structures such as stacks, chimneys, silos and skirt-supported 

vertical vessels.

4. Trussed towers (freestanding or guyed), guyed stacks and chimneys.

5. Cantilevered column-type structures.

6. Cooling towers.

7. Bins and hoppers on braced or unbraced legs.

8. Storage racks 

9. Signs and billboards.

10. Amusement structures and monuments.

11. All other self-supporting structures not otherwise covered.

R

2.2

3.6

2.9

2.9

2.2

3.6

2.9

3.6

3.6

2.2

2.9

2.0

2.0

2.0

2.0

2.0

2.0

2.0

2.0

2.0

2.0

2.0

4.2
6.5
5.5
4.2
4.2
6.0

8.5
4.2

6.5
4.2
6.5
4.2

7.5
4.2

2.2

5.5

-

2.8
2.8
2.8
2.8
2.8
2.8

2.8
2.8

2.8
2.8
2.8
2.8

2.8
2.8

2.0

2.8

-

160
160
160
160

-
160

N.L.
160

N.L.
160

-
-

N.L.
160

35

160

-

Basic structural 
system

Lateral force resisting system description R Height limit for 
seismic zones 3 and 

4 (feet)
x 304.8 for mm

0Ω

Table 2 22 R and  factors for nonbuilding structures  (Table 16-P UBC 97)

0Ω

For steel building, we usually use R=4.5.

CHAPTER 2. CODES AND LOADS -
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Structure period or elastic fundamental period of  vibration, of  the structure in the direction under consideration.

Method A
For all buildings, the value T may be determined from section 1630.2.2 UBC 97

( )3 4
A t nT T C h= =  (s)

Where:
- Ct = the structural coefficient depends on the material of  the frame, is always input in English unit in SAP 
software.

•	  ( )0.035 0.0853tC =  for steel moment-resisting frames.

•	   ( )0.030 0.0731tC =  for reinforced concrete moment-resisting frames and eccentrically braced frames.

•	   ( )0.020 0.0488tC =  for all other buildings.
- hn = height above the base to level that is uppermost in the main portion of  the structure. In SAP software, it’s 
measured from the elevation of  the specified bottom story/minimum elevation level to the (top of  the) specified 
top story/maximum elevation level. (m)

The designer can modify hn value by choosing  an option “User specified” in Lateral load elevation range & fill in 
Min Z/ Max Z.

2.2.6.11 Structure period (T)
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Method B
The fundamental period T may be calculated using the structural properties and deformation characteristics of  the 
resisting elements in a properly substantiated analysis. The analysis shall be in accordance with the requirements of  
Section 1630.1.2 UBC 97. The fundamental period T may be computed by using the following formula:

2

1 1

2 2 w f
n n

B i i i i
i i

mT g
k

π π δ δ
= =

   = = ÷   
   
∑ ∑

 
(s)

Where:
- fi = lateral force at level i (kN)

- iδ  = horizontal displacement at Level i relative to the base due to applied lateral force f  (m)

- g = acceleration due to gravity,  ( )29.81g m s=
- wi = that portion of  the total seismic dead load assigned to level i. (kN)
SAP software use this method to calculate T if  designer choose “Program calc” in Time period.

- If  the seismic zone is zone 4 then:

•	 If  1.3B A BT T T T≤ → =
•	 If  1.3B A AT T T T> → =

- If  the seismic zone is zone 1, 2A, 2B, 3 then:

•	 If  1.4B A AT T T T> → =

•	 If  1.4B A AT T T T> → =
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For seismic zone 4 (Z=0.4), we need near-source factor Na, Nv to determine seismic coefficient Ca, Cv corresponding. 
They depend on seismic source type and the distance from the site to seismic source.

The purpose of  Na and Nv is to increase the soil-modified ground motion parameters, Ca and Cv, when there are 
active faults capable of  generating large-magnitude earthquakes within 15 km of  a seismic zone 4 site. So that 

, 1a vN N ≥ .
In SAP software, a designer needs to choose “Seismic source type” & “Dist. to source”, the program will be 
calculated Na, Nv automatically according to UBC 97.

2.2.6.12 Near-source factor (Na, Nv)

Seismic source type

A

B

C

Seismic source type

A

B

C

Closest distance to known seismic source

Closest distance to known seismic source

  ≤  2 km

1.5

1.3

1.0

  ≤  2 km

2.0

1.6

1.0

5 km

1.2

1.0

1.0

5 km

1.6

1.2

1.0

≥  10 km

1.0

1.0

1.0

10 km

1.2

1.0

1.0

≥  15 km

1.0

1.0

1.0

Table 2 23 Near-source factor Na (Table 16-S UBC 97)

Table 2 24 Near-source factor NV (Table 16-T UBC 97)
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The seismic source types labeled A, B, or C (Table 16-U UBC 97) is used to identify earthquake potential and 
activity of  faults in the immediate vicinity of  the structure.
They are defined in terms of  the slip rate of  the fault and the maximum magnitude of  earthquake that may 
be generated at the fault. The highest seismic risk is posed by seismic source type A, which is defined by a 
maximum moment magnitude of  7.0 or greater and a slip rate of  5 mm/year or greater.
Moment magnitude (M) was introduced in 1979 by Hanks and Kanamori and has since become the most 
commonly used method of  describing the size of  a microseism.  Moment magnitude measures the size of  
events in terms of  how much energy is released.
The slip rate is how fast the two sides of  a fault are slipping relative to one another, as determined 
from geodetic measurements, from offset man-made structures, or from offset geologic features whose age 
can be estimated. It is measured parallel to the predominant slip direction or estimated from the vertical or 
horizontal offset of  geologic markers.

2.2.6.13 Seismic source types

Seismic 

source type

A

B

C

Seismic source description

Faults that are capable of 

producing large magnitude 

events and that have a high rate 

of seismic activity

All faults other than types A and C

Faults that are not capable of 

producing large magnitude 

earthquakes and that have a 

relatively low rate of seismic 

activity

Seismic source definition

 Maximum moment 

magnitude, M

7.0M ≥

7.0M ≥
7.0M <
6.5M ≥

6.5M <

Slip rate, SR (mm/

year)

5SR ≥

5SR <
2SR >
2SR <

2SR ≤

Table 2 25 Seismic source type (Table 16-U UBC 97)
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2.3. Load Combinations

2.4. Serviceability Consideration

2.3.1. For Frame Structure

2.3.2. For Cold-Formed Section

Based on design method (LRFD or ASD), ASCE 7-10 define load combination coefficients for each method. 
BMB&A uses allowable stress design (ASD) method, see section 2.4.1 ASCE 7-10. 

1. Dead Load (DL)
2. Dead Load (DL) + Live Load (LL)
3. Dead Load (DL) + Live Load (Floor/Crane)
4. Dead Load (DL) + 0.75 Live Load (LL) + 0.75 Live Load (Floor/Crane)
5. Dead Load (DL) + [0.6 Wind Load (WL) or 0.7 Earthquake load (EL)]
6a. Dead Load (DL) + 0.75 Live Load (LL) + 0.75 Live Load (Floor/Crane) + 0.45 Wind Load (WL)
6b. Dead Load (DL) + 0.75 Live Load (LL) + 0.525 Earthquake load (EL) 
7. 0.6 Dead Load (DL) + 0.6 Wind Load (WL)
8. 0.6 Dead Load (DL) + 0.7 Earthquake load (EL) 

1. Dead Load (DL) + Roof  Live Load (LLr)
2. Dead Load (DL) + 0.6 Wind Load (WL)
3. 0.6 Dead Load (DL) + 0.6 Wind Load (WL)
All of  these are basic combination. For more loads (snow load, rain load, flood load…, etc.) see section 2.4 ASCE 7-10.

LOAD & DEFORMALOAD

DL + CR

L/600

L/400

DL + CR or WL 10 yr.

H/240 or ≤ 5.08cm

H/100

CONTRUCTION

 1/ Rafter (Vertical deflection) 2

 a/ Supporting plaster ceiling

 b/ Supporting non-plaster ceiling

 c/ Not supporting ceiling

 2/ Column (Horizontal deflection) 3

II/ Purlin1

 1/ Purlin (Vertical deflection)

 2/ Girt (Horizontal deflection)

III/ Floor members (Vertical deflection)

Beam, Joist, Decking, Checker Plate

IV/ Top Running Cranes 4

 1/ Runway Beam (Vertical deflection)

 2/ Runway Beam (Horizontal deflection)

V/ Crane Bracket (Horizontal deflection) 3

 1/ Cab or Radio - Operator cranes

 2/ Pendant - Operator cranes

 LL

L/360

L/240

L/180

DL + WL 10 yr.

DL + LL

L/150

L/120

LL

L/360

DL + LL

L/240

L/180

L/120

H/60

DL + WL 10 yr.

L/150

L/120

DL + LL

L/240

REMARK

10 Yr. Wind

10 Yr. Wind

Crane lateral 

or 10 Yr. 

Wind

Table 2 26 Deflection Limitations

 2 International Building Code - IBC 2012, Table 1604.3, page 335.
 3 Metal Building Systems Manual 2012, Table 3.3, page 331.
 4 Metal Building Systems Manual 2012, Table 3.5, page 333.
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Planning of  the pre-engineered buildings (low rise metal buildings) and arranging different building components 
is a very important step for the designer before proceeding with the design of  each component. The Following 
building configurations are significantly affecting the building Stability and Cost:
1.	 Main Frame configuration (orientation, type, roof  slope, eave height)
2.	 Roof  purlins spacing
3.	 Wall girts (connection & spacing)
4.	 End wall system
5.	 Expansion joints
6.	 Bay spacing
7.	 Bracing systems arrangement
8.	 Mezzanine floor beams/columns (orientation & spacing)
9.	 Crane systems

Figure 3.1 Pre-engineered building system

Figure 3.2 Pre-engineered building system

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM 
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3.1. Main Frame Configuration
Main frame is the basic supporting component in the PEB systems; main frames provide the vertical support for 
the whole building plus providing the lateral stability for the building in its direction while lateral stability in the 
other direction is usually achieved by a bracing system.
The width of  the building is defined as the out-to-out dimensions of  girts/eave struts and these extents define 
the sidewall steel lines. Eave height is the height measured from bottom of  the column base plate to top of  the 
eave strut. Rigid frame members are tapered using built-up sections following the shape of  the bending moment 
diagram. Columns with fixed base are straight. Also the interior columns are always maintained straight.

3.1.1. Main frame orientation

3.1.2. Main frame types

Building should be oriented in such a way that the length is greater than the width. This will result in more number 
of  lighter frames rather than less number of  heavy frames. This also will reduce the wind bracing forces results in 
lighter bracing systems.

Clear Span rigid frames are single gable frames and offer full-width clear space inside the building without interior 
columns. This type of  frame is extensively used anywhere an unobstructed working area is desired in diverse 
applications such as auditoriums, gymnasiums, aircraft hangars, showrooms and recreation facilities.
The deepest part of  the frame is the knee, the joint between the rafter and the column, which is generally designed 
as horizontal knee connection. An alternate design of  knee joint is as vertical knee connection that is employed 
for flush side-wall construction. Clear Span rigid frames are appropriate and economical when:
i) Frame width is in the range 24m-30m.
ii) Headroom at the exterior walls is not critical.

3.1.2.1 Clear span

Figure 3.3 Clear span frame

Figure 3.4 Column reaction of clear span frame
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Lean-To is not a self-contained and stable framing system rather an add-on to the existing building with a single 
slope. This type of  frame achieves stability when it is connected to an existing rigid framing. Usually column rafter 
connection at knee is pinned type, which results in lighter columns. In general, columns and rafters are straight 
except that rafters are tapered for larger widths (> 12m). For clear widths larger than 18m, tapered columns with 
moment resisting connections at the knee are more economical. Lean-To framing is typically used for building 
additions, equipment rooms and storage.
For larger widths “Multi-Span-Lean-To” framing can be adopted with exterior column tapered and moment 
connected at the knee.

When clear space inside the building is not the crucial requirement then Multi-Span rigid frames offer greater 
economy and theoretically unlimited building size. Buildings wider than around 90m experience a build-up of  
temperature stresses and require temperature load analysis and design. Multi-span rigid frames have straight 
interior columns, generally hot-rolled tube sections pin connected at the top with the rafter. When lateral sway is 
critical, the interior columns may be moment connected at the top with the rafter, and in such a situation built-up 
straight columns are more viable than hot-rolled tube columns.
Multi-Span rigid frame with an interior column located at ridge requires the rafter at ridge to have a horizontal 
bottom flange in order to accommodate horizontal cap plate. Multi-Span rigid frame is the most economical 
solution for wider buildings (width > 24m) and is used for buildings such as warehouses, distribution centers and 
factories. The most economical modular width in multi-span buildings is in the range 18m-24m.
The disadvantages of  such a framing system include:
-	 The susceptibility to differential settlement of  column supports.
-	 Locations of  the interior columns are difficult to change in future.
-	 Longer un-braced interior columns especially for wider buildings.
-	 Horizontal sway may be critical and governing the design in case of  internal columns pined with rafter.

3.1.2.3 Lean – to

3.1.2.2 Multi – span

Figure 3.5 Multi - span frame

Figure 3.6 Column reaction of multi - span frame



49CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -

Figure 3.7 Lean - to frame

Figure 3.8 Column reaction of lean - to frame

Figure 3.9 Mono-slope frame

Mono-slope or single-slope framing system is an alternative to gable type of  frame that may be either Clear Span 
or multi-span. Mono-Slope configuration results in more expensive framing than the gable type.
Mono-slope framing system is frequently adopted where:
-	 Rainwater needs to be drained away from the parking areas or from the adjacent buildings
-	 Larger headroom is required at one sidewall
-	 A new building is added directly adjacent to an existing building and it is required to avoid:
•	 The creation of  a valley condition along the connection of  both buildings.
•	 The imposition of  additional loads on the columns and foundations of  the existing building.

3.1.2.4 Mono-slope
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Figure 3.12 Mono-slope frame with 2 spans

Figure 3.13 Mono-slope frame with 3 spans

Figure 3.14 Mono-slope frame with 4 spans

For larger widths “mono-slope-multi-span” framing will be more economical when column free area inside the 
building is not an essential requirement.
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Space Saver framing system offers straight columns, keeping the rafter bottom flange horizontal for ceiling 
applications with rigid knee connection. Selection of  Space Saver is appropriate when:
-	 The frame width is between 6m to 18m and eave height does not exceed 6m.
-	 Straight columns are desired.
-	 Roof  slope 5%≤  are acceptable.
-	 Customer requires minimum air volume inside the building especially in cold storage warehouses

A Roof  System framing consists of  beam (rafter) resting onto a planned or an existing substructure. The 
substructure is normally made of  concrete or masonry. The rafter is designed in such a way to result in only 
vertical reaction (no horizontal reaction) by prescribing a roller support condition at one end. The roller 
supports are provided at one end by means of  roller rods.

3.1.2.5 Space saver

3.1.2.6 Roof system

Figure 3.15 Space saver frame

Figure 3.16 Column reaction of space saver frame
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Figure 3.17 Roof systems connect to RC column

Figure 3.18 Detail C – typical pinned arrangement Figure 3.19 Detail D – typical rolled arrangement 

A Roof  System is generally not economical for spans greater than 12m although it can span as large as 36m. 
This is due to fact that the Roof  System stresses are concentrated at mid-span rather than at the knees.
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Multi-Gable buildings are not recommended due to maintenance requirement of  valley region, internal drainage 
and bracing requirement inside the building at columns located at valley. Especially in snow areas, Multi-Gable 
framing should be discouraged. However, for very wide buildings this type of  framing offers a viable solution due 
to:
-	 Reduced height of  ridge and thus the reduced height of  interior columns
-	 Temperature effects can be controlled by dividing the frame into separate structural segments

Thus, Multi-Gable buildings are more economical than Multi-Span buildings for very wide buildings. Multi-Gable 
frames may be either Clear Spans or Multi-Spans. The columns at the valley location should be designed as rigidly 
connected to rafters on either side using a vertical type of  connection.

3.1.2.7 Multi – gable

Figure 3.20 Multi – gable frame with 2 clear spans

Figure 3.21 Multi – gable frame with 3 clear spans

Figure 3.22 Multi – gable frame with 4 clear spans

Figure 3.23 Typical detail at valley Figure 3.24 Recommended interior drainage arrangement

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -
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3.1.3. Roof slope

3.1.4. Eave height

Optimum roof  slope:

Eave height is governed by:
-	 Clear height at eave (head clearance)
-	 Mezzanine clear heights below beam and above joist
-	 Crane beam/ Crane hook heights
Minimize eave height to the bare minimum requirement since the eave height affects the price of  the building by 
adding to the price of  sheeting, girts and columns. If  columns are unbraced eave height affects the frame weight 
significantly. Also higher eave heights increase the wind loads on the building.
If  eave height to width ratio becomes more than 0.8 then the frame may have a fixed based design in order to 
control the lateral deflection.

Type of building

Multi - span buildings

Clear span, width up to 45m

Clear span, width up to 60m

Clear span, width > 60m

Recommended slope (%)

5

10

15

20

Figure 3.25 Eave height in the building
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3.2.1. Generals

3.2.3. End Wall Post

3.2.2. Post & Beam End Wall Rafter

3.2. End Wall Systems

The standard end wall is designed as post & beam (all connections are pinned) the lateral stability is provided by 
the diaphragm action, in the absence of  this shear diaphragm wind bracing are required.
End rigid frame are used in case of:
-	 Future extension is intended; in this case only wind posts are required.
-	 Crane running to the end wall
-	 Open for access condition prevails at the end wall
-	 X-bracing is not allowed at end wall in the case of  by-framed end wall.

All end wall posts are flush with the end wall structural line in end post & beam gable type and they are supporting 
end wall rafters. In all cases end wall posts are oriented so that end wall wind pressure is producing bending 
moments about the column major axis. End wall posts are comprised of  built-up sections or hot rolled sections.
Design concept
End wall posts are the supporting elements for end wall girts/block walls for wind loads (pressure or suction) 
which produce bending moment about posts major axes, end wall posts are designed as simple beam supported at 
foundation level (base plate) and are connected with Spanner at roof  purlins level.
For Post & Beam end walls additional vertical loads from end wall rafters are transmitted to posts producing axial 
loads (compression or tension).
End wall post buckling length about major axis is the column length.
Flanges unsupported length is depending on the end wall type and position.

All end wall rafters are designed as simple beams over the end wall posts. They are comprised of  built-up sections 
or hot rolled sections.
Design concept
Under gravity load (Dead load + Live Load): The top flange of  the end wall rafters is under compression and 
it is braced against lateral torsional buckling at every purlin location. 
Under uplift loads (Dead + Wind Load): The bottom flange of  the end wall rafters is under compression and 
it is unbraced against lateral torsional buckling. The buckling length is the distance between end wall columns, this 
may significantly reduce the section bending capacity or flange braces are to be used.

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -
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3.3. Expansion Joints
The purpose to add the expansion joint is separating 
the building into many areas in order that every area has 
allowable temperature deformation. When separating 
the foundation into 2 parts, expansion joint become 
settlement joint.
Section L7 AISC 360-10 recommends that the length of  
building needs to be added expansion joint or research 
NRC 1974 for more.

Unless more specifc site information is available, most engineers assume a range of  50° to 70° F (10° to 21° C)  
for continuously heated and air-conditioned buildings. Using that assumption, most steel, rectangular, framed 
confguration buildings with symmetrical stiffness can tolerate 460 ft (140 m) between expansion joints. 
Or the designer can refer to section 11.1.2 TCVN 5575:2012 to know the length & width of  building with 
expansion joint to be added.

Type of building

Building with insulation

Building without insulation 

& heating factory

Viaduct

Note: If there are 2 wall bracing systems in every expansion area, the distance of these not exceeding 

from 40m to 50m for building; from 25m to 30m for viaduct.

Longitudinal 

direction

230

200

130

Lateral 

direction

150

120

-

From expansion joist or the 

end of building to axis of 

nearest wall bracing system

150

120

-

Between 2 expansion joints

Maximum distance (m)
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Figure 3.26 Purlin/girt connection at expansion joint

Figure 3.27 Eave strut connection at expansion joint

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -
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Figure 3.28 Roof & wall panels at expansion joint

Figure 3.29 Panel connection at expansion joint
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Figure 3.30 Gutter at expansion joint

Figure 3.31 Expansion joint at ridge

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -
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3.4. Bay Spacing

Figure 3.32 Bay spacing

Figure 3.33 Jack beam plan with bay Spacing 12m

The most economical bay spacing is around 8m for the standard loads as following:

For greater loads than standard loads the economical bay spacing tends to decrease.
For buildings with heavy cranes (crane capacity > 10 Tons) the economical bay spacing ranges between 6m and 
7m.
Smaller end bays than interior bays will taper off  the effect of  higher deflection and bending moment in end bays 
as compared to interior bays and help reduce the weights of  purlins/girts in the end bays. This will avoid the need 
of  nested purlins/girts in the end bays and result in uniform size of  purlin/girt sizes.
Some buildings require bay spacing more than 10m in order to have a greater clear space at the interior of  
the building in Multi-Span buildings. Such a situation can be handled by providing jack beams that support the 
intermediate frames without interior columns. Thus the exterior columns will have bay spacing of  say 6m while 
the interior columns are spaced at 12m. Intermediate frames allow the purlin to span for 6m.

Live Loads on roof and frame (kN/m2)

0.57

Wind Speed (km/h)

130
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Figure 3.35 Elevation of jack beam at side wall

Figure 3.34 Jack beam at side wall

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -
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Figure 3.36 Section A - Jack beam at side wall

Figure 3.37 Detail 1 - Jack beam at side wall
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Figure 3.38 Interior jack beam

Figure 3.39 Elevation - Interior jack beam

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -
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Figure 3.40 Jack beam at middle span of rafter

Figure 3.41 Jack beam at intermediate span of rafter
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3.5. Bracing Systems Arrangement
Bracing is a structural system used to provide stability in a structure in a direction where applied forces on that 
structure would otherwise make it unstable. Whether it is a force due to wind, crane or seismic applications, the 
bracing system will always eventually transmit that load down to the column base and then to the foundations. The 
rules of  arranging different types of  bracing systems are as follows:

1. In long buildings, braced bays shall be provided in intervals not to exceed 5 bays.
2. Sidewall bracing shall be generally placed in the same bays of  roof  bracing. This may not be possible at times 
due to openings in the sidewalls. In such cases, sidewall bracing shall be placed in bays adjacent to those containing 
the roof  bracing with a consideration that load transfers to the adjacent bays.
3. Roof  rod bracing shall not cross the ridgeline.
4. Cables/rods braces shall not exceed 15m in length. If  a cross bracing contains rods longer than 15m, then the 
bracing should be broken to two sets of  bracings with a strut member between them so that the rod/cable lengths 
shall not exceed 15 m. 
5. Sidewall bracing shall be comprised of  any one of  the following types:
-	 Cables
-	 Rods or angles.
-	 Portal frame with/without rods or angles.
6. There shall be only one type of  bracing in the same sidewall. Do not mix different types/materials in the same 
sidewall.
7. It is preferable to use only one type of  wall bracing in the whole building otherwise the lateral loads (especially 
seismic loads) will not be divided equally between bracing lines. For cases when this will result in excessive weight 
for bracing system advanced calculation is to be done to determine the force that will be carried by each type 
depending on its stiffness and location.
8. Do not use rod/cable Ø25mm for roof  bracing because its weight make a large vertical deflection.

3.5.1. Bracing for wind and seismic loads in the longitudinal direction

CHAPTER 3. PRE-ENGINEERED BUILDING (PEB) SYSTEM -
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Figure 3.43 Cable bracing Figure 3.44 Rod bracing

Figure 3.42 Cable or rod bracing at roof & wall of a braced bay
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Figure 3.45 Portal frame Figure 3.46 Cable or rod bracing with strut tube

Figure 3.47 Angle bracing with strut tube
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1. End wall bracing is not required for a fully sheeted P&B end wall with flush girt construction. If  P&B end walls 
have by-framed girts then this end wall needs bracing.
2. If  required, bracing in P&B end walls shall comprise cables or rods, unless otherwise specified by the customer. 
In such a case the end wall members shall be either built-up or hot-rolled members.
3. If  an end wall requires bracing and the customer requests that no bracing to be placed in the plane of  the end 
wall, then it is recommended that the load in the plane of  the end wall is transferred back to the first rigid frame 
through additional roof  bracing in the end bay.

1. In crane buildings, bracing has to be designed for longitudinal crane loads for top running or underhung cranes. 
The bracing shall be placed in intervals not to exceed 5 bays.
2. Longitudinal bracing for top running cranes shall be comprised of  any one of  the following types.
-	 Angles or pipes;
-	 Portal frame with rods (or angles);
-	 Portal frame without rods (or angles).
3. Longitudinal bracing for top running cranes shall be of  only one type in the same longitudinal plane of  a 
building.
4. Longitudinal bracing for underhung cranes shall consist of  either rods or angles.
5. Lateral bracing for underhung cranes (attached to crane brackets), if  any shall consist of  either rods or angles.
6. Whenever a brace rod is used for crane bracing, the minimum diameter of  that rod shall be 20mm.
7. A brace rod shall not exceed 15m in length. If  angles are used the critical slenderness ratio of  a bracing angle 
shall not exceed 300.

3.5.2. Wind and seismic bracing in P&B end wall

3.5.3. Crane Bracing
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4.1. Main frame design procedure and constraints
4.1.1. Design procedure

Combined Stress Unity Check 

  1.0bya bx

a bx by

ff f
F F F

+ + ≤

Where fa, fbx and fby are actual axial, major axis bending and minor axis bending stresses respectively. Fa, Fbx 
and Fby are corresponding allowable stresses. If  section fails in combined unity check then check the allowable 
stresses:
(1)	 If  Mn/Omega Capacity or Pnc/Omega Capacity are much lower than Mn/Omega No LTB or 
Pnt/Omega Capacity  then it implies that the member is not properly braced then try one of  the following:

•	 For rafters and exterior columns (with sheeted side walls) adding flange braces with roof  purlins or wall 
girts will adjust the allowable stresses for the unbraced flange.
•	 For exterior columns (without sheeted side walls) then providing EB (strut tubes) adequately connected to 
bracing system at an appropriate height would reduce the unbraced length and adjust the allowable stress.
•	 For interior I-section columns they can also be braced by means of  EB if  allowed and adequately connected 
to bracing system.
•	 For interior I-section columns that brace points cannot be added in the design then stress ratios can be 
improved by increasing flanges width or by minor adjustment in the flange thickness.
•	 For columns connected with mezzanine beams/joists columns are considered braced at mezzanine level.
•	 For columns supporting top running crane beam the columns are considered laterally braced at the level 
of  carne beam top flange.
(2)	 If  allowable stresses are sufficiently high and still the section is failing in unity check, then unity check ratio 
can be improved by increasing the following in the given order:
•	 Increasing the web depth
•	 Increasing the flange width
•	 Increasing the flange thickness
(3)	 If  Shear stress unit ratio fv/Fv > 1.0 increase web thickness.

CHAPTER 4. MAIN FRAME AND CONNECTION
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4.1.1.1 Stress Unity Checks

Figure 4 1 Stress check in SAP
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Refer Table 2 26 Deflection Limitations for Deflection Limitations.
If  lateral deflection exceeds the prescribed limit (normally H/60) then check the H/Width ratio. If  H/B > 0.75 
then fixing the base would result in more economical frame. If  H/B<0.75 then increase the web depth at knee of  
both column and rafter (difference between knee depth of  column and rafter < 200mm)
In multi-span frames before going for the option of  fixing the exterior column at base, check whether fixing the 
tops of  interior columns control the lateral sway. If  not then fix the exterior column bases.
If  Vertical deflection ∆v exceeds the prescribed limit (normally Span/180), increase the web depth at knee of  
both column and rafter. A slight increase in the rafter depth at ridge will also help control the vertical deflection.

4.1.1.2 Controlling Deflections

4.1.2. Design constraints

180w

w

h
t

<  ;  31f

f
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t

<

 5
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< ;  2.5f

w

t
t

<

Compression element:  200
kL
r

<  

Tension element:  300
kL
r

<

Web thickness

Flange thickness

Web depth

Flange width

Minimum

Maximum
Minimum

Maximum
Minimum
Maximum
Minimum
Maximum

4mm: beam, rafter
5mm: column
50mm but give priority to 12mm
5mm: beam, rafter
6mm: column
50mm but give priority to 12mm
200mm
1500mm
134mm
746mm

4.1.2.1 Standard

4.1.2.2 Fabrication limitation for built-up section

NOTE	
•	 Width of  continuous flange should be constant along the one welded piece.
•	 Variation of  thickness at any butt weld splice of  continuous flange/web within 
the one welded piece should be limited to maximum 6mm.
•	 Width flange/web having constant width, use steel plate gouge like below table.
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Maximum fabricated out-to-out length of  the piece is 14m for transportation by truck (in Vietnam),
and 11.7m for transportation by dry cargo container (foreign) except 13.5m for Cambodia.

(1)	 At knee connection, maximum difference between column depth and rafter depth is 200mm.
(2)	 In a tapered section, the minimum difference in web depth at start and end should be 100mm.
(3)	 Minimum base plate thickness = 14 mm.
(4)	 Minimum base plate width = 164 mm.
(5)	 Minimum splice plate thickness = 12 mm.
(6)	 Minimum splice plate width = 164 mm.
(7)	 Minimum anchor bolt diameter = M20 (except end-wall post M16).
(8)	 Minimum splice bolt = M16.

To produce the most economical frame profiles, let apply the following rules:
(1)	 Minimize number of  splices in the columns and rafters by providing maximum possible lengths regardless 
of  the material savings that can be produced otherwise. Section lengths should be multiple of  3m i.e., 3m, 6m, 9m 
and 12m in order to reduce the scrap.
(2)	 In case of  different bay spacing avoid using more than 3 frames.
(3)	 Different frame should be adopted if  saving of  5% on all frames with a minimum of  1.0ton is ascertained.
(4)	 When different frames have to be used due to different bay spacing, maintain the same web cuts for all 
such frames.
(5)	 Minimize the number of  different flange widths in a frame. Maximum different widths of  flanges in all the 
frames should preferably be less than three.
(6)	 As much as possible maintain uniformity in the base plate detail and anchor bolt sizes for all the frames.
(7)	 Try to locate the splices at the locations where the bending moment is least and/or where the depth is least 
in a frame.
(8)	 Try to follow the shape of  bending moment diagram for the controlling load combination in the 
configuration of  the frame by maintaining the stress unity check ratios closer to 1.

4.1.2.3 Shipping limitation

4.1.2.4 Other guidelines

4.1.2.5 Optimization

Width

(mm)

1200

1500

2000

2

600

596

750

746

1000

996

÷

3

400

397

500

496

667

663

4

300

298

375

372

500

496

5

240

238

300

298

400

397

6

200

198

250

248

333

330

7

171

169

214

212

286

284

8

150

148

188

184

250

248

9

133

131

167

164

222

220

10

150

148

200

198

11

136

134

182

180

12

167

165

13

154

152

14

143

141

15

133

131

Table 4 1 Size of plate
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This section provides step-by-step instructions for building a basic SAP2000 model. 

In this Step, the basic grid that will serve as a template for developing the model will be defined. Then a material 
will be defined and sections will be selected.

4.1.3. Instruction to build Sap2000 Model 

4.1.3.1 Defining

a. Setting Default Units (KN, m, C) through: File > New Model Form.

Defining 

Units and geometry

Material and member section properties

Load patterns, load cases and load combinations

Modeling

Draw/Edit Frame Objects and Bracing System

Assigning/Edit Section Properties, Releases & Restraints.

Assign Load

Assign Unbraced Length Ratio (ULR)

Analyzing

Set Analysis Option

Set Load Cases to Run form

Display the result

Design Steel Frame

Check Deflection Limitation

Figure 4 2 New model form
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(1) Creating Generally Grid System:  New Model form > Grid Only
(2) Define Grid System Data: Define>Coordinate Systems/Grids>GLOBAL>Modify/Show System

b. Setting up geometry in 2 ways:

c. Define Materials through: Define > Materials
Figure 4 3 Quick Grid Lines form

STEEL3450 STEEL2350

Figure 4 5 Material Property Data

A36 (Tendon)

Figure 4 4 Define Grid System Date form
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Define Frame Section through: Define/Section Properties/Frame Sections

Define Tendon Section through: Define/Section Properties/Tendon Sections

d. Define Frame Sections

e. Define Load patterns, load cases and load combinations 

Figure 4 6 I/Wide Flange Section form Figure 4 7 Nonprismatic Section Definition form

Figure 4 8 Tendon Section Data form (Diameter 16mm)

•	 Define Load Patterns through: Define > Load Patterns
•	 Define Load Cases through: Define > Load Cases
•	 Define Load Combinations through: Define > Load Combinations or using *.s2k text file
In “1A - LOAD APPLICATION AND PURLIN - Under 18m” file, go to sheet “2” and enter the number 
for each load pattern, click COMBINATION then click EXPORT TO .TXT which will display a window to 
specify position for saving file. Click the Save button to save file.
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Figure 4 9 Design loading combination sheet

Figure 4 10 Create load combination COMB1

In SAP2000, you have to define at least one load combination before export .s2k text file. Click the Define > 
Load Combinations command, in the Define Load Combinations form which has just appeared, click the 
Add New Combo button and create an combination as shown in figure below.

After create any combination, click the File > Export > Sap2000 .s2k Text File command to display the Choose 
Tables for Export to Text File form shown in figure below.
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Figure 4 11 Choose Tables for Export to Text File form

Figure 4 11 Choose Tables for Export to Text File form

Make sure that all tables, load patterns, and Open File After Export option are selected before click the OK button.
Copy all data in combination.txt text file and paste to .s2k text file at highlight text shown in figure below.

Save and close file. Return to SAP and import this file. Click the File > Import > SAP2000 .s2k Text File 
command to display Import Tabular Database shown in figure below. Click the OK button, specify created .s2k 
text file in appeared window and click the Done button to import file.
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Figure 4 13 Import Tabular Database form

Figure 4 14 Click the Done button to finish importing .s2k text file

Figure 4 15 Properties of Object form

In this step, frame objects with the associated sections previously defined are drawn using the grids and snap-to 
options, and generated using Edit>Draw Frame/Cable. 
The Properties of  Object pop-up form for frames will appear as shown in figure below.

4.1.3.2 Modeling
a. Draw Frame Objects
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Use default values as seen in figure above to draw because we will assign information to frames after dividing them 
with appropriate length.

To draw EB and Tendon/Cable system, using Draw Frame/Cable button.

Divide frame objects
SAP2000 allows members to be sub-divided into multiple objects after they are drawn to accommodate changes 
in geometry (this differs from the internal meshing done during analysis where the number of  objects remains the 
same). 
Select rafters and vertical lines, then click the Edit > Edit Lines > Divide Frames command to show Divide 
Selected Frames form. In this form, make sure that Break at intersection with selected Joints, Frames, Area Edges 
and Solid Edges is selected before click the OK button.

b. Draw Bracing System

c. Edit Modeling

Figure 4 16 Bracing System

Figure 4 17  Divide Selected Frames form
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Assign member end releases and restraint
•	 Assign Frame Releases through: Assign > Frame > Releases/Partial Fixity
•	 Assign Joint Restraints through: Assign > Joint > Restraints
•	 Assign Frame Sections through: Assign > Frame > Frame Sections
•	 Assign Unbraced Length Ratio (ULR):
ULR is specified as a fraction of  the frame object length. Multiplying these factor times the frame object length 
gives the unbraced length for the object. There are three types of  ULR include ULR in major axis, minor axis, and 
lateral torsional buckling. 
(1)	 ULR (major) is ULR for buckling about the frame object major axis (occur when object is compressed). 
This item is taken to be the maximum distance between two major bracing divided by actual length of  object and 
it is usually specified as Program Determined.
(2)	 ULR (minor) is ULR for buckling about the frame object minor axis (occur when object is compressed). 
This item is taken to be the maximum distance between two bracing points (bracing member frame into web or 
flange of  the braced member) divided by actual length of  object.
(3)	 ULR (LTB) is ULR for lateral-torsional buckling for the frame object (occur when object is flexed). This 
item is taken to be the maximum distance between two bracing points (bracing member frame into flange of  the 
braced member) divided by actual length of  object.

Replicate Frame through Edit > Replicate.

Figure 4 18 Replicate form
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NOTE	
Assume purlin spacing and girt spacing is 1.5m.
With rafters, bracing members are purlins and flange braces. To conservative, just locations 
that have both purlin and flange brace are considered as bracing point. 
Therefore, unbraced length is spacing between flange braces.
With outer columns, bracing members are girts and flange braces. 
Therefore, unbraced length is the greater value of  spacing between flange brace or distance 
from ground to the first flange brace.
With inner columns, bracing members are longitudinal steel members and portal frame. 
Unbraced length is the largest of  unbraced lengths.

NOTE	
It will be easier to assign frame load when frames are not be divided into different 
length members.

Figure 4 19 Steel frame design overwrites form

In this step, the dead, live and wind loads will be applied to the model.
Calculate frame loads which will be assigned to frame using “1A - LOAD APPLICATION AND PURLIN - 
Under 18m” file.

d. Assign loads through Assign/Frame Loads.
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Figure 4 20 Set Load Cases to Run form

Figure 4 21 Steel Frame Design Preferences form 

In this part SAP2000 will assemble and solve the global matrix. The following steps are needed:
Setting Analysis Option through: Analysis > Set Option: check the available DOFs. If  you are analyzing a plane 
truss, check UX and UY, leave the UZ, RX, RY and RZ blank.
From the Analysis menu, select Run.Click the Run Now button to start running.

•	 Displaying the deformed shape through: Display > Show Deformed Shape
•	 Return normal model through: F4 or the Display > Show Undeformed Shape
•	 Show Model Definition or Analysis Result through: Ctrl+T or the Display > Show Table

Click the Design menu > Steel Frame Design > View/Revise Preferences command. 
The Steel Frame Design Preferences form shown in figure below displays.

When the analysis is finished, the program automatically displays a deformed shape view of  the model, and the 
model is locked. Check the general stability of  model by clicking the Start Animation button at the lower right 
hand of  monitor. If  any member is deformed unusually, you should unlock model and revise it.

4.1.3.3 Analyzing

4.1.3.4 Display the result

4.1.3.5 Design Steel Frame 
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Make sure that the Design Code is set to AISC 360-10, the Framing Type is set to OMF(ordinary-moment-frame) 
and the Design Provision is set to ASD.
Review the information contained in the other items and then click OK to accept the selections.
Click the Design menu > Steel Frame Design > Select Design Combos command to access the Design Load 
Combinations Selection form. Uncheck Automatically Generate Code-Based Design Load Combinations, 
then click OK to accept the changes.

Click the Design menu > Steel Frame Design > Start Design/ Check of  Structure command to start the 
steel frame design process. When the design is complete, stress ratio are displayed on the model as a color pallet.

Click the Design menu > Steel Frame Design > Display Design Info command to show Display Steel 
Design Results (AISC 360-10) form. In the Design Output drop-down list, select P-M Ratio Colors & Values, 
then click OK to accept.
To see detail information of  checking strength, right click on the 1K member to show the Steel Stress Check 
Information form.

Figure 4 22 Design Load Combinations Selection form

Figure 4 23 Model after checking
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Figure 4 24 Steel Stress Check Information form

Figure 4 25 Steel Stress Check Data form

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Click the Details button to show more detail information.

To check whether all steel frames passed the stress check, click the Design menu > Steel Frame Design > 
Verify All Members Passed command to display as figure below.

NOTE	
Unbraced length ratio for major bending is 4.167 which is taken to be distance between two 
bracing point in major axis (25m) divided by actual length of  member (6m). You should carefully 
review this ratio to ensure that the design process is consistent with your expectations.

Figure 4 26 Checking capacity of all steel objects

Figure 4 27 Load Case Data – Linear Static form

Refer Section 2.4 Serviceability Consideration for more details.
To optimize weight of  building, unlock model, modify section and irritate above steps until total weight is smallest.

In Load Case Data – Linear Static form, change Scale Factor for all Windload Case from 1 to 0.625 as 
Figure 4 27.

4.1.3.6 Check Deflection Limitt

4.1.4. Export Joint Reaction 
4.1.4.1 Transform from wind load with return period wind speed of 700 years to wind load 
with those of 50 years

50

2 2 2700
50 700 50 700 700

0.36 0.1ln(12 )

V 0.791 0.791 0.626
0.36 0.1ln(12 700)

TV T
V

V V WL WL WL

= +

⇒ = = ⇒ = × = ×
+ ×
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Figure 4 28 Change Label Form

Figure 4 29 Joints in X-Y Plan @Z=0 Figure 4 30 Label name after changing

Select the Edit > Change Labels command to access Interactive Name Change form. After enter all the 
information as figure below, select the Edit > Auto Relabel > All In List command to change label name.

4.1.4.2 Changing label name of joints 

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Export Joint Reactions to Excel
•	 When steel columns locate on concrete columns, specify all steel columns 
and show table Element Joint Forces – Frames.
•	 When steel columns locate on foundations, specify all base joints 
and show table Joint Reactions.
Create JOINT REACTIONS Results
Open file “7 - JOINT REACTIONS” and move to sheet “SteelColumn”, and then enter all the information 
about the project and Joint Labels Plan.
In Excel file that has just appeared, filter all base joints. Then insert one column on the left of  column “E”. Copy 
all data from column “B” to column “K”.
In sheet “InputS” in file “7 – JOINT REACTIONS”:
-	 Delete all data in area from columns A to J and from rows 4 to the end of  sheet. 
-	 Select cell “A4” and paste data into this. Select cell “X6” and change content in this cell to “Wind load Y”.
-	 Move to sheet “SteelColumn” and click the HIDE button.
-	 Set Print Area before print PDF file.
-	 Recheck all information; make sure that Vertical Reactions Vz for Dead load and Live load are always 
positive.

4.1.4.3 Displaying the Joint Forces/Joint Reactions

4.1.5. Design Example 4a: Low-Rise Building Sap Model

Figure 4 31 Low-rise building model
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4.1.5.1 Defining

Figure 4 33 Setting up geometry and default units

Table 4 2 Frame Section Properties

Define Section Properties as table below:

SectionName

Text

1C

1C-250212

1C-600212

1K

1K-384164

1K-600164

2C264184

2K-384148

3K

3K-384164

3K-600164

4K

4K-600184

4K-825184

CDH

CON45x35

EB

IPE-200

KDH

TABLE:  Frame Section Properties 01 - General

Material

Text

 

STEEL3450

STEEL3450

 

STEEL3450

STEEL3450

STEEL3450

STEEL3450

 

STEEL3450

STEEL3450

 

STEEL3450

STEEL3450

STEEL3450

CON25

STEEL2350

STEEL2350

STEEL3450

Shape

Text

Nonprismatic

I/Wide Flange

I/Wide Flange

Nonprismatic

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

Nonprismatic

I/Wide Flange

I/Wide Flange

Nonprismatic

I/Wide Flange

I/Wide Flange

I/Wide Flange

Rectangular

Box/Tube

I/Wide Flange

I/Wide Flange

d

m

 

0.25

0.6

 

0.384

0.6

0.264

0.384

 

0.384

0.6

 

0.6

0.8

0.26

0.45

0.15

0.2

0.222

bf1

m

 

0.212

0.212

 

0.164

0.164

0.184

0.148

 

0.164

0.164

 

0.184

0.184

0.164

0.35

0.15

0.1

0.148

tf1

m

 

0.008

0.008

 

0.006

0.006

0.008

0.006

 

0.006

0.006

 

0.008

0.008

0.006

 

0.0028

0.008

0.005

tw

m

 

0.005

0.005

 

0.005

0.005

0.005

0.004

 

0.005

0.005

 

0.005

0.005

0.004

 

0.0028

0.0055

0.004

bf2

m

 

0.212

0.212

 

0.164

0.164

0.184

0.148

 

0.164

0.164

 

0.184

0.184

0.164

 

 

0.1

0.148

tf2

m

 

0.008

0.008

 

0.008

0.008

0.008

0.006

 

0.008

0.008

 

0.008

0.008

0.006

 

 

0.008

0.005
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4.1.5.2 Modeling
Create general model

Define load patterns and load combinations

Figure 4 34 Main frame

Figure 4 35 End wall frame

Figure 4 36 Define Load Patterns form
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Assign load 

Dead load (DL)

Wind load 1 (WL1)

Dead load (DL)

Wind load 1 (WL1)

Wind load 3 (WL3)
Figure 4 38 Load applied on end-wall frame

Figure 4 37 Load applied on main frame

Live load (LL)

Wind load 2 (WL2)

Live load (LL)

Wind load 2 (WL2)
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Divide frame objects
Draw vertical lines that are located at x=6m, x=17.5m, x=23.5m, x=26.5m, x=32.5m and x=44m as shown in 
figure below.

Assign member section, end releases and restraint

Delete additional vertical lines.

Select rafters and vertical 
lines, then click the Edit > 
Edit Lines > Divide Frames 
command to show Divide 
Selected Frames form. In this 
form, make sure that Break 
at intersection with selected 
Joints, Frames, Area Edges 
and Solid Edges is selected 
before click the OK button.

Figure 4 39  Vertical lines to divide rafter

Figure 4 40  Divide Selected Frames form

Figure 4 41  Main frame after dividing 

Figure 4 43  Main frame sections 

Figure 4 42  End wall frame
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Calculate ULR for each member in frame
- Assume purlin spacing and girt spacing are 1.5m.
- With rafters: unbraced length for 1K, 3K and 4K are 1.5m, for 2K-384148 are 3m and for KDH, IPE-200 are 
their length (no bracing)
- With outer columns: unbraced length for 1C and CDH are 5m (base on architectural drawing).
- With inner columns (2C264184): there are not any ST or portal frame, so unbraced length for this column is 
taken to be its length or ULR is 1.

Select 1K section members and click the Design > Steel Frame Design > View/Revise Overwrites command 
to show the Steel Frame Design Overwrites for AISC 360-10 form.
At the Value column, type 0.25 for both Unbraced Length Ratio (Minor) and Unbraced Length Ratio 
(LTB).

CHAPTER 4. MAIN FRAME AND CONNECTION -

Figure 4 44  End wall frame sections

Table 4 3 Unbraced length ratio

Member

1K

2K-384148

3K

4K

1C

2C264184

IPE-200

CDH

KDH

Length (m)

6.00

11.50

6.00

1.50

7.80

6.75

1.50

7.80

25.28

Unbraced Length (m)

1.50

3.00

1.50

1.30

5.00

6.75

1.50

5.00

25.28

ULR

0.25

0.26

0.25

0.87

0.64

1.00

1.00

0.64

1.00
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Figure 4 45 Steel frame design overwrites form

Figure 4 46 Replicate form

Repeat these steps to assign ULR for the other member.
Replicate Frame
Select frame at X-Z Plan @ Y=8 and then select the 
Edit > Replicate.
To generate 8 additional frames with 8m bay spacing, 
enter like below:
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Figure 4 47 Column brace system

Figure 4 48 Model after running analysis

CHAPTER 4. MAIN FRAME AND CONNECTION -

Draw Bracing System

4.1.5.3 Analyzing



96

DESIGN GUIDELINES

4.1.5.4 Design Steel Frame

Figure 4 49 Model after checking

Figure 4 50 Main frame at plane Y=8

Figure 4 51 Checking capacity of all steel objects

To check whether all steel frames passed the stress 
check, click the Design menu > Steel Frame Design 
> Verify All Members Passed command to display as 
figure below.
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4.1.5.5 Check Deflection Limitation

CHAPTER 4. MAIN FRAME AND CONNECTION -

Create combos for deflection checking:

Vertical Deflection
Click the Display > Show Deformed 
Shape command which will show a 
Deformed Shape form. Select COMB1 
(DL + LL) from Case/Combo Name 
drop-down list and click OK to accept.

Checking if  vertical deflection (U3) of  mid points of  rafter are excess deflection limit. Put the cursor at mid points 
of  rafter to see if  deflection of  that point is excess the limit or not.

Compute deflection limit: ∆ = = =
25

0.208
120 120
L m

Name

CV1

CV2

CV3

CV

LCombination

DL + 0.4224WL1

DL + 0.4224WL2

DL + 0.4224WL3

CV1 + CV2 + CV3

Figure 4 52 Deformed Shape form
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Figure 4 54 Deflection of point 113 – 0.0755m

Figure 4 55 Deflection of point 28 – 0.0225m

Figure 4 56 Deflection of point 34 – 0.0221m

Figure 4 57 Load Case Data – Linear Static form

Horizontal Deflection
Checking if  horizontal deflection of  
combination CV of  top of  columns 
are excess deflection limit. Put the 
cursor at points located at the top 
of  column to see if  the horizontal 
deflection (U1 or U2) of  that point is 
excess the limit or not.
Compute horizontal deflection limit:   

∆ = = =
8

0.133
60 60
h m

4.1.5.6 Export joint reaction

Transform from wind load with 
return period wind speed of  700 years 
to wind load with those of  50 years
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Figure 4 58 Labels after change

Figure 4 59 Column reactions file

Changing label name of  joints 
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Figure 4 60 Element Joints Forces – Frame table

Figure 4 61 Data of element joint forces after filter and sort



101CHAPTER 4. MAIN FRAME AND CONNECTION -

Figure 4 62 Data after paste

Figure 4 63 Joint reactions after hide rows
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4.1.6. Design Example 4b: High-Rise Building Sap Model

Figure 4 64 High-rise building model

Figure 4 65 Setting up geometry and default units

4.1.6.1 Defining
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Requirements: 1.New Est.  / 2.Arch.drwgs  / 3.Apprl.drwgs  / 4.Design calculation  / 5.Shop drwgs  
BUILDING DESCRIPTION 

Material 
Specifications  

1.BMB Standard / 2.Tender’s Standard    
Built-up member: fy= 24.5 kN/ cm2 Purlin: Painted  / Galvanized   fy=45 kN/cm2    
Anchor bolt: 5.6  / 8.8   4. Connection bolt: 10.9 
Paint/ Finishing: Alkyd / Galvanized  / Epoxy   / Thickness: 140 micron 

Exposure B    C     D     

Qty. of identical Bldings 1 Usage 
Paint Coating Process (CPL Building) 
GRIDLINE iv1 to iv22 

Type of building Single slope Roof slope (%) 5 % 

Width (M) 
20 
(GL iii21 to 
middle column) 

Width Module (M) 1@20 
(center to center steel column) 

Length (M) 167 
 (GL iv1 to iv22) 

Bay Spacing (M) 20@8 + 1@7 
(center to center steel column) 

Height (M) 23 – at GL ivB Eave Height  Clear Height  

Type of End 
Frames 

Post & Beam  One, Axis ....................   Both  

Main Rigid Frame  One, Axis ....................   Both  

Concrete Columns and rafters (by others)  One, Axis ....................   Both  
Type of Wall 
Bracing Diagonal Rod  / Cable  / Portal frame  / None  

Eave Condition Gutter & Downspout / RC Gutter (by other)  / Gutter & Downspout (by other)  

Notes:  DO NOT put any column in GL ivA : iv16 ; iv17 ; iv19 ; iv20 ; iv21 
 
 DESIGN LOADS Follow BMB’s design  / Follow Customer’s design  
Live Load on Roof (kN/m2) 0.57 (58.1 KG/m2) / Others ..............................................  

Live Load on Frame (kN/m2) 0.30 (30.6 KG/m2) / Others ..............................................  

Wind Speed (KM/h) 110 (30.6 M/s)  / 130 (36.1 M/s)  / 160 (44 M/s)  / Other (……. M/s)  

Collateral Load (KG/m2)  Concentrated load (KG/m)  

Collateral Load hang on purlin        Collateral Load don’t hang on purlin        

Notes: Earthquake Zone Global Seismic Hazard Zone IIB 
ROOF, WALL SHEETINGS 

Roof panel: Yes  
 None  

Bare Zinc-Alum AZ…  Pre-Painted Zinc-Alum AZ…  7 ribs  / 5 ribs  

Pre-Painted Zinc-Alum AZ…  Thickness: 0.50mm Seam  / Clip-lock  

Wall panel: Yes  
 None  

Bare Zinc-Alum  Pre-Painted Zinc-Alum AZ…  7 ribs panel  

Pre-Painted Zinc-Alum AZ…  Thickness: 0.50mm 5 ribs panel  
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Notes:  
 INSULATION Roof  / Wall  / None  
Fiberglass thick 50mm  Air Bubble P2  Rockwall  Sandwich  Other  

Fiberglass thick 100mm  Air Bubble A2  PU  Panel      

Fiberglass density: 10-12 KG/m3  / Or other kind  Density: ............................................... KG/m3 

Other insulation: 

Notes: 
OPEN WALL CONDITIONS 

Both Side wall  1m for brick wall -  sheet to roof  

End wall GL ivB 1m for brick wall -  sheet to roof  

End wall GL ivA – iv1 to iv15 1m for brick wall -  sheet to roof  

End wall GL ivA – iv15 to iv22 Open 20.5 M - sheet to roof  

Notes: 

 ROOF MONITOR  None  
Type Jack roof  Ridge vent   Other  

Overall width (M) 3.5 Length (M) = 6  7  (pcs ) x 16.880 = 118.16  

Eave Condition Curved Eave  Open Eave  Other  

Roof panel  Same as roof panel  / Other  ............................................... thick  .............. mm 
(nominal) 

Wall panel  Same as wall panel / Other  ................................................ thick ............... mm 
(nominal) 

Notes: 
 MEZZANINE SLAB None  

Type 
Concrete slab    thick .............. mm / Decking panel  thick .............. mm 

Mezzanine with Checker Plate   thick .............. mm 

Quantity Mezzanine slab 1 Mezzanine slab 2 
Location   
Area (m2)   

Live load (KG/m2)   

Dead load (KG/m2)   

Others load (KG/m2)    
Height up to top of 
Concrete Slab (M)   

Type of support  
shear load Shear stud D20          Angle V      

Notes: 
 ROOF EXTENSIONS None  
Panel Same roof panel / Other   ....................................................... thick ............... mm (nominal) 
Location Side wall End wall 

Soffit panel Yes  / None  Yes  / None  

Quantity   

Width (M)   

Length (M)   

Notes: 
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 CANOPY None  
Panel Same as roof panel  / Other   ................................................. thick ............... mm (nominal) 
Eave 
Condition Curved Eave  Open Eave  Other  

Location Side wall End wall 

Soffit panel Yes  / None  Yes  / None  

Quantity   

Width (M)   

Length (M)   
Gutter, 
Downspout Yes  None  

Notes: 
 FASCIA None  
Panel Same as wall panel  / Other   ........................................ thick ............... mm (nominal) 

Location Side wall End wall 

Soffit panel Yes  / None  Yes  / None  

Type   

High (M)   

Length (M)   
Fascia projection 
(M)   

Notes: 
 PARTITIONS None  
Quantity Partition 1 Partition 2 

Location   

Length (M)   

High (M)   

Type Vertical of house  / Horizontal of house  Vertical of house  / Horizontal of house  

Wall 
Condition 

One side  / Double side  One side  / Double side  

Fully Sheeted  / Block wall  Fully Sheeted  / Blockwall  

Open up to ......... M  / Open up to access  Open up to ......... M  / Open up to access  

Wall Panel Same as wall panel  / Other   ................................................. thick ............... mm (nominal) 

Notes: 
CRANE SYSTEMS (The number of effective cranes on one column: 1 ) None  

Quantity Crane No.1 Crane No.2 Crane No.3 Crane No.4 

Location 
Full length of 
building    

Crane capacity (TON) 10T    

Crane Span (M) 20    

Length of Crane Run (M) 167    

Bracket Height  +19.5m    

Notes: Only supply, install running beam  / Our supply does not include the Crane System and Crane Rails  

Entire supply of Crane System include Crane, running beam, for crane rails and electrical systems ... 

Notes: 

CHAPTER 4. MAIN FRAME AND CONNECTION -
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ACCESSORIES - UTILITY ITEMS OR OTHER REQUIREMENTS (If Applicable) 
Accessories Length Width Height Qty. Accessories Length Width Height Qty. 

Rolling door     Rlg.door (motor)   

Door frame 0.85  2 10 Steel stair     

Double sliding dr     Stair handrail     

Window (Steel)     Opening frame     

Window (Almn)     Wall light 1  20.2 10 

 Steel Louver  
(+ mesh) 

5  1.5 10 Ladder     

Notes: Only supply frame for doors,sliding doors,rolling doors,windows 
Project Eng. 
(Sign & write down full name) 
 

 
Nguyen Minh Phuc Nguyen 

 

Notes for using this PIF 
1. Must fill in Exact Country of Project & Name of Consultancy/ Design Company at  top of 
PIF 
2. Must make sketch drawing or provide architectural drawing. 
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Table 4 4 Frame Section Properties

Define Section Properties as table below:

SectionName

Text

1K

1K516248

1K900248

1KA

2K

3K

3K350184

3K766184

4K766184

5K

5K-766

5K-900

B1

B2

BR

C1

C2

C2-D

C2-T

C3

CD

CDH

CR (500~800~500)

CR(800~800~500)

CR2(800~1500~800)

CR2-1500

CR2-800

CR3(800~1800~800)

CR3-1800

CR3-800

CR500184

CR800184

D310164

EB

G1

I-200

I-314

I-392212

IPE200

JB1

KDH

P141

P168

ST264164

V100x10

Material

Text

 

STEEL3450

STEEL3450

 

STEEL3450

 

STEEL3450

STEEL3450

STEEL3450

 

STEEL3450

STEEL3450

STEEL3450

STEEL3450

STEEL3450

STEEL3450

 

STEEL3450

STEEL3450

STEEL3450

STEEL3450

STEEL3450

 

 

 

STEEL3450

STEEL3450

 

STEEL3450

STEEL3450

STEEL3450

STEEL3450

STEEL3450

STEEL2350

STEEL3450

STEEL3450

STEEL3450

STEEL3450

STEEL2350

STEEL3450

STEEL3450

STEEL2350

STEEL2350

STEEL3450

STEEL2350

Shape

Text

Nonprismatic

I/Wide Flange

I/Wide Flange

Nonprismatic

I/Wide Flange

Nonprismatic

I/Wide Flange

I/Wide Flange

I/Wide Flange

Nonprismatic

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

Nonprismatic

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

Nonprismatic

Nonprismatic

Nonprismatic

I/Wide Flange

I/Wide Flange

Nonprismatic

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

Box/Tube

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

I/Wide Flange

Pipe

Pipe

I/Wide Flange

Angle

d

m

 

0.516

0.9

 

0.516

 

0.35

0.766

0.766

 

0.766

0.9

0.31

0.512

0.516

0.8

 

0.8

0.8

0.8

0.524

0.52

 

 

 

1.5

0.8

 

1.8

0.8

0.5

0.8

0.31

0.15

0.77

0.2

0.314

0.392

0.2

0.392

0.314

0.1413

0.1683

0.264

0.1

bf1

m

 

0.248

0.248

 

0.184

 

0.184

0.184

0.184

 

0.212

0.212

0.148

0.164

0.212

0.496

 

0.372

0.372

0.372

0.248

0.372

 

 

 

0.372

0.372

 

0.372

0.372

0.184

0.184

0.164

0.15

0.184

0.164

0.184

0.248

0.1

0.212

0.164

 

 

0.164

0.1

tf1

m

 

0.012

0.012

 

0.01

 

0.01

0.01

0.01

 

0.01

0.01

0.006

0.008

0.01

0.018

 

0.016

0.014

0.016

0.014

0.012

 

 

 

0.014

0.014

 

0.016

0.016

0.008

0.008

0.006

0.0028

0.012

0.008

0.008

0.01

0.008

0.01

0.008

 

 

0.008

0.01

tw

m

 

0.006

0.006

 

0.005

 

0.005

0.005

0.005

 

0.006

0.006

0.005

0.005

0.008

0.012

 

0.008

0.008

0.01

0.01

0.006

 

 

 

0.01

0.01

 

0.012

0.012

0.006

0.006

0.005

0.0028

0.008

0.005

0.005

0.006

0.0055

0.006

0.005

0.00396

0.00396

0.005

0.01

bf2

m

 

0.248

0.248

 

0.184

 

0.184

0.184

0.184

 

0.212

0.212

0.148

0.164

0.212

0.496

 

0.372

0.372

0.372

0.248

0.372

 

 

 

0.372

0.372

 

0.372

0.372

0.184

0.184

0.164

 

0.184

0.164

0.184

0.248

0.1

0.212

0.164

 

 

0.164

 

tf2

m

 

0.01

0.01

 

0.01

 

0.01

0.01

0.01

 

0.01

0.01

0.006

0.008

0.01

0.018

 

0.016

0.014

0.016

0.014

0.012

 

 

 

0.014

0.014

 

0.016

0.016

0.008

0.008

0.006

 

0.012

0.008

0.008

0.01

0.008

0.01

0.008

 

 

0.008
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4.1.6.2 Modeling

Create general model

End wall frame – GL iv1

Main frame – GL iv4 to GL iv14

Main frame – GL iv2 to GL iv3

Main frame – GL iv15 & GL iv18
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Main frame – GL iv16 to GL iv21 except GL iv18 Main frame – GL iv22

Figure 4 66 Main Frame

Figure 4 67 Elevation – GL ivB

Figure 4 68 Elevation – GL ivA

CHAPTER 4. MAIN FRAME AND CONNECTION -



110

DESIGN GUIDELINES

Figure 4 69 Jack beam and crane bracing

Figure 4 70 Crane runway beam & bracing – level +19.5m

Figure 4 71 Crane runway beam & bracing – level +19.5m
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Figure 4 72 Mezzanine floor – level +6.5m, +13m

Figure 4 73  Define Load Patterns form

Define load patterns and load combinations
Click the Define > Load Patterns command to access the Define Load Patterns form. In Load Patterns area, 
create load patterns including DL, LL, FL1, FL2, FL3, WL1, WL2, WL3, WL4, WL5, WL6, WL7, WL8, EL1, 
EL2, CR1, CR2 as shown in figure below.

CHAPTER 4. MAIN FRAME AND CONNECTION -



112

DESIGN GUIDELINES

Figure 4 74  Define Load Patterns form

Figure 4 75  EL1 definition

Select EL1 in Load Patterns area and then click the Modify Lateral Load Pattern button in Click to area to 
display the 1997 UBC Seismic Load Pattern form. Enter all information as figure below.
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Figure 4 76  EL2 definition

Figure 4 77  Mass Source form

Select EL2 in Load Patterns area and 
then click the Modify Lateral Load 
Pattern button in Click to area to 
display the 1997 UBC Seismic Load 
Pattern form. Enter all information 
as figure below.
Note: Based on UBC 97 standard, 
we have all the parameters for seismic 
zone 2B as above.

Define mass source: click the Define > Mass Source command to show the Mass Source form.
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Click the Modify/Show Mass source 
button to access the Mass Source Data 
form. Enter all information like figure 
below:

Define load combinations follow ASCE 
7-10 standard using .s2k text file. 

Figure 4 78  Mass Source Data form

Figure 4 79 Design loading combination sheet
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•	 In SAP2000, you have 
to define at least one load 
combination before export .s2k 
text file. Click the Define > Load 
Combinations command, in the 
Define Load Combinations 
form which has just appeared, click 
the Add New Combo button and 
create an combination as shown in 
figure below.

•	 After create any 
combination, click the File > 
Export > Sap2000 .s2k Text File 
command to display the Choose 
Tables for Export to Text File 
form shown in figure below.

•	 Make sure that all tables, load patterns, and Open File After Export option are selected before click the 
OK button.
•	 Copy all data in combination.txt text file and paste to .s2k text file at highlight text shown in figure below.

Figure 4 80  Create load combination COMB1

Figure 4 81  Choose Tables for Export to Text File form

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Figure 4 82 Substitute combination defined by SAP with combination exported from excel.

Figure 4 83 Import Tabular Database form

•	 Save and close file. Return to SAP and 
import this file. Click the File > Import > 
SAP2000 .s2k Text File command to display 
Import Tabular Database shown in figure 
below. Click the OK button, specify created 
.s2k text file in appeared window and click the 
Done button to import file.
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Assign loads
In this step, the dead, live and wind loads will be applied to the model.
Calculate wind loads which will be assigned to frame using “1A - LOAD APPLICATION AND PURLIN – All 
Height” file.
•	 In sheet “Input”, enter all the information as below:

CHAPTER 4. MAIN FRAME AND CONNECTION -

Figure 4 84 Click the Done button to finish importing .s2k text file

Figure 4 85 Input sheet
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•	 Go to sheet “Left Monoslope Roof” and then click the Calculation button to compute wind load blowing 
from left to right.

•	 Go to sheet “Right Monoslope Roof” and then click the Calculation button to compute wind load 
blowing from right to left.

Calculate dead load and floor load using “2 - COMPOSITE BEAM & DECKING” file.

Figure 4 86 Left Monoslope Roof sheet

Figure 4 87 Right Monoslope Roof sheet
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In sheet “1”, enter all the information as figure below:

Use 2.96 kN/m2 for dead load and 2 kN/m2 for live load to apply on mezzanine floor.
Calculate crane load using “3 - CRANE BEAM DESIGN” file. Enter all the information as figure below:

Figure 4 88 Calculate load for mezzanine floor
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Figure 4 89 Crane load for bay spacing 8m
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Figure 4 90 Crane load for bay spacing 24m and 31m
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Assign Load
After calculate load applied on frame, we assign them to frame as shown in these figure below.

Dead load (DL)

Wind load 1 (WL1)

Live load (LL)

Wind load 2 (WL2)
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Wind load 3 (WL3)

Wind load 5 (WL5)

Wind load 4 (WL4)

Wind load 6 (WL6)
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Wind load 7 (WL7)

Dead load (DL)

Wind load 8 (WL8)

Figure 4 91 Load applied Frame with 8m bay spacing 

Live load (LL)

•	 End wall frame
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Wind load 1 (WL1)

Wind load 3 (WL3)

Wind load 2 (WL2)

Wind load 4 (WL4)
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Wind load 5 (WL5)

Wind load 7 (WL7

Wind load 6 (WL6)

Wind load 8 (WL8)

Figure 4 92  Load applied End-wall Frame
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Deal load (DL) – level +6.5m

Floor load 1 (FL1)

Floor load 3 (FL3)

Figure 4 93 Mezzanine floor

Deal load (DL) – level +13m

Floor load 2 (FL2)
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•	 Crane bracket

Figure 4 94 Crane load 1 (CR1)

Figure 4 95 Crane load 2 (CR2)
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Divide frame objects and assign member section, end releases and restraint
By the same manner in modeling low-rise building, we have model as shown in figure below:

End wall frame – GL iv1

Main frame – GL iv4 to GL iv14

Main frame – GL iv2 to GL iv3

Main frame – GL iv15 & GL iv18
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Main frame – GL iv16 to GL iv21 except GL iv18

Elevation – GL ivB

Elevation – GL ivA

Main frame – GL iv22
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Jack beam and crane bracing

Crane runway beam & bracing – level +19.5m

Crane runway beam & bracing – level +19.5m
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Mezzanine floor – level +6.5m, +13m

Table 4 5 Unbraced length ratio

Calculate ULR for each member in frame
- Assume purlin spacing and girt spacing are 1.5m.
- With rafters: unbraced length for 1K, 1KA, 5K, 3K are 1.5m, for 2K and 4k766184 are 3m and for KDH is 
their length (no bracing).
- With outer columns: unbraced length for C1, C2, C3 and CDH are 2.5m (based on architectural drawing).
- With the other members, set ULR as Program Determined.

Member

1K

2K

1KA

5K

4K766184

3K

KDH

C1

C2

C3

CDH

Length (m)

6

8

6

6

8

6

6.667

23

23

23

23

Unbraced Length (m)

1.5

3

1.5

1.5

3

1.5

6.667

2.5

2.5

2.5

2.5

ULR

0.25

0.38

0.25

0.25

0.38

0.25

1.00

0.11

0.11

0.11

0.11
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Figure 4 96 Steel frame design overwrites form

Select 1K section members and click the Design > Steel Frame Design > View/Revise Overwrites command 
to show the Steel Frame Design Overwrites for AISC 360-10 form.
At the Value column, type 0.25 for both Unbraced Length Ratio (Minor) and Unbraced Length Ratio (LTB).

Repeat these steps to assign ULR for the other member.
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End wall GL iv1 End wall GL iv22

Draw Bracing System
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Elevation GL ivB

Elevation GL ivA

Figure 4 98 Model after running analysis

4.1.6.3 Analyzing
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4.1.6.4 Design Steel Frame

Figure 4 99 Model after checking

To see detail information of  checking strength, right click on the 1K member to show the Steel Stress Check 
Information form.
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Figure 4 100 Steel Stress Check Information form

Figure 4 101 Steel Stress Check Data form

Click the Details button to show more detail information.

NOTE	
Unbrace length ratio for major bending is 3.337 which is taken to be distance between two 
bracing point in major axis (20m) divided by actual length of  member (6m). You should carefully 
review this ratio to ensure that the design process is consistent with your expectations.
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To check whether all steel frames passed the stress check, click the Design menu > Steel Frame Design > 
Verify All Members Passed command to display as figure below.

Create combos for deflection checking:

Figure 4 102 Checking capacity of all steel objects

4.1.6.5 Check Deflection Limitation

Name

CV1

CV2

CV3

CV4

CV5

CV6

CV7

CV8

CVN1

CVN2

CVN3

CVN4

CVN5

CVN6

CVN7

CVN8

CVN9

CVN10

CVN11

CVN12

CV

Combination

DL + 0.4224WL1

DL + 0.4224WL2

DL + 0.4224WL3

DL + 0.4224WL4

DL + 0.4224WL5

DL + 0.4224WL6

DL + 0.4224WL7

DL + 0.4224WL8

DL + 0.75CR1 + 0.3168WL1 

DL + 0.75CR1 + 0.3168WL2

DL + 0.75CR1 + 0.3168WL3

DL + 0.75CR1 + 0.3168WL4

DL + 0.75CR2 + 0.3168WL1 

DL + 0.75CR2 + 0.3168WL2

DL + 0.75CR2 + 0.3168WL3

DL + 0.75CR2 + 0.3168WL4

DL + 0.75CR1 + 0.3168WL6 

DL + 0.75CR1 + 0.3168WL7

DL + 0.75CR2 + 0.3168WL6 

DL + 0.75CR2 + 0.3168WL7

CV1 + CV2 + … + CVN12
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Click the Display > Show Deformed Shape command which will show the Deformed Shape form. Select CV 
from Case/Combo Name drop-down list and click OK to accept.
Checking if  horizontal deflection of  crane bracket are excess deflection limit. 

Compute horizontal deflection limit:  ∆ = = =
19.5

0.195
100 100
h m  

Put the cursor at points located at the crane bracket to see if  the horizontal deflection (U1 or U2) of  that point is 
excess the limit or not.

Checking if  vertical deflection (U3) of  mid points of  rafter are excess deflection limit.

Compute deflection limit:   ∆ = = =
20

0.167
120 120
L m

Put the cursor at mid points of  rafter to see if  deflection of  that point is excess the limit or not.

Deflection of point 563 – 0.0109m Deflection of point 538 – 0.0212m

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Deflection of point 249 – 0.1094m

Deflection of point 249 – 0.1094m

Deflection of point 183 – 0.1237m

Checking if  vertical deflection of  girder are excess deflection limit.

Compute vertical deflection limit:   ∆ = = =
10

0.042
240 240
L m

Put the cursor at points located at the middle of  girder to see if  the vertical deflection (U1 or U2) of  that point is 
excess the limit or not.
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Deflection of point 196 – 0.0083m

Figure 4 103 Load Case Data – Linear Static form

Transform from wind load with return period wind speed of  700 years to wind load with those of  50 years

4.1.6.6 Export joint reaction



142

DESIGN GUIDELINES

Changing label name of  joints 

Figure 4 104 Labels after change
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Figure 4 105 Column reactions file

NOTE	
Change Collateral load to Earthquake load in Design load area. Do not insert any more rows or 
column in this sheet.

Run the model and specify all joints in active plan. Select the Display > Show Tables command to show Choose 
Tables for Display form. Make sure that the Table: Joint Reactions item and DL, LL, FL1, FL2, FL3, CR1, 
CR2, WL1, WL2, WL3, WL4, WL5, WL6, WL7, WL8, EL1, EL2 in the Select Load Cases form are selected 
before click the OK button.

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Figure 4 106 Element Joints Forces – Frame table

Figure 4 107 Data of element joint forces after filter and sort
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Figure 4 108 Data after paste

Select area from cell “W11” to cell “Z11” and click the Home > Insert command to insert more cells above active 
area. Revise load case name as shown in figure below.

Move to sheet “SteelColumn” and click the HIDE button.

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Figure 4 109  Joint reactions after hide rows

Select area from cell “A1” to cell “I795” and select the Page Layout > Print Area > Set Print Area command.
Recheck all information; make sure that Vertical Reactions Vz for Dead load and Live load are always positive.
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4.2. Pinned Base Plate Design
4.2.1. Input 

Run the model and specify 
all joints that connecting 
as pin to foundation and 
have the same column 
section. Select the Display 
> Show Tables command 
to show Choose Tables 
for Display form. Make 
sure that the Table: Joint 
Reactions item and all 
combinations in the 
Select Load Cases form 
are selected before click the 
OK button.

In Joint Reactions tables, 
select File > Export 
Current Table > To Excel. 

In excel file just exported, filter largest value in “F3” column and enter this value and correspondence shear to Pmax 
and Vp in “Base Plate Calculation” file.

4.2.1.1 Loading

Figure 4 110 Choose Tables for Display form

Figure 4 111 Joint Reactions table
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NOTE	
All value in Joint Reactions file are counter sign with value in “Base Plate Calculation” file, so we 
have to change the sign when enter axial force into calculation file. Shear forces will be taken as 
absolute values in all cases.

NOTE	
Compressive force will have negative sign “-“, and tensile force will have positive sign “+” or no 
sign. If  there is not tensile force at base, value for it will be taken as 1.

Do as above manner, filter the smallest value in “F3” 
column and enter this value and correspondence shear 
to Tmax and VT, filter largest absolute value in “F1” and 
“F2” column and take them to Vmax and TV.
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In order to illustrate a pinned base plate connection with full of  dangerous cases, we assume information as figure 
below.

4.2.1.2 Material, geometry parameter 

4.2.2. Checking base plate
4.2.2.1 Base plate for concentric axial compressive load

Calculate base plate area

Length of concrete foundation

Width of concrete foundation

Assume spacing between outermost anchor bolt and concrete edge is 200 mm

678.4 cm² 

500 mm

500 mm

2
1 320 212 67840A NB x mm= = =

4
1 2 * 200 1 100 2 * 200

2 2c x
nN s   = − + = − +   

   

2 200 100 2 200c yB s x x= + = +
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Calculate effective concrete area

Maxlimum bearing stress between 

plate and concrete

Allowable bearing force

Critical base plate cantilever 

dimension, l, is the larger of m, n 

and λn’:

For the yielding limit state, the 

required minimum thickness of the 

base plate

1656.25 cm²

11498.92 

kN/m²

780.1 kN

17.5 mm

32.4 mm

0.24

0.53

30.87 mm

32.4 mm

5.47 mm

37.5 mm

47.5 mm

1781.25 kNmm

95 mm

2 min , Nc c c c
BA N N B
N

 =  
 

2
212

min 500 500,500 500
320

A x x x =  
 

' 2
(max)

1

1
0.85p c

Af f
A

=
Ω

(max)
1 1656.25

0.85 20000
2.31 678.4pf x=

4
(max) 1 11498.92 678.4 10p

p

P
f A x x −= =

Ω

0.95 320 0.95 300
2 2

N d xm − −
= =

0.8 212 0.8 184
2 2

fB b xn
− −

= =

( )
max

2 2

4 4 300 184 200
(300 184) 780.1

f

pf

db P x xX
Pd b

Ω
= =

++

2 2 0.24
1 1 1 1 0.24

X x
X

λ = =
+ − + −

300 184
' 0.53

4 4
fdb xn

λ
λ = =

max( , , ') max(17.5, 32.4, 30.87)l m n nλ= =

22
maxmax 21

2 4
p

y p
y

t PP l F t l
BN F BN

Ω
= ⇒ =
Ω

2 1.67 200
32.4

34.5 212 320p
x xt x

x x
=

4.2.2.2 Base plate for uplift load

Tension for each anchor bolt

Distance from bolt rows to column 

web

Moment caused by tension on bolt

Width of effective area to assist 

max 150
4

T
n

=

100 5
2 2

y ws t
a

− −
= =

max 37.5 47.5a
TM a x

n
= =

2 2 47.5effb a x= =
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19.05 mm

OK

1.5

95 mm

4.10 kN/cm

3.95 kN/cm

OK

1.0

600 mm

2.74 kN/cm

2.5 kN/cm

OK

1.5

736 mm

6.84 kN/cm

CHAPTER 4. MAIN FRAME AND CONNECTION -

bending moment

Required minimum thickness of 

base plate

Demand/capacity thickness of base 

plate

Load angle factor when force 

perpendicular with welding

Width of effective area resisting 

tension force of one bolt

Allowable bearing capacity of 

column web weld

Force apply on column web weld

Demand/capacity welding

Load angle factor when force 

parallel with welding

Total web weld length

Allowable bearing capacity of 

column web weld

Force apply on column web weld

Demand/capacity welding

Load angle factor when force 

perpendicular with welding

Total flange weld length

Allowable bearing capacity of 

column web weld

2 41 4 1.67 1781.25
4 0.345 95

eff p a
y a p

y eff

b t MF M t
F b
Ω × ×

= ⇒ = =
Ω ×

max(5.47,19.05)
0.953 1

20
= <

4.2.2.3 Design welding
Weld capacity due to anchor tension

Elastic method weld shear capacity

Elastic method weld axial capacity

1.5 1.51 0.5sin ( ) 1 0.5sin (90)χ θ= + = +

2 2 47.5effb a x= =

_
1 2 1 2

0.6 1.5 0.6 43 0.3
2 2 2

w
EXX f web

R F hχ= = × × × × ×
Ω Ω

max 150
4 9.5eff

T
nb x

=

3.96
0.962 1

4.1
= <

1.5 1.51 0.5sin ( ) 1 0.5sin (0)χ θ= + = +

2 2 300 600shearL d x= = =

_
1 2 1 2

0.6 1.0 0.6 43 0.3
2 2 2

w
EXX f web

R F hχ= = × × × × ×
Ω Ω

max 150
60shear

V
L

=

2.5
0.914 1

2.74
= <

1.5 1.51 0.5sin ( ) 1 0.5sin (90)χ θ= + = +

4 4 184fL b x= =

_flange
1 2 1 2

0.6 1.5 0.6 43 0.5
2 2 2

w
EXX f

R F hχ= = × × × × ×
Ω Ω
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2.04 kN/cm

OK

132.54 kN

37.5 kN

OK

63.62 kN

OK

OK

47.69 kN

OK

Force apply on column flange weld

Demand/capacity welding

Allowable tensile capacity of each 

bolt

Required tension force for each 

bolt

Demand/Capacity

Allowable shear capacity of each 

bolt

Demand/Capacity

Demand/Capacity

The pullout strength in tension of a 

single hooked bolt

Demand/Capacity

The pullout strength in tension of a single hooked bolt: 

Assume there is no cracking in concrete so modification factor for pullout shall be taken as 1.4

Effective dimension to compute pullout strength of hooked bolt eh shall  be taken as 4.5da 

max 150
73.6

T
L

=

2.04
0.298 1

6.84
= <

4.2.3. Anchor bolt checking
4.2.3.1 Checking for combination maximum tension
Steel strength of  a single anchor in tension

Steel strength of  a single anchor in tension

Interaction of  tensile and shear forces of  anchor

Pullout of  anchor in tension

2 21 1 3
37.5

4 2 4
n b

nt
R dF π π

= = ×
Ω Ω

150
4

T
n
=

37.5
0.283 1

132.54
= <

'

,
0.9 0.9 2 4.5 3 3

1.4
2.14

pn c h a
c P

N f e d x x x xψ= =
Ω Ω

37.5
0.786 1

47.69
= <

2 20.8 / 4 0.8 22.5 3 / 4
2

sa nv bV F dπ π× ×
= =

Ω Ω

20
0.079 1

4 63.62x
= <

0.786 0.079
0.721 1

1.2
+

= <
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132.54 kN

12.5 kN

OK

63.62 kN

OK

OK

47.69 kN

OK

Allowable tensile capacity of each 

bolt

Required tension force for each 

bolt

Demand/Capacity

Allowable shear capacity of each 

bolt

Demand/Capacity

Demand/Capacity

The pullout strength in tension of a 

single hooked bolt

Demand/Capacity

Assume there is no cracking in concrete so modification factor for pullout shall be taken as 1.4

Effective dimension to compute pullout strength of hooked bolt eh shall  be taken as  4.5da 

4.2.3.2 Checking for combination maximum shear
Steel strength of  a single anchor in tension

Steel strength of  anchors in shear

Interaction of  tensile and shear forces of  anchor

Pullout of  anchor in tension

CHAPTER 4. MAIN FRAME AND CONNECTION -

2 21 1 3
37.5

4 2 4
n b

nt
R dF π π

= = ×
Ω Ω

50
4

T
n
=

12.5
0.094 1

132.54
= <

'

,
0.9 0.9 2 4.5 3 3

1.4
2.14

pn c h a
c P

N f e dψ × × × ×
= =

Ω Ω

12.5
0.262 1

47.69
= <

2 20.8 / 4 0.8 22.5 3 / 4
2

sa nv bV F d x x xπ π
= =

Ω Ω

150
0.589 1

4 63.62x
= <

0.262 0.589
0.710 1

1.2
+

= <
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4.3. Fixed Base Plate Design
4.3.1. Loading
Run the model and specify all joints that 
connecting as fixed to foundation and 
have the same column section. Select 
the Display > Show Tables command 
to show Choose Tables for Display 
form. Make sure that the Table: Joint 
Reactions item and all combinations 
in the Select Load Cases form are 
selected before click the OK button.

In Joint Reactions tables, select File > Export Current Table > To Excel. 

In excel file just exported, filter largest value in “F3” column and enter this value, correspondence shear and moment 
M2 to Pmax, VP and MP in “Base Plate Calculation” file.

Figure 4 113 Choose Tables for Display form

Figure 4 114 Joint Reactions table
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Do as above manner, filter the smallest value in “F3” column and enter this value and correspondence shear and 
moment M2 to Tmax, VT and MT 

Filter all positive values of  F3, and then filter the largest absolute value of  M2. Enter this value, correspondence 
compressive force and shear to M1max, PM1 and VM1.

Filter all negative values of  F3, and then filter the largest absolute value of  M2. Enter this value, correspondence 
tensile force and shear to M2max, PM2 and VM2.

Filter all negative values of  F3, and then filter the largest absolute value of  F1. Enter this value, correspondence 
tensile force and shear to Vmax, TV and MV.

Figure 4 115  Internal force for calculation

NOTE	
All values in Joint Reactions file are countered sign with value in “Base Plate Calculation” file, so 
we have to change the sign when enter axial force into calculation file. Shear forces and moment 
will be taken as absolute values in all cases.

NOTE	
Compressive force will have negative sign “-“, and tensile force will have positive sign “+” or no 
sign. If  there is not tensile force at base, value for it will be taken as 1.
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4.3.2. Material, geometry parameter

4.3.3. Checking base plate

In order to illustrate a fixed base plate connection with full of  dangerous cases, we assume information as figure 
below.

1823.2 cm²

1140 mm

Calculate base plate area

Length of concrete foundation

Calculate concrete area:

Assume spacing between outermost anchor bolt and concrete edge is 200 mm

1 860 212A NB x= =

, 1 1 , 2 2( ) ( )c a x x a x xN N c k c k− −= + − + −

860 (200 60) (200 60)cN = + − + −
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520 mm

320366.5 

mm²

9755.36 

kN/m²

2068.14 

kN/m

145 mm

21.2 mm

250 mm

381.65 mm

360 mm

2620.55 kN/m²

23.13 mm

Width of concrete foundation

Calculate effective concrete area

Maximum bearing stress between 

plate and concrete

Maximum resultant bearing force

Critical base plate cantilever 

dimension is the larger of m, n:

The equivalent eccentricity of 

base plate

The critical eccentricity

Conclusion

The concrete bearing length

Bearing stress between base 

plate and concrete

Determine minimum plate 

thickness with m (Y>m)

crite e<  => Case of  a base plate with small moment 
 No anchor rod forces exists.

, 1 1 , 2 2( ) ( )c a y y a y yB B c k c k− −= + − + −

212 (200 46) (200 46)cB = + − + −

2 min , Nc c c c
BA N N B
N

 =  
 

2
212

min 1140 1140,1140 520
860

A  = × × × 
 

' 2
(max)

1

1 1 3203.7
0.85 0.85 20000

2.31 1823.2p c
Af f x x
A

= =
Ω

max (max) 9755.36 0.212pq f B x= =

0.95 860 0.95 600
2 2

N d xm − −
= =

0.8 212 0.8 212
2 2

fB b xn
− −

= =

4.3.3.1 Checking base plate with combo Mp + Pmax

max

50
0.25m

200
PMe

P
= = =

max

860 200
2 2 2 2 2068.14crit
N Pe

q x
= − = −

2 860 2 250Y N e x= − = −

200
0.212 0.360p

Pf
BY x

= =

2 21
4 2

p
y p

Bt mF f B=
Ω

4

2 2 1.67 2620.55
145

34.5 10
p

p
y

f x xt m
F x
Ω

→ = =
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4.3.3.2 Checking base plate with combo Tmax + MT

It’s always the case of  base plate with large moment when 
considering combo momnent with tension.

,max 29755.36p p
kNf f
m

= =  

Determine bearing length Y:
-	 Equilibrium momentum with rotate center at the edge of  compresion concrete zone:
 

With:  

-	 Equilibrium force equation:
 

-	 Assume Y=0.001, set this value into Equation R:
 

-	 Set R into Equation Y:
 

  0.01 0.001
9 0.05

0.001
Y −

∆ = = >
  
=> Recalculate until this change not excess 0.05

2
2 2 2 2 21

1 2 3 4 5 max
1

25 5
2 2

max
1 1

2

max

5 5
2 2

1 1

( ) ( ) ( ) ( ) ( )
2 2

2 5
2 2

0.8650 200 2068
2 2 2

2 5

i i
i i

i i
i i

P Y Nh Y h Y h Y h Y h Y q M P Y
h Y

N YR h Y h Y M P Y q

N YM P Y q Y
R

h Y h Y

= =

= =

  − + − + − + − + − + = + −  −  
   ⇔ − + = + − −     

   + − − + − −   
   ⇔ = =

 − + 
 

∑ ∑

∑ ∑

2

2

4 2 4 2

.14
136 200 1034.072

12951 10 2 2.15 5 12951 10 4.3 5

Y
Y Y

x Yx Y x Y Y− −

− −
=

− + − +

5
2 2 2 2 2 2 2

1
5

1

1

1

800 650 430 210 60 1295100

800 650 430 210 60 2150

i
i

i
i

h mm

h mm

PR
h Y

=

=

= + + + + =

= + + + + =

=
−

∑

∑

[ ]

( )

( )

1
1 2 3 4 5 max

1
5

max
1

5

max
1

5

1

max

( ) ( ) ( ) ( ) ( )

5

5

2.15 200
5 2068.14 5

i
i

i
i

i
i

P h Y h Y h Y h Y h Y P q Y
h Y

R h Y P q Y

q R Y R h P

R h P
RY

q R R

=

=

=

− + − + − + − + − = +
−

 ⇔ − = + 
 

⇔ + = −

−
−

⇔ = =
+ +

∑

∑

∑

2

4 2

136 200 0.001 1034.07 0.001
105.2

1295 10 4.3 0.001 5 0.001
x xR

x x x−

− −
= =

+ +

2.15 105.2 200
0.01

2068.14 5 105.2
xY

x
−

= =
+
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-	 Set Y=0.01 into Equation R: 
2

4 2

136 200 0.01 1034.07 0.01
106.89

1295 10 4.3 0.01 5 0.01
x xR

x x x−

− −
= =

− + 

                                                           2.15 106.89 200
0.01146

2068.14 5 106.89
xY

x
−

= =
+

0.01146 0.01
0.146 0.05

0.01
Y −

∆ = = >  => Recalculate until this change not excess 0.05

-	 Set Y=0.01146 into Equation R:  
2

4 2

136 200 0.01146 1034.07 0.01146
107.16

1295 10 4.3 0.01146 5 0.01146
x xR

x x x−

− −
= =

− + 

                                                                  2.15 107.16 200
0.01167

2068.14 5 107.16
xY

x
−

= =
+                                                         

                                                                 0.01167 0.01146
0.018 0.05

0.01146
Y −

∆ = = <
 
=> OK

Determine maximum anchor tension:   1
1 1

1

( ) 107.16(0.8 0.01167) 84.5
PR P R h Y

h Y
= ⇒ = − = − =

−  
kN

Tension in one outermost bolt:   1
max

1

84.5
42.25

/ 2 4 / 2
PT

n
= = =

 
kN

Determine minimum plate thickness with m (Y<m):

                                                                       
21

( )
4 2

p
y p

Bt YF f BY m= −
Ω

                            
4

11.674 ( ) 4 1.67 9755.36 11.67 (145 )
2 2 17.51

34.5 10

p

p
y

Yf Y m x x x x
t

F x

Ω − −
→ = = =  mm

Determine minimum plate thickness follow tension in bolt:   
2

1
1

4
p

y

Bt
F P x=

Ω  

                                                               

14 4 1.67 84.5 76
24.22

212 34.5p
y

P x x x xt
BF x
Ω

→ = = =
 
mm

	 Calculate similarly for combos  max 1 max 2 max1 & , 2 & , &M M VM P M T V M  we find that required minimum 
base plate thickness is 44.62mm which is still smaller than currently thickness of  50mm.
	 Maximun tension in anchor bolts governed by combination M2max & TM2

	 Use these force to checking bolts:
Total axial force P = 50 kN
Total shear force Vg = 50 kN
Total moment M = 200 kNm
Maximum anchor tension Tmax = 82.41 kN
Shear for one bolt V = 5 kN

CHAPTER 4. MAIN FRAME AND CONNECTION -
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4.3.3.3 Design welding

Weld capacity due to anchor tension.

Load angle factor when force perpendicular with welding:

 1.5 1.51 0.5sin ( ) 1 0.5sin (90) 1.5χ θ= + = + =
Width of  effective area resisting tension force of  one bolt:

2 2 70 140effb a x= = =  mm
Allowable bearing capacity of  column flange weld:

_flange
1 2 1 2

0.6 1.5 0.6 43 0.7 9.58
2 2 2

w
EXX f

R kNF h x x x x x
cm

χ= = =
Ω Ω

Force apply on column flange weld:

max 82.41
5.89

14eff

T kN
b cm

= =  

           Demand/capacity welding: 5.89
0.615 1

9.58
= <  

           OK

Elastic method weld shear capacity

Load angle factor when force parallel with welding:

1.5 1.51 0.5sin ( ) 1 0.5sin (0) 1.0χ θ= + = + =  
Total web weld length:

2 2 600 1200shearL d x= = =  mm
Allowable bearing capacity of  column web weld:

_
1 2 1 2

0.6 1.0 0.6 43 0.6 5.47
2 2 2

w
EXX f web

R kNF h x x x x x
cm

χ= = =
Ω Ω

Force apply on column web weld:

max 200
1.67

120shear

V kN
L cm

= =  

           Demand/capacity welding: 1.67
0.305 1

5.47
= <  

           OK

Elastic method weld axial capacity

Load angle factor when force perpendicular with welding:

1.5 1.51 0.5sin ( ) 1 0.5sin (90) 1.5χ θ= + = + =
Total flange weld length

4 4 212 848fL b x= = =  mm
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Inertia moment of  weld:

( )2 3 2 3 34 / 2 2( 2 ) /12 4 212 (600/ 2) 2 (600 2 12) /12 108170.5f fI b d d t x x x x cm= + − = + − =

Allowable bearing capacity of  column web weld:

_flange
1 2 1 2

0.6 1.5 0.6 43 0.7 9.58
2 2 2

w
EXX f

R kNF h x x x x x
cm

χ= = =
Ω Ω

Force apply on column flange weld:

max 2 max2 ( / 2)( / 2) 200 5000(60/ 2) 50 20000(600/ 2)
max , max , 6.14

84.8 108170.5 84.8 109170.5
MTT T M dM d

L I L I
   + + = + + =  

  
 

             Demand/capacity welding: 6.14
0.64 1

9.58
= <  

             OK
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4.3.4.1 Steel strength of a single anchor in tension

4.3.4.2 Pullout of anchor in tension

Checking for combination maximum tension
Total axial force P = 50 kN
Total shear force Vg = 50 kN
Total moment M = 200 kNm
Maximum anchor tension Tmax = 82.41 kN
Shear for one bolt V = 5 kN

Allowable tensile capacity of  each bolt:

2 21 1 2.7
37.5 107.35

4 2 4
n b

nt
R dF xπ π

= = =
Ω Ω

kN

Demand/Capacity: 82.41
0.77 1

107.35
= <  

             OK

The pullout strength in tension of  a single headed bolt:

'

,

8 8.83 8 2
1.4 92.43

2.14
pn brg c

c P

N A f x xψ= = =
Ω Ω

kN

With:  
2 2

2 2 23 3 2.7
4.1 8.83

2 4 2 4
b

brg
d xA F cmπ π

= − = − =
 
(F is nominal dimension of  bolt’s head, take 1.5 bF d≈  )

Assume there is no cracking in concrete so modification factor for pullout shall be taken as 1.4

             Demand/Capacity = 82.41
0.89 1

92.43
= <  

             OK

4.3.4. Anchor bolt checking
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4.3.4.3 Steel strength of anchors in shear

4.3.4.4 Interaction of tensile and shear forces of anchor:

4.3.4.5 Steel strength of a single anchor in tension

4.3.4.6 Pullout of anchor in tension

Allowable shear capacity of  each bolt:

2 20.8 / 4 0.8 22.5 2.7 / 4
51.53

2
sa nv bV F d x x xπ π
= = =

Ω Ω
 kN

           Demand/Capacity = 5
0.097 1

51.53
= <  

           OK

0.89 0.097
0.823 1

1.2
+

= <

           OK

Checking for combination maximum shear
Total axial force P = 50 kN
Total shear force Vg = 200 kN
Total moment M = 50 kNm
Maximum anchor tension Tmax = 22.74 kN
Shear for one bolt V = 20 kN

Allowable tensile capacity of  each bolt:

2 21 1 2.7
37.5 107.35

4 2 4
n b

nt
R dF xπ π

= = =
Ω Ω

kN

Demand/Capacity: 22.74
0.21 1

107.35
= <  

           OK

The pullout strength in tension of  a single headed bolt:

'

,

8 8.83 8 2
1.4 92.43

2.14
pn brg c

c P

N A f x xψ= = =
Ω Ω

kN

With: 
2 2

2 2 23 3 2.7
4.1 8.83

2 4 2 4
b

brg
d xA F cmπ π

= − = − =  (F is nominal dimension of  bolt’s head, take 1.5 bF d≈  )

Assume there is no cracking in concrete so modification factor for pullout shall be taken as 1.4

           Demand/Capacity = 22.74
0.25 1

92.43
= <  

           OK
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4.3.4.7 Steel strength of anchors in shear

4.3.4.8 Interaction of tensile and shear forces of anchor:

Allowable shear capacity of  each bolt:

2 20.8 / 4 0.8 22.5 2.7 / 4
51.53

2
sa nv bV F d x x xπ π
= = =

Ω Ω
 kN

             Demand/Capacity = 20
0.39 1

51.53
= <  

             OK

0.25 0.39
0.53 1

1.2
+

= <  : OK
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4.4. Horizontal Knee Connection Design
4.4.1. Input
4.4.1.1 Loading

Run the model and specify all rafter 
having section 1K. Select the Display 
> Show Tables command to show 
Choose Tables for Display form. 
Make sure that the Table: Element 
Forces - Frames item and all 
combinations in the Select Load 
Cases form are selected before click 
the OK button.

In Element Forces tables, select File > Export Current Table > To Excel. 

Figure 4 116  Choose Tables for Display form

Figure 4 117  Joint Reactions table
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4.4.1.2 Material and geometry

In order to illustrate a K-type connection with full of  dangerous cases, we assume information as figure below.

In excel file just exported, in Station column, select station that use K-type connection, usually “0”. Filter the smallest 
value in “M3” column and enter this value, correspondence shear V2 and axial force P to “Bolt Connections” file.

NOTE	
Sign of  force in sap will be the same sign of  force in calculation file.
a. Filter the largest value in “M3” column and enter this value, correspondence shear V2 and 
axial force P to “Bolt Connections” file.
b. Filter the largest value in “V2” column and enter this value, correspondence moment M3 
and axial force P to “Bolt Connections” file.
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4.4.2. Determind internal force for K connection
Because interal force are in the end of  rafter so we have to transfer this load into internal force at top of  column

Internal force for Combo of  negative moment

Axial force
1 1sin V cos 50sin 5.71 50cos5.71o oP P α α= + = + 		   54.73 kN

Shear force
1 1cos sin 50cos5.71 50sin 5.71o oV P Vα α= − = − 44.78 kN

Moment
1M M= -350 kNm

Tension force at 
external flange

350 54.73
2 0.78 2fk

M PPufTop
h

−
= − + = − + 476.08 kN

Tension force at 
internal flange

350 54.73
2 0.78 2fk

M PPufBot
h

−
= + = + -421.35 kN

Internal force for Combo of  positive moment

Axial force
1 1sin V cos 50sin 5.71 50cos5.71o oP P α α= + = − + 44.78 kN

Shear force
1 1cos sin 50cos5.71 50sin 5.71o oV P Vα α= − = − − -54.73 kN

Moment
1M M= 200 kN

Tension force at 
external flange

200 44.78
2 0.78 2fk

M PPufTop
h

= − + = − + -234.02 kN

Tension force at 
internal flange

200 44.78
2 0.78 2fk

M PPufBot
h

= + = + 278.80 kN

Internal force for Combo of  shear max

Axial force
1 1sin V cos 50sin 5.71 200cos5.71o oP P α α= + = + 203.98 kN

Shear force
1 1cos sin 50cos5.71 200sin 5.71o oV P Vα α= − = − 29.85 kN

Moment
1M M= -50 kN

Tension force at 
external flange

50 203.98
2 0.78 2fk

M PPufBot
h

−
= + = + 166.09 kN

Tension force at 
internal flange

50 203.98
2 0.78 2fk

M PPufBot
h

−
= + = + 37.89 kN

Combo Axial (kN) V2 (kN) M33 (kNm) PufTop (kN) PufBot (kN)
Negative Moment 54.73 44.78 -350.00 476.08 -421.35

Positive Moment 44.78 54.73 200.00 -234.02 278.80

Shear 203.98 29.85 -50.00 166.09 37.89
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4.4.3. Checking moment end plate (external flange)
Flexural yielding

Calculate total length of  yielding line of  external flange from Table 4-4 DG16:

( ) ( )

( ) ( )

01 2
1 , 2

, ,

1 2
0.75 0.25

2 2 2
248 730 630 850 1 2 100

730 50 0.75 100 630 78.74 0.25 100
2 50 78.74 50 2 100 2

8030.65

p
f i b b

f i f o

b hh h gY h p p h s p
p s p g

x x

mm

 
 = + + − + + + + +    

 
 = + + − + + + + +     

=

With: 1 1
248 100 78.74

2 2ps b g x= = =  mm

No prying bolt moment strength

Tension capacity of  one bolt
2 22

75
4 4

b
t nt

d xP F π π
= =

 

235.62 kN

Flexural moment capacity of  
bolt with no prying force

1 1
2 2 235.62(0.840 0.720 0.620)

2
np

t n

M
P d= = × + +

Ω Ω ∑
 

513.65 kNm

Flexural moment capacity of  
external end plate

2 21 1
34.5 1.6 803.065

1 1.67
pl

y p
r r

M
F t Y x x

xγ γ
= =

Ω Ω

( 1rγ =  for extended connections)

424.71 kNm

Demand flexural moment 0.78
350 54.73

2 2
fk

an

h
M M P= + = − +

 

371.34 kNm

Demand/Capacity ratio 371.34
/ 0.88

424.71
D C = =

 
OK
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Demand/Capacity ratio 371.34
/ 0.72

513.65
D C = = OK

Conclusion
0.9 0.9 424.39 381.95 513.65pl npM M

x= = < =
Ω Ω

 

Thin plate behavior
Exist prying force in bolts when end plate is flexed

Bolt rupture with prying moment strength

Maximum prying force of  inner bolts:

22 2' 2
2 2

max,

' 101 16 93.94
3 3450 3 47.10

4 ' 4 45.72 101 16
p i

i py
i p

w t F xQ F
a w t x x

   = − = − =         
kN

With: ' / 2 248/ 2 22 102p hw b d= − = − =  mm

3 316
25.4 3.682 0.085 25.4 3.682 0.085 45.72

20
p

i
b

t
a

d

       = − = − =            
mm

3 3
2 2

'

,

248 20 0.750.85 0.80 ' 16 0.345 0.85 0.8 1022 8 2 8 94.30
4 4 50

p b nt
p y

i
f i

b d F x xt F w x x
F

p x

π π   + + + +   
   = = = kN

Maximum prying force of  outer bolts:

22 2' 2
2 2

max,o

' 101 16 93.94
3 3450 3 47.10

4 ' 4 45.72 101 16
p o

py
o p

w t F xQ F
a w t x x

   = − = − =         
kN

With: ' / 2 248/ 2 22 102p hw b d= − = − =  mm
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Bolts shear

Shear strength of  six bolts in 
external flange

2 21 1 2
45 6

4 2 4
n b

nv
R d xF nπ π

= =
Ω Ω

424.12 kN

Demand shear strength is 
the maximum shear force 
correspondent with negative 
axial force of  top flange

54.73 kN

Demand/Capacity ratio 54.73
/ 0.13

424.12
D C = = OK

Bolts bearing under shear load

Distance from edge of  outermost hole to edge of  plate:

1 2 50 22/ 2 39lc ev hl L d l= − = − =  mm
Distance from edge of  hole to hole:

100 22 78c b hl p d= − = − = mm
Bolts bearing capacity at outermost bolts:

2 2(0.6 ) 1.2 1.2 7.8 1.6 44.8 670.92n u c c ur F l t l tF x x x= = = = kN
Bolts bearing capcity between bolts:

2 2(0.6 ) 1.2 1.2 7.8 1.6 44.8 670.92n u c c ur F l t l tF x x x= = = = kN
Maximum bearing capacity:

(max) 2(0.6 2 ) 2.4 2.4 2 1.6 44.8 344.06n u ur F dt dtF x x x= = = = kN

Moment 
strength [ ]

( ) ( )
( )

max,o 0 max, 1 2

max,o 0 1 2

max,i 1 0 2

0 1 2

2(P ) 2( ) 2 T
1 2(P ) 2 ( )max

2(P ) 2 ( )
2 ( )

2 235.62 47.10 840 2 235.62 47.10 720 2 179 620
1 2 235.62 47.10 840 2max
2

t t i b

q t b

t b

b

Q d P Q d d
M Q d T d d

Q d T d d
T d d d

x x

  − + − +   − + +  =   − + +Ω Ω   
+ +  
− + − +
− += ( )

179 (720 620)
2 235.62 47.10 720 2 179 (840 620)
2 179 (840 720 620)

x x
x x

x x

 
 +
 − + + + + 

With:  
2 22

75 235.62
4 4

b
t nt

dP F π π ×
= = =

 
kN

405.07 kNm

Demand/
Capacity ratio

371.34
/ 0.92

405.07
D C = = OK

3 316
min ; 25.4 3.682 0.085 min 50; 25.4 3.682 0.085 45.72

20
p

o ev
b

t
a L

d

          = − = − =                 
mm

3 3
2 2

'

,o

248 20 0.750.85 0.80 ' 16 0.345 0.85 0.8 1022 8 2 8 94.30
4 4 50

p b nt
p y

o
f

b d F x xt F w x x
F

p x

π π   + + + +   
   = = = kN

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Total bearing capacity

( ) ( )

1 (max) 2 (max)
1

2 min( , ) 2( 1)min(r , )
2

1 6
2 min 335.46, 344.06 2 1 min 670.92, 344.06

2 2
1023.58

n
n n n n

R nr r r

kN

 = + − Ω Ω  
  = + −    

=

Demand shear strength                                                            kN

Demand/Capacity ratio                                         : OK

max(44.78,54.73, 29.85) 54.73aV = =

54.73
/ 0.05

1023.58
D C = =

Shear yielding of  plate

Shear yielding strength of  plate:

( )max 476.08, 234.02,166.09
238.04

2 2a
PuftopV = = = kN

Demand shear strength:

( )max 476.08, 234.02,166.09
238.04

2 2a
PuftopV = = = kN

Demand/Capacity ratio:

238.04
/ 0.48

491.84
D C = =  : OK

Shear rupture of  plate

Shear rupture strength of  plate:

1
0.6 [ 2( 1.6)]tn

u p h p
R F b d= − +
Ω Ω

( )1
0.6 0.45 248 2 22 1.6 16 431.99

2
nR kN= × × × − + =  Ω

Demand shear strength:

( )max 476.08, 234.02,166.09
238.04

2 2a
PuftopV = = =

 
kN

Demand/Capacity ratio: 238.04
/ 0.55

431.99
D C = =  : OK
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Flexural yielding

Calculate total length of  yielding line of  internal flange from Table 3-3 DG16:

 

( ) ( )

( ) ( )

1 2
1 2

2
0.75 0.25

2 2
248 730 630 2 100

730 50 0.75 100 630 78.74 0.25 100
2 50 78.74 100 2

5984.65

p
f b b

f

b h h gY h p p h s p
p s g

x x

mm

 
 = + + + + + +    

 
 = + + + + + +     

=

With: 1 1
248 100 78.74

2 2ps b g x= = =  mm

No prying bolt moment strength

Tension capacity of  
one bolt

2 22
75

4 4
b

t nt
dP F π π ×

= =
235.62 kN

Flexural moment 
capacity of  bolt with 
no prying force

1 1
2 ( ) 2 235.62(0.720 0.620)

2
np

t n

M
P d= = × +

Ω Ω ∑
315.73 

kNm

Demand/Capacity 
ratio 217.46

/ 0.69
315.73

D C = =
OK

Flexural moment 
capacity of  internal 
end plate

2 21 1
34.5 1.6 598.465 253.20

1.25 1.67
pl

y p
r r

M
F t Y x x kNm

xγ γ
= = =

Ω Ω

( 1.25rγ = for flush connections)

Demand flexural 
moment

               
                                                                        kNm 

Demand/Capacity 
ratio                                        : OK

CHAPTER 4. MAIN FRAME AND CONNECTION -

4.4.4. Checking moment end plate (internal flange)

0.78
200 44.78 217.46

2 2
fk

ap

h
M M P= + = + =

217.46
/ 0.86

253.20
D C = =
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Conclusion
0.9 0.9 253.20 227.88 315.73pl npM M

x= = < =
Ω Ω

         Thin plate behavior
         Exist prying force in bolts when end plate is flexed

Bolt rupture with prying moment strength

Bolts shear

Shear strength of  four bolts in 
internal flange

282.74 
kN

Demand shear strength is 
the maximum shear force 
correspondent with negative axial 
force of  bottom flange

aV 44.78 kN

Demand/Capacity ratio 44.78
/ 0.16

282.74
D C = =

OK

Maximum prying 

force of inner bolts

Moment strength

Demand/Capacity 

ratio

With: 

With: ' / 2 248/ 2 22p hw b d= − = −

47.10 kN

102 mm

45.72 mm

94.30 kN

252.62 kN

235.62 kN

OK

22 2' 2
2 2

max,

' 101 16 93.94
3 3450 3

4 ' 4 45.72 101 16
p i

i py
i p

w t F xQ F
a w t x x

   = − = −       

0.85 0.80 '
2 8

248 20 0.7516 0.345 0.85 0.8 102
2 8

4 50

b nt
p y

f i

d Ft F w
 

+ + 
 

× × + × + 
 

×

3 316
25.4 3.682 0.085 25.4 3.682 0.085

20
p

i
b

t
a

d

       = − = −            

[ ]

( )( )

( )

max, 1 2

1 2

1
2( )( )

max 1
2 ( )

1
2 235.62 47.10 0.72 0.62

2max 1
2 179 0.72 0.62

2

t iq

b

P Q d dM

T d d

x x

  − +  Ω=  Ω + 
Ω 

 − +   =  
+    

2 22
75

4 4
b

t nt
dP F π π

= =

217.46
/ 0.86

252.62
D C = =

2 21 1 2
45 4

4 2 4
n b

nv
R dF nπ π

= =
Ω Ω
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Bolts bearing under shear load

Shear yielding of  plate

Shear rupture of  plate

Distance from edge of outermost 

hole to edge of plate

Distance from edge of hole to hole

Bolts bearing capacity at outermost 

bolts

Bolts bearing capcity between 

bolts

Maximum bearing capacity

Total bearing 

capacity

Demand shear 

strength

Demand/

Capacity ratio

Shear yielding 

strength of plate

Demand shear 

strength

Demand/

Capacity ratio

Shear rupture 

strength of plate

Demand shear 

strength

Demand/

Capacity ratio

431.99 kN

310.68 kN

OK

491.84 kN

210.68 kN

OK

679.52 kN

54.73 kN

OK

39 mm

78 mm

335.46 kN

670.92 kN

344.06 kN

CHAPTER 4. MAIN FRAME AND CONNECTION -

1 2 50 22/ 2lc ev hl L d l= − = −

100 22c b hl p d= − = −

1 1 12(0.6 ) 1.2
1.2 3.9 1.6 44.8

n u c c ur F l t l tF= =
= × × ×

2 2(0.6 ) 1.2
1.2 7.8 1.6 44.8

n u c c ur F l t l tF= =
= × × ×

(max) 2(0.6 2 ) 2.4
2.4 2 1.6 44.

n u ur F dt dtF= =
= × × ×

1 (max) 2 (max)
1

2 min( , ) 2( 1)min(r , )
2

n
n n n n

R nr r r = + − Ω Ω  

( ) ( )1 4
2 min 335.46, 344.06 2 1 min 670.92, 344.06

2 2
nR   = + −  Ω   

max(44.78;54.73; 29.85)aV =

54.73
/ 0.08

679.52
D C = =

1
0.6

1
0.6 34.5 24.8 1.6

1.67

n
y p p

R F b t=
Ω Ω
= × × ×

( )max 421.35; 278.8; 37.89
2 2a

PufbotV = =

210.68
/ 0.43

491.84
D C = =

( )

1
0.6 [ 2( 1.6)]t

1
0.6 0.45 248 2 22 1.6 16

2

n
u p h p

R F b d= − +
Ω Ω
= × × − +  

( )max 421.35; 278.8; 37.89
2 2a

PufbotV = =

210.68
/ 0.49

431.99
D C = =
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4.4.5. Weld check
Web weld shear strength

Web weld strength to reach yield stress

Shear yielding of  web

Flange weld capacity (external flange)

Area of web weld (assume only weld 

at compresion area assist shear force)

Shear strength of web weld

Demand shear strength

Demand/Capacity ratio

Load angle factor when force 

perpendicular with weld

Weld strength of web weld

Demand yield stress

Demand/Capacity ratio

Area of outsite flange weld

Load angle factor when force 

perpendicular with weld

Weld strength of flange weld

3347.44 mm²

1.5

623.55 kN

1.5

21.07 kN/cm

20.64 kN/cm

OK

2206.17 mm

547.97 kN

54.73 kN

OK

2 2 2 780
8

2 2 2 2 2
fk

w w w

h
A W L W= = = ×

1 1
2 0.6 2 0.6 41.4 22.06

2
n

EXX w
R F A   = = × ×   Ω Ω   

max(44.78;54.73; 29.85)aV =

54.73
/ 0.10

547.97
D C = =

1.5 1.51 0.5sin ( ) 1 0.5sin (90)χ θ= + = +

1 2
2 0.6

2
1 2

2 0.6 41.4 1.5 0.8
2 2

w
EXX w

R F Wχ
 

=  Ω Ω 
 

= × × × 
 

1 1
34.5 1

1.67
n

y w
R F t= = ×
Ω Ω

/ 20.64 / 21.08 0.98D C = =

Shear yielding strength of  web 1 1
0.6 0.6 34.5 80 1

1.5
n

y p w
R F L t= = × × ×
Ω Ω

 1104 kN

Demand shear strength / 54.73/1104 0.05D C = = 54.73 kN

Demand/Capacity ratio / 54.73/1104 0.05D C = =
 

OK

( )

2 2
(2 2 t )

2 2
2

9 2 248 10 2 20
2

w f f f w fA W L W b t= = − +

= × − + ×

1.5 1.51 0.5sin ( ) 1 0.5sin (90)χ θ= + = +

1
0.6

1
0.6 41.4 1.5 33.47

2

n
EXX w

R F Aχ=
Ω Ω
= × × ×
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4.4.6. Checking panel zone

Flange weld capacity (internal flange)

Panel web shear

Demand shear strength

Demand/Capacity ratio

476.08 kNaV Puftop=  kN

476.08
/ 0.76

623.55
D C = =  : OK

Area of  inside flange 
weld

2 2
(2 2 t )

2 2w f f f w fA W L W b t= = − +

1.5 1.51 0.5sin ( ) 1 0.5sin (90) 1.5χ θ= + = + =Load angle factor when 
force perpendicular with 
weld

1.5 1.51 0.5sin ( ) 1 0.5sin (90) 1.5χ θ= + = + =

Weld strength of  flange 
weld 1 1

0.6 0.6 41.4 1.5 33.47 623.55
2

n
EXX w

R F A x x xχ= = =
Ω Ω

kN

Demand shear strength 421.35aV Pufbot= =  kN

Demand/Capacity ratio 421.35
/ 0.68

623.55
D C = =  : OK

-	 Shear yield strength of  the rafter:

( )0.6 0.6 (2 ) 0.6 34.5 2 212 10 680 5 /100 1581.48c y g y f f w wP F A F b t h t x x x x x= = + = + =  kN

For:     ( ) ( )max , max 476.08, 421.35 476.08
P 476.08 0.4 0.4 158148 632.59

r

r c

P Puftop Pufbot
P x

= = =
= < = =

  

-	
0.6 0.6 34.5 70 0.5

433.83
1.67 1.67

y wn
F htR x x x

= = =
Ω

 kN

-	 Shear yield strength of  the diagonal stiffeners (consider diagonal stiffeners as compresion elements):

Inertia radius of  stiffeners: / 12 12/ 12 3.46psr t= = =  mm

Slenderness of  stiffeners: / r 0.65x1018.47/ 3.46 191.10KL = =
  

	 20000
191.10 4.71 4.71 113.4

34.5y

KL E
r F

= > = =   

	
2 2

2 2 2

20000
0.877 0.877 0.877 4.74

191.10cr e
E x kNF F

cmKL
r

π π
= = = =

 
 
 
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Strength of  diagonal stiffeners: 2

21 1
2 cos 2 ( )

1 800 2 20
2 4.74 (109 10) 12 10

1.67 1018.47
50.32

nps c fc
cr g cr ps ps

ps

R h t
F A F b cc t

L
xx x x

kN

θ

−

−
= = −

Ω Ω Ω
−

= −

= 

Total panel web shear resitance: 433.83 50.32 484.15npsn
RR

+ = + =
Ω Ω  

kN

Demand shear strength: max( , ) max(476.08, 421.35) 476.08aV Puftop Pufbot= = =  kN

Demand/Capacity ratio: 476.08
/ 0.98

484.15
D C = =

  
	 OK

Web resistance in local web yielding:

( )1 1
[0.5(6 2 ) ) 0.5 6 16 2 16 38 34.5 10 5 117.3

1.5p yw wk t N F t x x x x= + + = + + =  Ω Ω
kN

	

With: 16pk t= =  mm

	 2 10 2 9 38f fN t W x= + = + = mm
Stiffeners resistance in local web yielding:

21 1
2 2 34.5 10 1338 552.83

1.67
ns

y s
R F A x x−= = =
Ω Ω

kN
	

With: 2( ) 12(121.5 10) 1338s s sA t b clip mm= − = − =  
Total resistance of  web:

117.3 552.83 670.13n nsR R
+ = + =

Ω Ω
kN

Demand shear strength:

max( , ) max(476.08, 421.35) 476.08aV Puftop Pufbot= = =  kN
Demand/Capacity ratio:

476.08
/ 0.71

670.13
D C = =  

	 OK

4.4.7. Local web yielding
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Compression

Inertia radius of  stiffeners:

/ 12 12/ 12 3.46sr t= = = mm
Slenderness of  stiffeners:

/ r 0.65x 400/ 3.46 75.14KL = =  

20000
75.14 4.71 4.71 113.4

34.5y

KL E
r F

= < = =  

34.5
34.960.658 0.658 34.5 22.83cr y

kNF F
cm

   
= = =   
    

 

34.5
34.96

20.658 0.658 34.5 22.83
y

e

F
F

cr y
kNF F
cm

   
= = =   
    

 

Compressive strength shall be determined based on the limit state of  flexural buckling:

1 1
2 2 22.83 13.38 365.83

1.67
n

cr g
P F A x= = =
Ω Ω

kN

Demand axial strength is calculated by subtracting web resistance in local web yielding from maximum compressive 
force at bottom flange:

min( 421.35, 278.80, 37.89) 117.3 304.05compressionP = − − =  kN
Demand/Capacity ratio:

304.05
/ 0.83

365.83
D C = =  

	 OK

Yielding strength due to axial load

Gross section area of  transverse stiffeners: ( ) 22 2 (121.5 10) 12 2676g s sA b clip t x x mm= − = − =

Tensile yielding strength of  stiffeners: 21 1
34.5 10 2676 552.83

1.67y g
V F A x x−= = =
Ω Ω

kN

Demand axial strength is calculated by subtracting web resistance in local web yielding from maximum tension 

force at bottom flange: max( 421.35, 278.80, 37.89) 117.3 161.5tensionP = − − = kN

Demand/Capacity ratio: 161.5
/ 0.29

552.83
D C = =  

	 OK

4.4.8. Transverse stiffeners

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Welding stiffeners with rafter flange

Area of  flange weld:

( ) ( ) 22 2 2
7 121.5 10 7 517.25

2 2 2w s s st sA W L W b clip W mm= = − − = − − =
Load angle factor when force perpendicular with weld

1.5 1.51 0.5sin ( ) 1 0.5sin (90) 1.5χ θ= + = + =
Weld strength of  total flange weld:

( ) ( )max , max 161.5, 304.05 304.05a tension compressionV P P= = = kN
Demand shear strength:

( ) ( )max , max 161.5, 304.05 304.05a tension compressionV P P= = = kN
Demand/Capacity ratio:

304.05
/ 0.79

385.27
D C = =  

	 OK

Welding stiffeners with rafter web

Area of  web weld:

1 1
4 0.6 4 0.6 41.4 1.0 18.96 941.93

2
n

EXX w
R F A x x xχ   = = =   Ω Ω   
Load angle factor when force parallel with weld 1.5 1.51 0.5sin ( ) 1 0.5sin (0) 1.0χ θ= + = + =

Weld strength of  total web weld:

1 1
4 0.6 4 0.6 41.4 1.0 18.96 941.93

2
n

EXX w
R F A x x xχ   = = =   Ω Ω   

kN

Demand shear strength: ( ) ( )max , max 161.5, 304.05 304.05a tension compressionV P P= = =
 
kN

Demand/Capacity ratio: 304.05
/ 0.32

941.93
D C = =  

	 OK
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4.4.9. Checking diagonal stiffeners
Yielding strength due to axial load

Section area of  diagonal stiffeners: ( ) ( )2 2 109 10 12 2376g ps psA b clip t= − = − = mm2

Tensile yielding strength of  stiffeners: 1 1
34.5 23.76 490.85

1.67
n

y g
R F A x= = =
Ω Ω

kN

Demand axial strength is calculated by subtracting web resistance in panel web shear from maximum of  tensile 
force at bottom flange and compressive force at top flange:

( )max min 476.08, 234.02,166.09 , max( 421.35, 278.80, 37.89) 433.83 155.03
0

cos costensionP
θ θ

 − − − − = = < kN

Because required strength is negative so it’s not necessary  to check tensile yielding strength of  diagonal 
stiffeners.
Checking compressive strength of  diagonal stiffeners

Inertia radius of  stiffeners: / 12 12/ 12 3.46psr t= = = mm

Slenderness of  stiffeners: 20000
191.33 4.71 4.71 113.4

34.5y

KL E
r F

= > = =  

	

20000
191.33 4.71 4.71 113.4

34.5y

KL E
r F

= > = =  

	

2 2

2 2 2

20000
5.39

191.33e
E x kNF

cmKL
r

π π
= = =
 
 
 

 

	
20.877 0.877 5.39 4.73cr e

kNF F x
cm

= = =  

Compressive strength shall be determined based on the limit state of  flexural buckling:

1 1
2 2 4.74 11.88 67.44

1.67
n

cr g
P F A x= = =
Ω Ω

kN

Demand axial strength is calculated by subtracting web resistance in panel web shear from maximum of  compressive 
force at bottom flange and tensile force at top flange:

	

Demand/Capacity ratio: 56.62
/ 0.84

67.44
D C = =  

	 OK

( )

( ) ( )

max max 476.08, 234.02,166.09 , min( 421.35, 278.80, 37.89) 433.83
cos

42.25 42.25
56.62

800 2 20 /1018.472 /

compression

c fc ps

P

kN
xh t L

θ
− − −  =

= = =
−−
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Welding stiffeners with rafter flange

Area of  flange weld: ( ) ( ) 22 2 2
7 109 10 7 455.38

2 2 2w ps ps ps psA W L W b clip W mm= = − − = − − =

Load angle factor when force perpendicular with weld: 1.5 1.51 0.5sin ( ) 1 0.5sin (90) 1.5χ θ= + = + =

Weld strength of  total flange weld: 
1 1

4 0.6 4 0.6 41.4 1.5 4.55 339.07
2

n
EXX w

R F A x x xχ   = = =   Ω Ω   
kN

Demand shear strength: ( ) ( )max , max 0,56.62 56.62a tension compressionV P P= = =
 
kN

Demand/Capacity ratio: 56.62
/ 0.17

339.07
D C = =  

	 OK

Welding stiffeners with rafter web

Area of  web weld: ( ) ( ) 22 2 2
7 1018.47 10 7 4957.02

2 2 2w ps ps ps sA W L W L clip W mm= = − − = − − =

Load angle factor when force parallel with weld 1.5 1.51 0.5sin ( ) 1 0.5sin (0) 1.0χ θ= + = + =

Weld strength of  total web weld: ( ) ( )max , max 0,56.62 56.62a tension compressionV P P= = = kN

Demand shear strength: ( ) ( )max , max 0,56.62 56.62a tension compressionV P P= = = kN

Demand/Capacity ratio: 56.62
/ 0.02

2462.64
D C = =  

	 OK
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4.5. Single Plate Connection Design
4.5.1. Input
4.5.1.1 Loading

Run the model and specify all beam having section B1. Select the Display > Show Tables command to show 
Choose Tables for Display form. Make sure that the Table: Element Forces - Frames item and ENVE 
combination in the Select Load Cases form are selected before click the OK button.

In Element Forces tables, select File > Export Current Table > To Excel. 

Figure 4 118  Choose Tables for Display form

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Figure 4 118  Choose Tables for Display form

NOTE	
Take absolute value for both shear and axial force to enter into “Bolt Connections” file.
In excel file just exported, in Station column, select stations at two ends of  beam. Filter the largest 
value in “V2” column and largest value in “P”, enter these value to “Bolt Connections” file.
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4.5.1.2 Material and geometry

In order to illustrate a single plate connection with full of  dangerous cases, we assume information as figure below.

CHAPTER 4. MAIN FRAME AND CONNECTION -
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Shear strength of  bolt group:

223.08 45 1
4 217.71

2
n nv b v

xx x xR CF A n
π

= = =
Ω Ω

kN
	 Where:

−	 C: coefficient for eccentrically loaded bolt groups (represents the number of  bolts that are effective 
in resisting the eccentric shear force) is selected from table 7-8 AISC Steel Construction Manual 13th, 
with n=4, s=75mm (3in), ex=202mm (7.95in), using interpolation method we find out C value is 
approximately 3.08. 

4.5.2. Plate (beam side)
4.5.2.1 Bolt shear

−	 nv: number of  shear plane through bolt. In this case, nv=1.

Demand shear strength for bolt group:

2 2 2 250 200 206.16aV P V= + = + = kN

Demand/Capacity ratio 206.16
/ 0.95

217.71
D C = = : OK
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Shear yielding strength 
of  plate

1 1
0.6 0.6 34.5 30.5 1.4

1.5c y gV F A= = × × ×
Ω

589.26 kN

Plastic section modul of  
plate

2 21.4 30.5
4 4

p p
pl

t L xZ = = 325.59 cm²

Flexural yielding 
strength of  plate 31 1

34.5 325.59 10
1.67c y plM F Z −= = × ×

Ω
67.26 kNm

Demand moment 
strength 200 0.202aM Ve= = × 40.4 kNm

Demand shear strength
aV 200 kN

Demand/Capacity ratio 2 2200 40.4
/ 0.48

589.26 67.26
D C    = + =   

   
OK

4.5.2.2 Shear yielding/buckling and flexure yielding

4.5.2.3 Bolt bearing under shear load

Distance from edge of  
outermost hole to edge of plate 1 2 40 22/ 2lc ev hl L d l= − = − 29 mm

Distance from edge of  hole 
to hole

75 22c b hl p d= − = − 53 mm

Bolts bearing capacity at 
outermost bolts

1 1 12(0.6 ) 1.2 1.2 2.9 1.4 44.8n u c c ur F l t l tF= = = × × × 218.27 kN

Bolts bearing capcity 
between bolts

2 2(0.6 ) 1.2 1.2 5.3 1.4 44.8n u c c ur F l t l tF= = = × × × 398.90 kN

Maximum bearing capacity (max) 2(0.6 2 ) 2.4 2.4 2 1.4 44.8n u ur F dt dtF= = = × × × 301.06 kN

Total bearing capacity

( )

1 2 (max)
1

C min( , r , )
1

3.08 min 218.27; 398.90; 301.06
2

n
n n n

R r r=
Ω Ω
= ×

336.14 kN

Demand shear strength aV 200 kN

Demand/Capacity ratio 200
/ 0.59

336.14
D C = = OK
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4.5.2.4 Shear yielding

4.5.2.5 Shear rupture

4.5.2.6 Block shear rupture

4.5.2.7 Flexure rupture

Shear yielding strength of  plate 1 1
0.6 0.6 34.5 30.5 1.4

1.5
n

y g
R F A= = × × ×
Ω Ω

 aV
589.26 kN

Demand shear strength aV 200 kN

Demand/Capacity ratio 200
/ 0.34

589.26
D C = = OK

Net area of  plate ( )[L n(d 1.6)] 305 4 22 1.6 14nv p hA t= − + = − +  
2948.4 mm²

Shear rupture strength of  plate 0.6 0.6 44.8 29.48
2

n u nvR F A × ×
= =

Ω Ω
396.21 kN

Demand shear strength
aV 200 kN

Demand/Capacity ratio 200
/ 0.50

396.21
D C = = OK

Net area subject to shear
( ) ( )( )

[( 1) ( 0.5)( 1.6)]t
4 1 75 40 4 0.5 22 1.6 14

nv ev hA n s L n d= − + − − +
= − + − − +  

2553.6 mm²

Net area subject to tension
( ) ( )( )

[ ( 1) ( 0.5)( 1.6)]
40 2 1 100 2 0.5 22 1.6 14

nt eh c c hA L n g n d t= + − − − +
= + − − − +  

1464.4 mm²

Gross area subject to shear ( )[( 1) ] 4 1 75 40 14gv evA n s L t= − + = − +   3710 mm²

Block shear rupture strength of  
plate ( )

1
[U min(0.6 ; 0.6 )]

1
0.5 44.8 14.64 min 0.6 34.5 37.1; 0.6 44.8 25.54

2

n
bs u nt y gv u nv

R F A F A F A= +
Ω Ω

= × × + × × × ×  
 

(Ubs is taken equal to 0.5 due to the tension stress is 
nonuniform for two of  column of   bolts)

507.4 kN

Demand shear strength
aV 200 kN

Demand/Capacity ratio 200
/ 0.39

507.4
D C = = OK

Plastic section modul of net section 

will be calculated as below

Flexure rupture strength of plate

234186 mm³

52.46 kNm

2 2
2

2 2
2

( 1)(d 1.6)
L

4
14 75 4 (4 1)(22 1.6)

305
4 305

h
net p

p

s n ntZ
L

x x

 − +
= − 

  
 − +

= − 
 

44.8 234.19
2

n u net

b b

M F Z x
= =

Ω Ω
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Demand moment strength

Demand/Capacity ratio

30.4 kNm

OK30.4
/ 0.58

52.46
D C = =

4.5.2.8 Bolt bearing under axial load

4.5.2.10 Tension rupture

4.5.2.9 Tension yielding

Distance from edge of  outermost 
hole to edge of  plate 1 2 40 22/ 2lc eh hl L d l= − = − 29 mm

Distance from edge of  hole to hole 100 22c hl g d= − = − 78 mm

Bolts bearing capacity at outermost 
bolts 1 1 12(0.6 ) 1.2 1.2 2.9 1.4 44.8n u c c ur F l t l tF= = = × × × 218.27 mm

Bolts bearing capcity between bolts
2 2(0.6 ) 1.2 1.2 7.8 1.4 44.8n u c c ur F l t l tF= = = × × × 587.06 kN

Maximum bearing capacity
(max) 2(0.6 2 ) 2.4 2.4 2 1.4 44.8n u ur F dt dtF= = = × × × 301.06 kN

Total bearing capacity

( )

1 2 (max)
1

C min( , r , )
1

3.08 min 218.27;587.06; 301.06
2

n
n n n

R r r=
Ω Ω
= ×

336.14 kN

Demand axial strength
aP 50 kN

Demand/Capacity ratio 50
/ 0.15

336.14
D C = = OK

Tension yielding 
strength of  plate

1 1
34.5 30.5 1.4

1.67
n

y g
R F A= = × ×
Ω Ω

882.13 kN

Demand axial strength aP 50 kN

Demand/Capacity ratio 50
/ 0.06

882.13
D C = = OK

Net area subject to tension ( )[L n(d 1.6)] 305 4 22 1.6 14np p hA t= − + = − +   2948.4 mm²

Axial rupture strength of  plate 44.8 29.48
2

u npn
F AR x

= =
Ω Ω

660.35 kN

Demand axial strength
aP 50 kN

Demand/Capacity ratio 50
/ 0.08

660.35
D C = = OK

200 0.152a aM V a= = ×
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4.5.2.11 Tear out under axial load

Net area subject to shear
( ) ( )( )

2[( 1) ( 0.5)( 1.6)]t
2 2 1 100 40 2 0.5 22 1.6 14
nv c eh c hA n g L n d= − + − − +

= − + − − +  

2928.8 
mm²

Net area subject to tension
( ) ( )

( 1)[s ( 1.6)]
4 1 75 22 1.6 14

nt hA n d t= − − +
= − − +  

2158.8 
mm²

Gross area subject to shear ( )2[( 1) ] 2 2 1 100 40 14gv c ehA n g L t= − + = − +   3920 mm²

Block axial rupture strength 
of  plate ( )

1
[U min(0.6 ; 0.6 )]

1
1 44.8 21.59 min 0.6 34.5 39.2; 0.6 44.8 29.29

2

n
bs u nt y gv u nv

R F A F A F A= +
Ω Ω

= × × + × × × ×  

(Ubs is taken equal to 1 because the tension stress is uniform 
for all of  rows of  bolts)

877.27 kN

Demand axial strength
aP 50 kN

Demand/Capacity ratio 50
/ 0.06

877.27
D C = = OK

4.5.3. Beam checking

Checking bolt bearing under shear load and tension load, shear yielding, tension rupture and tear out under axial 
load similarly for beam. The other limit states are not necessary.
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5.1. Crane Types 
CHAPTER 5. CRANE SYSTEMS DESIGN

The most common crane systems used in steel buildings are given in Table 5 1. 

These categories of  crane service classification have been established in Table 5 2. 

This document refers only to Classes A through D.

Crane Type Power Source Description Span or Reach (m) Capacity (Tons)

Under hung or Monorails Hand Geared or 
Electric Single Girder 3 ÷ 15.24 1/2 ÷ 10

Top Running 

Hand Geared or 
Electric Single Girder 3 ÷ 15.24 1/2 ÷ 10

Electric Double Girder 6 ÷ 18.29 5 ÷ 25
Electric Box Girder

Pendant-Operated
4-Wheel End Truck

6 ÷ 27.43 5 ÷ 25

Electric Box Girder 
Cab Operated 
4-Wheel End Truck

15.24 ÷ 30.48 Up to 60

Electric Box Girder 
Cab Operated 
8-Wheel End Trucks

15.24 ÷ 30.48 Up to 250

JIB Cranes 
Hand Geared or 
Electric

Floor Mounted 280° ÷ 360°
Column Mounted 180° 2.43 ÷ 6 1/4 ÷ 5

Table 5 1 General Range of Crane Types

Table 5 2 CMAA Crane Service Classes5

Class

CLASS A 
(Standby or 
Infrequent Service)

CLASS B 
(Light Service)

CLASS C 
(Moderate Service)

CLASS D 
(Heavy Service)

CLASS E 
(Severe Service)

CLASS F 
(Continuous Severe 
Service)

Usage range

Power houses, public utilities, turbine rooms, 
motor rooms, and transformer stations, etc.

light assembly facilities, repair shops, service 
buildings, and warehousing, etc.

manufacturing, machine shops, or paper mill 
machine rooms, etc.

heavy machine shops, foundries, fabricating 
plants, steel warehouses, container yards, 
lumber mills, etc.

Magnet/bucket combination cranes for heavy 
items like crap yards or production mills, cement 
mills, lumber mills, fertilizer plants, and container 
handling, etc.

industrial settings, etc.

Description

slow speeds and with long periods of idling 
between each lift.

•	 slow speeds and light service. 
•	 2 to 5 lifts per hour, 
•	 average lift distance of 10 feet

•	 average loads is 50% of the rated capacity, 
•	 5 to 10 lifts per hour
•	 average lift distance of 15 feet

•	 quick speeds and moved constantly
•	 loads approaching 50% of the capacity 

throughout the workday but not over 65%, 
•	 10 to 20 lifts per hour
•	 average heights of 15 feet

•	 loads approaching rated capacity 
throughout their lifetime

•	 more than 20 lifts per hour
•	 require more frequent maintenance and 

provide the highest reliability possible.

•	 high capacity loads with constant frequency
•	 require the ability to handle the most 

extreme working conditions.

5Crane Manufacturers Association of America CMAA (2008),
Specification No. 70, Charlotte, NC.
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Figure 5 1 Underhung Bridge Crane

Figure 5 2 Monorail Crane

Figure 5 3 Overhead Crane in Design Example

The monorail cranes are characterized by the hoist being 
suspended from the lower flange of  a single supporting runway 
beam (See Figure 5 2). Monorails are used where the need to lift 
and move items can be confined to one direction.

Top Running Cranes 
as show in Figure 5 3 
are generally used in 
workshops and warehouses 
where lifting capacity is 
required over a large span 
of  the floor area. 
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Figure 5 4 Jib Crane

Column Mounted Jib
Crane

Column Mounted Jib Crane with
Supplemental Column

Top Running Cranes usually provide greater hook height and clearance below the crane girder than underhung 
cranes. 

The JIB crane is a crane that has a rotating horizontal boom attached to a fixed.

Bridge cranes can be designed having either single girder, double girder or box girder. 

Single girder is generally used on shorter spans and lower capacities or service classifications.  Double girder cranes 
provide greater hook height, but are no more durable than single girder cranes. However, crane and accessories 
such as bridge cranes, hoist, and trolley, etc. are provided by the manufacturer, not by BMB&A.

CHAPTER 5. CRANE SYSTEMS DESIGN - 
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5.2. Design procedure 
The clients will usually show their basic requirements in the design brief. Then the designers need to establish 
various parameters that will influence the structural design of  the building. 

These may include like below:

(1)	 Crane type (top running, underhung, etc.);

(2)	 Capacity (rated in tons) and service classification (CMAA);

(3)	 Power source: most use electric instead of  hand geared.

For electric powered cranes, method of  operation (pendant, cab, or radio);

(4)	 Crane load:

a.	 The self-weight: Bridge weight (CW) and weight of  trolley with hoist (HT);

b.	 Maximum wheel load without impact;

c.	 Special allowances for vertical impact, lateral force, longitudinal force, or the loads factored for dynamic 
effects and lateral loads, if  required.

(5)	 Dimensions:

a.	 The building layouts

b.	 Number wheelbase (NWb), distance between cranes (LCr), end-truck length (N), distance wheelbase(W);

c.	 Level of  the top of  rail (TOR), the clearance above the top of  the rail, Horizontal clearance, vertical 
clearance, and clearance beneath the runway beam or hook height.

(6)	 Deflection limits for the crane runway beam and portal frame. 

Utilization and state of  loading for fatigue assessment.

Once the crane wheel loads and overall geometry have been established, the general design procedure is as given 
below:

(1)	 Design the runway beams 

(2)	 Determine the crane load reactions on the bracket and load combinations

(3)	 Design of  main frames.

NOTE	
There can be a significant difference in wheel loads and geometry between single and double 
girder cranes. If  the designer cannot establish the make of  the crane, then a contingency of  
10% load could be added to the load provided by one manufacturer to allow for other make 
which might be adopted.
The speed of  hand-geared cranes is low, and the impact forces which supporting structures 
may resist are low compared to the faster electric powered cranes. 
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5.3. Design the runway beam

CHAPTER 5. CRANE SYSTEMS DESIGN - 

It is assumed the crane runway 
beams are simple beams 
supported at the brackets that 
cantilever from the main portal 
columns. 

NOTE	
Bracing 
When runway beam depth is less than 900mm, top flange beam need to be braced by 
I-260x164x5x6, and V50x50x5 or larger if  necessary.
When runway beam depth is not less than 900mm, need to use both top and bottom flange 
bracing, by I-260x164x5x6, and V50x50x5 or larger if  necessary.
Width of  runway beam’s top flange
When length of  building is greater than 50m, the width of  runway beam’s top flange need to 
be greater than 200mm to avoid errors in rail installation.

Figure 5 5 Schematics of Crame Runway Beam
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5.3.1. Crane Wheel Load 
Wheel Load

The maximum wheel load ( ) and the minimum wheel load ( ) can be provided by the crane manufacturer 
or may be conservatively approximated from the crane loads as follows:

Lateral Force

The lateral force shall be assumed to act horizontally at the traction surface of  a runway beam, in either direction 
perpendicular to the beam, and shall be distributed with due regard to the lateral stiffness of  the runway beam and 
supporting structure.

The lateral force in each end-truck wheel on crane runway beams with electrically powered trolleys shall be 
calculated as below:

20%
RC HTT

NWb
+

=

Longitudinal Force

The longitudinal force, acting horizontally at the top of  the rails and in each direction parallel to each runway beam 
on crane runway beams, shall be calculated as 10 percent of  the maximum wheel loads excluding vertical impact:

max10%P WL=

where,

WL 	 = Maximum wheel load

RC 	 = Rated capacity of  the crane

HT 	 = Weight of  hoist with trolley

CW 	 = Weight of  the crane excluding the hoist with trolley

NWb 	 = Number of  end truck wheels at one end of  the bridge

(2012MBSM, Eq. 2.4.1-1)max
0.5RC HT CWWL

NWb
+ +

=

min
0.5CWWL
NWb

=

Vertical Impact Force 

The maximum wheel load ( ) used for the 
design of  runway beams, including monorails, 
their connections and support brackets, shall 
be increased by the percentage given below to 
determine the induced vertical impact or vibration 
force.
Vertical impact shall not be required for the design 
of  frames, support columns, or the building 
foundation.

Crane Type

Monorail cranes (powered)

Cab-operated or radio operated bridge 
cranes (powered)

Pendant-operated bridge cranes 
(powered)

Bridge cranes or monorail cranes with 
hand-geared bridge, trolley and hoist

%

25

25

10

0
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5.3.2. Design runway beam using SAP 2000
Step-by-step moving-load analysis is initiated through the following process:

•	 Define Vehicles type through Define > Moving Loads > Vehicles: 
VEH-X: defines the maximum wheel load.  
VEH-Y-T50: defines 100% Lateral Forces. 
VEH-Y-T100: defines 50% Lateral Forces.

•	 Define The Paths through Define > Moving Loads > Paths. 
PATH-X: defines the lane in X-axis. 
PATH-Y: defines the lane in Y-axis.

•	 Define Moving-load Patterns and Cases through Define > Load Patterns and Load Cases: 
DEAD: defines self-weight of  model. 
WLmax: defines moving-load VEH-X on PATH-X lane.
T100: defines moving-load VEH-Y-T100 on PATH-Y lane. 
T50: defines moving-load VEH-Y-T50 on PATH-Y lane. 
Set the load-case type to Moving Load, and then specify the vehicles and paths assigned to this moving 
load, as shown below:

Figure 5 6 Load-case Data
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Combinations

Checklist Combinations Load case Output

Strength

M33 DL + WLmax M33 & M22

M22-T100 T-100 M22 & V33

M22-T50 T-50 M22 & V33

Deflection

CV-X DL + WLmax/α
One crane on single aisle: α = Vertical Impact I
Other case: α = 1

∆x

CV-Y-T100 T-100 ∆y

CV-Y-T50 T-50 ∆y

Analysis 

•	 Set Analysis Options: Plane Frame.
•	 Sum ratios of  runway beam both axis should be less than 1.0.
•	 Check Deflection as table below:

Output 

Using BMB’s calculation sheet presents the images and data of  the runway-beam design.

Table 5 3 Types Deflection Limitations for Top Running Cranes6  

DEFORMATION REMARK

Top Running Cranes	

1/ Runway Beam (vertical deflection)

L/600 (Classes A/B/C)
L/800 (Class D)
L/1000 (Class E/F)

CV-X

2/ Runway Beam (horizontal deflection) L/400 CV-Y-T100 & CV-Y-T50

Underhung and Monorail Crane 

Runway Beam (vertical deflection) L/450 (Classes A/B/C)

Crane Bracket (horizontal deflection) DL + CR or WL 10yr.

Crane lateral or WL 10yr. 1/ Cab or Radio - Operator cranes H/240 or ≤ 5.08cm
 2/ Pendant - Operator cranes H/100

CV-X
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Schematic Vertical Impact Lateral Force

Multiple

aisles 
with

multiple

cranes

Any one crane in 
any aisle

0% 100%

Any two adjacent 
cranes in any aisle

0% Both cranes 50% Both cranes, or

100% Either crane

Any one crane in 
any two adjacent 

aisles

0% Both cranes 50% Both cranes, or

100% Either crane

Any two adjacent 
cranes in any 
aisle and one 

crane in any other 
nonadjacent aisle

0% All cranes 50% All three 
cranes, or

100% Any one crane

CHAPTER 5. CRANE SYSTEMS DESIGN - 

Figure 5 7 Crane Loading Conditions

Table 5 4 Loading for Building Frames and Support Columns

5.4. Design Steel Frame
5.4.1. General
The general design main frame procedure is as given below:

1. Determine the load reactions on the bracket.

2. Add the crane runway beam dead load to the dead load and add the following new load case:

a. Crane loads with the maximum wheel load at left column.

Lateral crane loads with maximum at left column and acting from right to left.

b. Crane loads with maximum load at right column.

Lateral crane loads with maximum at right column and acting from left to right

Crane buildings have single or multiple cranes acting in one or more aisles shall be designed with the crane or cranes 
located longitudinally in the aisle or aisles in the positions that produce the most unfavorable effect. Unbalanced 
loads shall be applied as induced by a single crane operating in a crane aisle, and by a crane or cranes operating in 
one crane aisle of  a building with multiple crane aisles. See Table 5 4 for a summary of  these provisions.
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5.4.2. Bracket System 

5.4.3. Bracing

Figure 5 8 Loading on bracket

Figure 5 9 Bracing of minor axis 

The lateral load on a crane runway beam is transmitted to the main frame column by the bracing systems in the 
minor axis.
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Figure 5 10 Building Layout 

5.5. Design example - One Crane per Aisle
5.5.1. Input
Bay spacing 	 B = 7.50 m

Crane Data	 5 Tons Top Running Crane, 13.72 m span, Class C, top of  rail 5.75 m 

Bridge weight	 CW = 2.79 Tons

Hoist and trolley weight	 HT = 0.5 Tons

Service classification	 Class C, Radio Operation

2 End-truck wheel	 End-truck length N = 2.184 m, Distance Wheelbase W = 1.829 m

CHAPTER 5. CRANE SYSTEMS DESIGN - 
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5.5.2. Crane Load 
Crane Wheel Load

Loading for Runway Beam

Loading for Building Columns

Crane Wheel Load

Lateral Force 

Longitudinal Force

Vertical impact

Maximum vertical wheel load

100% Lateral Force 
Longitudinal Force

Vertical load on column near trolley	
		

Vertical load on column away from 
trolley			 

Lateral load on building columns

Longitudinal load on building columns

max (5 0.5 0.5 2.79)/ 2 10WL = + + × ×

min 2.79/(2 2) 10WL = × ×

20%(5 0.5)/ 2 10T = + ×

10% 34.5P = ×

I  (Radio Operation)

max 34.5 1.25WL I× = ×

= =100 5.5T T

0.1 maxP WL NWb= × ×
 

0.1 34.5 2= × ×

max max (1+( )/ )D WL B W B= × −

34.5 (1+(7.5 1.829)/7.5)= × −

min min (1+( )/ )D WL B W B= × −
7.0 (1+(7.5 1.829)/7.5)= × −

max (1+( )/ )T T B W B= × −

5.5 (1+(7.5 1.829)/7.5)= × −

0.1 maxP WL NWb= × ×

34.5 (kN)

7.0 (kN)

5.5 (kN)

3.45 (kN)

1.25

43.1 (kN)

5.5 (kN)

6.9 (kN)

60.6 (kN)

12.3 (kN)

9.66 (kN)

6.9 (kN)
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5.5.3. Runway Beam Modeling

Figure 5 11 Runway Beam in SAP2000 Modeling
Section: RB (I – 766x184x8x10), U (U 120x52x4.8x7.8)
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Define Vehicles type

(a) Define Vehicles

(b) Vehicles “VEH-X” defined for WLmax

Figure 5 12 Define Vehicles

(c) Vehicles “VEH- Y-T100” defined for T100
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Define Paths

Figure 5 13 Define Paths of Moving Loads *
PATH-X defined the path on the Major-axis (beams labeled 1 and 2)
PATH-Y defined the path on the Minor-axis (beams labeled 3 and 4)

Figure 5 14 Influence line

NOTE	
The discretization is as same as output-station spacing of  frame. The effect of  refining path 
discretization is apparent in the influence lines which follow (Figure 5 14):
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Define Load-Patterns

Load-case WLmax Data

Define Load-Case

Load-case T100 Data

Figure 5 15 Steel P-M Interaction Ratios of Runway Beam*

Output 

NOTE	
This ratio is only used for reference, since the SAP model does not include the longitudinal 
force. The total ratio of  the major and minor axis must be less than 1.00.
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Check Runway Beam by Calculation Sheet 

NOTE	
*Length Lb: the 
largest un-bracing 
length of  runway 
beam
*Factor Cb: get 
from Detail of  
Steel Stress Check 
Data
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Check Bolt Connection between Runway Beams to the Bracket

CHAPTER 5. CRANE SYSTEMS DESIGN - 
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Check Welding at Bracket
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The load frame

CHAPTER 5. CRANE SYSTEMS DESIGN - 

5.5.4. Main Frame

Columns supporting crane fixed about the major axes and pinned about minor axes.

CR1 Case

CR3 Caset

Typical Longitudinal Force for “CR1 Case”

CR2 Case

CR4 Case

The crane runway beam and rail are to be included as dead loads, applied at the bracket. Note that for clarity, dead 
loads (DL), live roof  loads (LL), wind loads (WL) are not shown in this example.
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The combinations

Deflection Checking

COMBO 1 DL + LL COMBO 16 DL + 0.75CR3 + 0.45WL1
COMBO 2 DL + 0.6WL1 COMBO 17 DL + 0.75CR4 + 0.45WL1
COMBO 3 DL + 0.6WL2 COMBO 18 DL + 0.75CR1 + 0.75CR3 + 0.45WL1
COMBO 4 DL + 0.75LL + 0.45WL1 COMBO 19 DL + 0.75CR1 + 0.75CR4 + 0.45WL1
COMBO 5 DL + 0.75LL + 0.45WL2 COMBO 20 DL + 0.75CR2 + 0.75CR3 + 0.45WL1
COMBO 6 DL + CR1 COMBO 21 DL + 0.75CR2 + 0.75CR4 + 0.45WL1
COMBO 7 DL + CR2 COMBO 22 DL + 0.75CR1 + 0.45WL2
COMBO 8 DL + CR3 COMBO 23 DL + 0.75CR2 + 0.45WL2
COMBO 9 DL + CR4 COMBO 24 DL + 0.75CR3 + 0.45WL2
COMBO 10 DL + CR1 + CR3 COMBO 25 DL + 0.75CR4 + 0.45WL2
COMBO 11 DL + CR1 + CR4 COMBO 26 DL + 0.75CR1 + 0.75CR3 + 0.45WL2
COMBO 12 DL + CR2 + CR3 COMBO 27 DL + 0.75CR1 + 0.75CR4 + 0.45WL2
COMBO 13 DL + CR2 + CR4 COMBO 28 DL + 0.75CR2 + 0.75CR3 + 0.45WL2
COMBO 14 DL + 0.75CR1 + 0.45WL1 COMBO 29 DL + 0.75CR2 + 0.75CR4 + 0.45WL2
COMBO 15 DL + 0.75CR2 + 0.45WL1 COMBO 30 0.6DL + 0.6WL1

COMBO 31 0.6DL + 0.6WL2

Case ‘DL+CR+WL 10yr.’: Y=0.72cm Case ‘DL + WL 10yr.’: Y=0.14cm

Figure 5 16 Crane Bracket Horizontal Deflection 

[ ] min[5.08 ;(575/ 240)] 5.08Y cm cm= =
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Steel stress check

NOTE	
When check steel column need to overwrite Factor “Unbraced Length Ratio (Major)” to 1.00 as 
Figure 5 17.

Figure 5 17 Define ratio for steel stress check
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6.1. General

6.2. Composite Slab

CHAPTER 6. MEZZANINE FLOOR DESIGN

Mezzanines and platforms are often required in industrial buildings. The type of  usage dictates design considerations. 
For proper design the designer needs to consider the following design parameters:

1.	 Occupancy or Use.
2.	 Design Loads (Uniform and Concentrated). 

The dead load includes the weight of  panel, concrete slab, finish floor and, wall on floor, and self-weight 
of  joist. 
The live load depends on the purpose of  the floor. Refer Chapter 2 for more details.

3.	 Type of  slab: composite slab, checkered plate, gratings, expanded metals, etc.  
Each type of  floor requires different design of  joists.
Mezzanine joists are analyzed and designed as simple span members. 
Joist beam spacing needs being less than 2000mm and depend on bay spacing for equal distances.

4.	 Stair, Opening, Guard rail requirements.
5.	 Design Criteria (if  required): Deflection limitation, Vibration Control, Lateral Stability Requirements.
6.	 Future Expansion.

Design Procedure 

1.	 Design of  Joists: 
2.	 Design of  Flooring
3.	 Design of  Main Frames

Composite Metal Deck Slabs – most commonly used today. Advantages:

−	 Stay in place form.
−	 Slab shoring typically not required.
−	 Metal deck serves as positive reinforcement.
−	 Metal deck serves as construction platform.

Shear connector can use Steel Headed Stud or Steel Channel Anchors. 

Steel headed stud anchors shall be welded through the deck to the steel cross section. Such anchorage shall be 
provided by steel headed stud anchors, a combination of  steel headed stud anchors and arc spot (puddle) welds, 
or other devices specified by the contract documents.

Figure 6 1 Composite Beam Dimensions with Ribs Perpendicular to Beam Span 
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6.2.1. Section Properties 
The section properties are reported with respect to the section local axes (2-3). Furthermore the section properties 
are reported assuming that the entire section is transformed into an equivalent area of  the specified base material.

Cross-section area

Moment of  Inertia 

Plastic Section Modulus 

Elastic Section modulus 

Radius of  Gyration 

Center of  gravity

2A bf tf tw hw= × × + ×

( )
3 3 3

3 2

12 12 12
w w w

i
t h h hbhIx Ay bf× −

= + = + ×∑ ∑

2

2
2 4i i

H tf hwZx A y bf tf tw−
= = × × × + ×∑

/ 2
IxSx

H
=

/rx Ix A=

;i i i i
C C

i i

F x F y
x y

F F
= =∑ ∑
∑ ∑
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For flexure, sections are classified as compact, non-compact or slender-element sections.

Width-to-Thickness Ratios of  I-shaped built-up sections are shown as below: 

Compact and Non-compact Requirements

Ratio: /b t  Limiting Width-to-Thickness Ratios for Flanges1

Compact Section Limits: 	 / 0.38 /pb t E Fyλ≤ =  

Noncompact Section Limits: 	 / 0.95 /r c Lb t k E Fλ≤ =

Ratio: / wh t
Limiting Ratios for Webs of  Doubly-symmetric I-shaped sections2

Compact Section Limits: 	 / 3.76 /ph tw E Fyλ≤ =  

Noncompact Section Limits: 	 / 5.70 /rh tw E Fyλ≤ =

Ratio: c wh t
Limiting Ratios for Webs of  Singly-symmetric I-shaped sections 3

Compact Section Limits: 	  

( )2

/
5.70 /

0.54 / 0.09

c
y

p
y

w p y

h E F
hh E F

t M M
≤ ≤

−

Noncompact Section Limits: 	 / 5.70 /rh tw E Fyλ≤ =

where: 345Fy MPa= : Modulus of  elasticity of  steel
345Fy MPa= : Specified minimum yield stress of  ST345

ck : Coefficient for slender unstiffened elements

4 ; 0.35 0.76
/c ck k

h tw
= ≤ ≤

LF : Magnitude of  flexural stress in compression flange at which flange local 
buckling or lateral-torsional buckling is influenced by yielding
For major axis bending of  compact and noncompact web built-up I-shaped 
members, with:

/ 0.7 : 0.75xt xc LS S F Fy≥ = ×  

/ 0.7 : / 0.5xt xc L xt xcS S F Fy S S Fy< = × ≥
/xt tS Ix h= : Section modulus about the x axis of  the outside fiber of  the tension 

flange, mm³.
y x yM S F=  : Section modulus about the x axis of  the outside fiber of  the 

compression flange, mm³.

y x yM S F=  : the yield moment of  the extreme fiber.	 (AISC F4-1)

p x yM Z F=  : the plastic bending moment.	 (AISC F4-2)

  7AISC 360-10, Table B4.1 Case 11.
  8AISC 360-10, Table B4.1 Case 15.
  9AISC 360-10, Table B4.1 Case 16. CHAPTER 6. MEZZANINE FLOOR DESIGN -

/ wh t
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Checking Dimension Requirements

Concrete slabs on formed steel deck connected to steel beams need to be satisfied the following requirements10 :
(1) The nominal rib height (hr) shall not be greater than 3 in. (75 mm).
(2) The average width of  concrete rib or haunch (wr) shall be not less than 2 in. (50 mm), but shall not be 
taken in calculations as more than the minimum clear width near the top of  the steel deck.
(3) The slab thickness above the steel deck shall be not less than 2 in. (50 mm).
(4) 	 a. The concrete slab shall be connected to the steel beam with welded steel headed stud anchors, 
not larger than 19 mm in diameter.
Steel headed stud anchors, after installation, shall be extended not less than 38mm above the top of  the 
steel deck and there shall be at least 13 mm of  specified concrete cover above the top of  the steel headed 
stud anchors.
		  b. The diameter of  a steel headed stud anchor shall not be greater than 2.5 times the thickness of  
the base metal to which it is welded, unless it is welded to a flange directly over a web.
		  c. Steel anchors shall have at least 1 in. (25 mm) of  lateral concrete cover in the direction 
perpendicular to the shear force, except for anchors installed in the ribs of  formed steel decks. The 
minimum distance from the center of  an anchor to a free edge in the direction of  the shear force shall be 8 
in. (203 mm) if  normal weight concrete is used and 10 in. (250 mm) if  lightweight concrete is used.
(5) The Stud spacing
		  a. Steel deck shall be anchored to all supporting members at spacing not to exceed 460 mm. 
		  b. The minimum center-to-center spacing of  steel headed stud anchors shall be six diameters 
along the longitudinal axis of  the supporting composite beam and four diameters transverse to the 
longitudinal axis of  the supporting composite beam, except that within the ribs of  formed steel decks 
oriented perpendicular to the steel beam the minimum center-to-center spacing shall be four diameters in 
any direction.
		  c. The maximum center-to-center spacing of  steel anchors shall not exceed eight times the total 
slab thickness or 36 in. (900 mm).

Figure 6 2 Dimension Requirements of Steel headed stud anchors

 10AISC 360-10, Section I3.2c, Section I8, page 146.
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Properties of  Transformed Section 

Check Bending Capacities

To calculate the moment capacity with an elastic stress distribution, first need to calculate the location of  the 
elastic neutral axis (ENA) and the transformed section moment of  inertia as below:

Moment Capacity for Positive Bending

max ; 1.67y
b b

tr b

FMf
S

= ≤ Ω =
Ω 

Moment Capacity for Negative Bending

 'max 0.45c c
t

Mf f
nS

= ≤

6.2.2. Beam Bending Capacities for Fully Composite Beam

Effective Width min( / 4; )
eff

L Bb
n

= (AISC 360-10 I3.1a)

Effective Thickness of  Slab

/ 2o s rt t h= −

where:
/s cn E E= : Modular ratio

cE : Modulus of  elasticity of  steel

cE : Modulus of  elasticity of  concrete

Height of  Composite Section
tr sd H h= +

Distance from Elastic Neutral 
Axis(ENA) to steel bottom of  
composite member

i i
b

i

A y
y

A
= ∑
∑

The transformed section moment 
of  inertia, about its ENA trI

Section modulus of  bottom edge : /(0.5 )b try H S Ix h≥ =

: /(0.5 )b try H S Ix h≥ =

Section modulus of  top edge tr
t

tr b

IS
d y

=
−

CHAPTER 6. MEZZANINE FLOOR DESIGN -
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6.2.3. Beam Shear Capacity
Shear Capacity

Checking the Beam Shear

The nominal shear strength of  unstiffened or stiffened webs of  all other doubly symmetric shapes and singly 
symmetric shapes and channels, is determined as follows:

The beam shear at the ends of  the beam is checked using the following equation.

(AISC 360-10 G2-1)

(AISC G2.1b, 1)

 Safety factor for shear 

The required shear strength	 

Shear capacity

where:

1.67vΩ =  

maxV

nV  

0.6n y w vV F A C= (AISC I4.2, G2-1)

where:

The web shear coefficient, is given by:	 (AISC G2.1b, G2-3)
(AISC G2.1b, G2-4)
(AISC G2.1b, G2-5)

vk The web plate buckling coefficient, is given by: (AISC G2.1b)   

For unstiffened webs with / 260hw tw < : 5vk =

For stiffened webs: 

+ 2

5
5

( / )vk
a h

= +

+ 5vk = for / 3.0a h >  or 
2260

/
/

a h
h tw

 >  
 

wA dt : area of  web

h for built-up welded sections, the clear distance between flanges

a clear distance between transverse stiffeners

Conditions vC

/ 1.10 vk Ehw tw
Fy

≤ 1.00

1.10 / 1.37v vk E k Ehw tw
Fy Fy

< ≤
1.10 /k E Fy

h tw

/ 1.37 vk Ehw tw
Fy

>
( )2

1.51
/

vk E
h tw Fy

vC

max
n

v

VV ≤
Ω
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6.2.4. Steel Anchors

Steel Headed Stud Anchor 

Shear connector capacities are defined for both shear studs and channel shear connectors. Next the equations 
used for determining the number of  shear connectors on the beam are provided.
The nominal shear force between the steel beam and the concrete slab transferred by steel anchors for Positive 
Flexural Strength:

The nominal shear strength of  one steel headed stud anchor embedded in a solid concrete slab

(AISC 360-10 G2.1b)

eff ob t n× × : area of  concrete slab within effective width

area of  steel cross section

where:

cA  

sA

CHAPTER 6. MEZZANINE FLOOR DESIGN -

{0.85 '' 0.5min c c

y s

f AV F A=

(AISC 360-10 I8.2a)

where:

saA cross-sectional area of  steel headed stud anchor, mm².

cE 1.50.043w ' ( )c cf MPa : Modulus of  elasticity of  concrete

w c Weight of  concrete per unit volume, assumed 2300 kg/m³

uf specified compressive strength of  concrete, MPa

uf specified minimum tensile strength of  a steel headed stud anchor
;g pR R

mid hte − distance from the edge of  steel headed stud anchor shank to the steel deck web, measured at 
mid-height of  the deck rib, and in the load bearing direction of  the steel headed stud anchor (in 
other words, in the direction
of  maximum moment for a simply supported beam).

0.5 'min sa c c
n

g p sa u

A f EQ R R A F


= 


Condition
gR pR

No decking 1.0 0.75

Decking oriented parallel to the steel shape / 1.5r rw h < 1.0 0.75

/ 1.5r rw h < 0.85(a) 0.75

Decking oriented perpendicular to the steel shape

Number of  steel headed stud anchors occupying 

the same decking rib

1 1.0 0.6(b)

2 0.85 0.6(b)

3 or more 0.7 0.6(b)

where:

rw : nominal rib height

rw : average width of  concrete rib or haunch
(a) for a single steel headed stud anchor

(b) this value may be increased to 0.75 when 2 . 51mid hte in mm− ≥ =

The table below presents values for gR  and gR  for several cases.
Capacities for steel headed stud anchors can be found in the Manual.
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Steel Channel Anchors 

Check Shear Connector Capacity

Checking Stress when made camber 

Checking Deflection of  Joist Beam

The nominal shear strength of  one hot-rolled channel anchor embedded in a solid concrete slab shall be 
determined as follows:

The number of  shear connectors is given as follows:

(AISC 360-10 I8.2a)

(AISC 360-10 I3.1c)

length of  channel anchor
thickness of  flange of  channel anchor
thickness of  channel anchor web

Number of  Stud each position
Shear Connectors Spacing
Length of  joist beam

where:

al  
tf
tw  

where:

rN  
s

L  

( ) '0.3 0.5n a c cQ tf tw l f E= +

'
2n n r
LQ Q N V
s

= ≥∑

6.2.5. Beam Deflection and Camber

Camber 	                                                                           
45

384
DL

DL
s

q L
EI

∆ = ×

Checking Stress	                                                                    DL

s b

M Fy
S

<
Ω

 

Effective moment of  inertia

Deflection by Floor Load

Deflection by Dead load & Floor load

(AISC 360-10 I3.2)0.75eff trI I=

[ ]
45

384 360
FL

FL
eff

q L L
EI

∆ = × ≤ ∆ =

[ ]
45

384 240eff

qL L
EI

∆ = × ≤ ∆ =
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Decking Properties

Checking the decking

It is necessary to determine decking’s material each project information.
Normally, yielding strength of  decking  is 235 MPa.

Loading impact on decking:  ( )c r CL concrete oq B q n G t= × × + ×

Checking capacity:

 
max ; 1.67b
x b

M Fy
S

≤ Ω =
Ω

Checking deflection :

 [ ]max 180
Bf f≤ =

[width  ]-[rid depth  ]-[rib spacing  ]-[ average width rib  ]

[1000]-[50]-[334]-[166]

[0870]-[75]-[ 287]-[ 148]

Thickness

0.75

455282
17842

922823
23643

0.95

574099
22441

1168944
29917

1.15

691840
26975

1415089
36178

6.2.6. Check Decking

Table 6 1 Properties of decking

Load assign decking (5 cases) Moment 3-3 Diagram

Figure 6 3 Schematics of Decking 

Shear 2-2 Diagram

  11SDI Composite Steel Floor Deck – Slabs, page 8, 2012.
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6.2.7. Design Example 8a - Composite Slab

6.2.7.1 Design Composite Joist Beam using Calculation Sheet

Input

Slab Loading

Loading

Slab thickness

Joist beam

Decking

Shear Connector

Concrete strength: B20

Steel

Load Case

Dead Load (DL)

Moment by Dead Load 

Moment by Dead Load & Floor Load

Maximum Shear by (DL+FL)

2 2/8 8.37 8 /8DLM qL= = ×
2 2/8 (8.37 1.5 5) 8 /8DL FLM qL+ = = + × ×
/ 2 (8.37 1.5 5) 8/ 2DL FLV qL+ = = + × ×

66.99 kN/m

126.93 kN/m

63.48 kN

Dead load applied on each joist:  0.334 3.6 1.5 2.955 8.37( / )DLq kN m= + + × =
Hence,

Include

Mass of  joist
Wall load
Surface sika 

Concrete slab
Mortar

Thickness (mm)

10

to = 95
20

G (kN/m³)

22

25
18

Design Load

0.334 kN/m
3.60 kN/m

2.955 kN/m²

Floor load (FL)  

Brick wall 1m height 0.2m thickness 
Wall load  18 1 0.2WL = × ×  

Included:
Surface sika, thickness 10mm, density 
22kN/mm³
Mortar, thickness 20mm, density 18kN/mm³

Section
Length 
Spacing

Type / Thickness (mm)
Construction method
Yielding strength, Fy 
Safety factor, n

Diameter/Height/Qty. each position/spacing 

Compression strength, fc’
Elastic modulus, Ec

ASTM specifications: A572 Grade 50
Yield strength, Fy
Ultimate strength, Fu
Modulus of  elasticity, E

5.0

3.6 

120.0

I – 508x148x5x6
8000.0
1500.0

[B1000 – hr50]/[0.75]
Don’t Use Support Column
235
1.5

[16]/[90]/[02]/[334]

16
18800

345
450
200000

kN/m²

kN/m

mm

mm
mm

MPa

MPa
MPa

MPa
MPa
MPa
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Section Properties

Classification of  Filled Composite Sections for Local Buckling

Checking Dimension Requirements

Cross-section area
Mass 

Moment of  Inertia 

Plastic Section Modulus 

Elastic Section modulus 

Radius of  Gyration 

Flanges: 
Noncompact

Web: 
Noncompact

Class: Noncompact

(1) The nominal rib height, hr
(2) The average width of  rib, wr
(3) The slab thickness 
(4) Steel headed stud anchors

Diameter
Height

Stud spacing

50 mm
166 mm
120 mm

16 mm

90 mm

334 mm

OK
OK
OK

OK

≤ 75 mm
> 50 mm
 50 100hr mm≥ + =

≤ 19 mm
2.5 1 2.5 6 15tf≤ × = × =

38 88hr mm≥ + =
5 16 80mm≥ × =  
120 13 107mm< − =  (slab cover above)

≤ 460 mm
. 6 16 96Min mm> = × =
. max(8 120;900) 960Max mm< = × =

0.38 200000/ 345pλ =

0.45 200000
0.95

0.75 345
rλ ×
=

×

4
: 0.35 0.45 0.76

396/5C Ck k
 

≤ = = ≤ 
 

/ 1.00 0.75xt xc LS S F Fy= ⇒ =

( )0.5 / 0.5 148/6 12.33 0.5 /p rB t B tλ λ= × = ⇒ < <

3.76 / 3.76 200000/ 345p E Fyλ = =

5.70 200000/ 345rλ =

( )/ 496/5 99.2 /p rh tw h twλ λ= = ⇒ < <

9.15

18.65

0.45

90.53

137.23

2 148 6 496 5A = × × + ×
78.5A×

3 3 35 496 508 496
148

12 12
Ix × −

= + ×

502 496 496
2 148 6 5

2 2 4
Zx  = × × × + × × 

 

2 1.63 08/508Sx E= × +

1.63 08/ 4256rx E= +

4256
0.334

1.63E8

753296

6.41E5

195.5

mm²
kN/m

mm4

mm³

mm³

mm

CHAPTER 6. MEZZANINE FLOOR DESIGN -
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min(8000/ 4;1500)/10.64effb =
200000/18800n =

120 50/ 2ot = −

120 508 628trd mm= + =

141 95 (508 120 95/ 2) 4256 508/ 2
141 95 4256by × × + − + ×

=
× +

4.24 8 9.31 7tr s cI I I E E= + = +
2 2( ) 1.63 8 4256(254 501.77)s c bI Ix A y y E= + − = + −

3 2141 95 /12 141 95 (628 95/ 2 501.77)cI = × + × × − −

5.17 8
501.77 508 :

501.77b tr
Ey H S= < = =

5.17 8
628 501.77t

ES =
−

141

10.64

95

501.77

5.17E8

4.24E8

9.31E7

1.03E6

4.1E6

Effective Width

Modular ratio

Effective Thickness of  Slab

Height of  Composite Section

Distance from ENA to steel 
bottom of  composite member

The transformed section moment 
of  inertia, about its ENA

Section modulus of  bottom edge

Section modulus of  top edge

Positive Bending

 y
b

b

F
f <

Ω
: OK

Negative Bending
'0.45c cf f<  : OK

The web shear coefficient

The available shear strength 

Check Shear Capacity

	
	

0.44	

135.26	 kN

 
496 5 200000

99.2 1.37 73.76
5 345

w

w

h
t

×
= = > =

5vk =  for  / 5.4 3.0a h = >
where:  / 2500/ 496 5.4 3.0a h = = >

( )2

1.51 5 200000
496/5 345vC × ×

⇒ =
× 

0.6 345 3 0.496 0.005 0.44
1.67

n

v

V E× × × ×
=

Ω 

max 63.48n

v

V V kN> =
Ω

 : OK

1.23E5

2.10E5

2.9E3

7.2E3

kN/m²

kN/m²

kN/m²

kN/m²

3

126.93
1.03 6/1000bf E

=

345 3
1.67

y

b

F E
=

Ω

3

126.93
10.64 4.1 6/1000cf E

=
×

'0.45 0.45 16 3cf E= ×

mm

mm

mm

mm4

mm4

mm4

mm³

mm³

Determining Composite Properties for Plastic Design

Check Bending Capacities 

Check Shear Capacities
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The required Shear for Shear 
Connector

The nominal shear strength of  
each stud

The number of  shear connectors

where:

Camber

Checking Stress

Effective moment of  inertia

Deflection by Floor Load

Deflection by Dead load & Floor 
load

3.88E8 mm40.75 5.17E8effI = ×

[ ]
45 5 1.5 8 8000

5.26 22.2
384 200000 3.88E 4 360FL mm mm× ×

∆ = × = < ∆ = =
× −

[ ]
45 (5 1.5 8.37) 8 8000

10.91 33.3
384 240eff

mm mm
EI

× + ×
∆ = × ≤ ∆ =

4

4

5 8.37 8
1.63 8384 200000
1000

DL E
×

∆ = ×
×

2
3

66.99 345 3
1.05 5 2.07 6( / )

6.41 5/1000 1.67
EE E kN m

E
= < =

13.7 mm

: OK

{ 2
0.85 16 3 0.141 0.095 10.64 1938' 0.5min 345 3 4256/1000 1468

EV E
× × × × == × =

2

2

201.06
0.5 16 18800 1000 55.13

1000min 201.06
1.0 0.75 450 1000 67.86

1000

n

kN
Q

kN

 × × × == 
× × × × =



8000
55.13 2 1321 ' 734.16

2 334nQ kN V kN= × × = ≥ =
×∑

2 216 / 4 201.06( )saA mmπ= × =

' 16cf MPa=
1.50.043 2300 16 18800cE MPa= × =

1.00
/ 166/50 3.32 1.5 0.75

g
r r

p

R
w h R

== = ≥ ⇒  =
450uf MPa=

734.16	 kN

55.13	 kN

: OK

Check Shear Connector Capacity

Beam Deflection and Camber

Checking Deflection of  Joist Beam

CHAPTER 6. MEZZANINE FLOOR DESIGN -
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Design Data 

Checking the decking

Components

Section

Studs

Camber

Deflection

Loading impact on decking

Maximum Moment

Checking capacity

Checking deflection

8.375 kN/m

: OK

: OK

( )c r CL concrete oq B q n G t= × × + ×

1 (4 1.5 25 0.095)cq = × × + ×

max 1.86( )M kNm=

≤ = =
− Ω

21.86 235000
1.02 5 1.4 5( / )

1.78 5 1.67b

FyE E kN m
E

[ ]max
1500

4.52 8.33
180 180
Bf mm f mm= ≤ = = =

Types	

Preliminary dimension
Top flange
Bottom flange
Shear strength

Spacing

Camber
Capacity

Live load
Dead load & Live load

Conclusion

OK

OK

mm
OK

OK

Ratio

0.842
0.405
0.596
0.464

0.556

14
0.506

0.232
0.327

6.2.7.2 Design Composite Mezzanine Decking using Calculation Sheet

Decking [1000]-[50]-[334]-[166] thickness 0.75mm: = 31.78 4( )xS E mm ; = 31.78 4( )xS E mm
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6.3. Checkered Plate Slab
6.3.1. General

6.3.2. Detailing Requirement

Allowable thicknesses of  Checkered Plate are 4mm, 5mm, 6mm or 8mm (included ribbed plate).
Checkered Plate Slab can be designed with or without Flat Bar.

NOTE	
Incase floor load is not less than 4 kN/m²; designers should use Checkered Plate Slab with 
Flat Bar under.
If  floor load is less than 4 kN/m², Checkered Plate Slab without Flat Bar can be used with 
the joists having maximum spacing 1.2÷1.5m. 

Figure 6 4 Checkered Plate with Flat Bar
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Figure 6 5 Bolt Connection of Checkered Plate and Joists

Figure 6 6 Weld connection at the intersection of Checkered Plates

Figure 6 7 Design Strip of Checkered Plate with Flat Bar

6.3.3. Checkered Plate with Flat Bar
Design Strip Properties
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Figure 6 8 Uniformly Loaded Rectangular Plates with Simply Supported Edges

Check Deflection 

Checkered Plate is considered as a uniform loaded long rectangular plate with longitudinal edges which are 
free to rotate but cannot move toward each other during bending. The design strip cut out this plate is in the 
condition of  a uniformly loaded bar submitted to the action of  an tensile force H , as show in  Figure 6‑8. The 
magnitude of  H is such as to prevent the ends of  bar from moving along the x-axis.

CHAPTER 6. MEZZANINE FLOOR DESIGN -

Section area

Distance from Neutral Axis to bottom 

Inertia moment of  strip   

Cylindrical rigidity of  plate  

where,

 

2A d L b h= × + ×

/base i i iy A y A=∑ ∑

( )3 2

12 i
bhIx Ay= +∑ ∑

3
2/12eD Eh L= ×

E  , Young’s Modulus

eh , elastic thickness
0.3υ = , Poisson’s Ratio for steel

The maximum deflection [ ]1
1 180o

L
α

∆ = ∆ ≤ ∆ =
+

The maximum deflection caused by uniform load q
4

1

5
384o

x

ql
E I

∆ = ; where 1 21
EE
υ

=
−

The factor for the effect of  the tensile reactions at the ends of  the 
strip

1
1 α+

The ratio of  the tensile force α to the Euler critical load of  the 
elemental strip, α , is determined from the equation:

( )
2

21 3 o

t
α α ∆ + =  

 



230

DESIGN GUIDELINES

Check Bending

Check Weld Connection 

The tensile force subject on joint of  strip 2

2

DH
l

π α
=

The maximum bending moment 2

max 8
qlM H= − ∆

Check Stress
max ; 1.67y

x

FMH
A S

σ = + ≤ Ω =
Ω

Tensile force subject to weld
; 2.00n nv wR F AT ×

≤ = Ω =
Ω Ω

Allowable bearing capacity of  weld ; 2.00n nv wR F AT ×
≤ = Ω =
Ω Ω

Nominal stress of  the weld ( )1.50.6 1 0.5sinnw EXXF F θ= +

Area of  the weld 2
2w fA h= ×

6.3.4. Checkered Plate without Flat Bar
Formulae show ratio of  design length and slab thickness(According to formulae of  A.L.Teloian): 

1 1
4 4

4 4
1 75 1 75

15 15
o o

o o

n nl E El t
t n q n q

   
= + ⇒ = × +   

   

where 
1 1

180o

f
n L

 = =  
: Ratio of  allowable deflection of  slab.

Hence, available joist spacing (distance edge flange to edge flange of  joists) [ ]ol l≤ .
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Input

Properties Of  Design Strip

CHAPTER 6. MEZZANINE FLOOR DESIGN -

6.3.5. Design Example 8b - Checkered Plate with Flat Bar

Spacing of  Joist 1500 mm

Spacing of  Flat bar  600 mm

Checkered Plate Thickness d 4 mm

Flat bar Width, b 4 mm

Height, h 50 mm

Material ASTM specifications for Steel JIS 3101 /SS400

Yield strength, uF
235 MPa

Ultimate strength, uF
400 MPa

Modulus of  elasticity of  steel, E 200000 MPa

Welding Welding wire E60xx

Height of  fillet weld 3 mm

Floor load FL 5 kN/m²

2L

1L

Section area 24 600 4 50 2600A mm= × + × = 2600 mm2

Distance from Neutral Axis 
to bottom 

600 4 52 4 50 25
2600basey × × + × ×

=
49.9323 mm

Inertia moment of  strip   
3

2

3
2

600 4
600 4 (52 )

12
4 50

4 50 (25 )
12

base

base

I y

y

×
= + × × −

×
− + × × −

179451 mm4

Section modulus 179451
0.5 0.5 49.9323

x
x

x

IS
y

= =
×

7187.8 mm3

Cylindrical rigidity of  plate  32 8 0.004
0.6

12
ED ×

= ×
0.64 kNm 
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Check Deflection 

Check Bending

Modulus 1E
1 2

200000
2.2 5( )

1 0.3
E E MPa= =

−
2.2E5 MPa

Dead load 
2

2600
78.5 1.05

1000DLq = × × 0.214 kN/m²

Uniform load q ( )0.214 5 0.6DL FLq q q= + = + × 3.13 kN/m²

The maximum deflection 
caused by uniform load q

45 3.13 1.5
384 2.2 8 1.79 7o E E

×
∆ =

× −

5.24E-3 m

The ratio α ( ) {
2

2 5.24 3 1.5351 3 5.15 0.774 3
E

E
αα α α

−  =+ = = ⇒  = −− 

Choose 1.535α =

The maximum deflection ( ) 1
5.4 3

1 1.535
E∆ = − ×

+
2.1E-3 m

Check deflection [ ] 1.5
0.0833

180
m∆ ≤ ∆ = = OK

The tensile force 2

2

3.14 0.64 1.535
1.5

H × ×
=

4.3 kN

The maximum bending 
moment

2

max
3.13 1.5

4.4 2.1 3
8

M E×
= − × −

0.87 kNm

Tensile stress 4.4 0.87
2.6 3 7.19 6E E

σ = +
− −

1.23E8 kN/m²

Check Stress ( )2245 3
1.47 6 /

1.67
yF E E kN mσ ≤ = =

Ω

OK
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Check Weld Connection 

Conclusion
The type of  checkered plate (with or without flat bar) depends on the load and thickness (if  required).

CHAPTER 6. MEZZANINE FLOOR DESIGN -

Factor β 0.002
1.2 0.8 1

3/600
β = − = < 0.8

Tensile force subject to weld 4.3
0.6 0.8eff

HT
n bβ

= =
×

8.95 kN/m

Bearing capacity of  weld 3.73 5 2.12 3
2

nR E E× −
=

Ω
394.96 kN/m

2 / 2 0.003 1wA = × × 2.12E-3 m²

( )1.50.6 4.14 5 1 0.5sin 90nwF E= × × + ° 3.73E5 kN/m²

( )60EXXF ksi= 4.14E5 kN/m²

Check Welding ( )28.95 394.969 /nRT kN m= < =
Ω

OK

6.3.6. Design Example 8c - Checkered Plate without Flat Bar

Input: as same as Design Example 8b, Checkered Plate without Flat Bar.

Specify Thickness: 4.00 mm.

Then, check Deflection and Bending as same as Example 8a.

Dead load 4
78.5 1.05

1000DLq = × × 0.33 kN/m²

Uniform load q 0.33 5.00DL FLq q q= + = + 5.33 kN/m²

Joist spacing [ ] 4

4 180 2.2 8
0.004 1 75 0.758

15 180 5.33o
El m×  ≤ × + = × 

0.8 m
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Figure 6 9 Standard Grating

Standard Range – Readily available with either plain or serrated load bearings bars (5mm thick) at 40 pitch and 
twisted transverse bars at 50 or 100 centers.

6.4.2. Design Example 8c - Grating Slab
Input

Floor load FLq 3.0 kN

Span/Trench width b 1300 mm

Bearing bar x pitch (32 x 5) @max 40 mm

Allowable stress yF 235 MPa

Modulus of  elasticity of  steel E 200000 MPa

Allowable deflection [ ] / 240L∆ = 5.41 mm

Open steel rectangular pattern floor is constructed from mild steel and is constructed by a forge-welding process 
in which the load bearing and transverse bars are heated and joined under pressure.

Gratings is suitable for most floor walkways, gantries, platforms, etc. and could even be used upright as fencing.

6.4. Grating Slab
6.4.1. General
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Consider 1m width of  grating slab.

Moment of  inertia 35 32
12

Ix ×
= 13653 mm4

Elastic section modulus 13653
32/ 2

Sx = 853 mm3

Load per each Bearing bar 3
1000/ 40 1.3 1.0

FLqP
n b

= =
× × ×

0.0923 kN/m

Maximum Moment 2 2

max
0.0923 1.3

8 8
qlM ×

= = 0.0195 kNm

Maximum Stress
max 0.0195

8.53 7x

M
S E

σ = =
−

1.83E5 kN/m²

Check stress ( )2245 3
1.47 6 /

1.67
yF E E kN mσ ≤ = =

Ω
OK

Check deflection
[ ]

4 45 5 0.0923 1.3
0.00126

384 384 2 8 1.36 8
ql m
EI E E

×
∆ = = = < ∆

× −
OK
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7.1. Purlins and Girts Design
CHAPTER 7. ACCESSORIES

CHAPTER 7. ACCESSORIES -

7.1.1. General
Purlins and girts are the immediate supporting member for roof  and wall sheeting respectively. They act principally 
as beams, but also perform as struts and as compression braces in restraining rafters and columns laterally against 
buckling. 

Purlins and girts are almost universally zed (Z), channel (C), or double channel section members.

C-sections have equal flanges and may be used in single spans and un-lapped continuous spans in multi-bay 
buildings. Their freestanding stable shape allows easy handling and storage and is easily adapted for use in small 
and medium sized buildings as structural framework.
Z-sections feature one broad and one narrow flange allowing the two sections to fit together snugly, making 
them suitable for lapping. Z sections of  the same depth and different thickness’ can be lapped in any combination. 
Purlins and Girts that are lapped form a structurally continuous line along the length of  the building, a factor that 
contributes significantly to the reduction in building costs. 

Figure 7 1 Typical Purlins and Girts Details 
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7.1.2. Design procedure 

7.1.2.1 Purlin/Girt spacing

7.1.2.2 Loading

Purlins and girts can be calculated as simply supported spans, lapped continuous spans or increased thickness end 
spans in lapped continuous systems.

Purlin spacing must be chosen to suit the type of  roof  sheeting and ceiling system if  any. The use of  translucent 
fiberglass roof  sheeting will also restrict the purlin spacing. Some suspended ceiling systems require a maximum 
purlin spacing of  1200mm (DONGIL project). Purlin deflections must also be controlled.
Roof  purlins are to be arranged according to the following guide lines as applicable:
-	 700 mm between first roof  purlin and the eave strut
-	 Intermediate spacing not exceeding 1600 mm.

The maximum spans are determined not only from wind load considerations, but also from live load requirements. 
Refer Chapter 2 for more detail.
Collateral load applied on purlin such as Fire Sprinkler, MEP System, Plaster Ceiling System, etc. should be clearly 
specified as concentrated or uniformed load to identify the most dangerous case. 

Components Load Case Load Combination

Purlins Gravity Loads: DL , AL , 1WL

Windload: 1WL , 2EWL , 2EWL , 3WL
Case 1: DL AL LLr+ +

Case 2:	{ 1

2

0.6 0.6 0.6
0.6 0.6 0.6 E

DL AL WL
DL AL WL

+ +
+ +

Case 3:	{ 2

3

0.6 0.6 0.6
0.6 0.6 0.6

FDL AL WL
DL AL WL

+ +
+ +

Eave struts Gravity Loads: LLr , LLr

Rainload: 
1WL

Windload: 1WL , 2EWL , 2EWL , 3WL

Case 1: 	  DL LLr+

Case 2: 	  rDL P+

Case 2: 	  30.6 0.6DL WL+

Girts Gravity Loads: AL , AL , 4WL

Windload: 4WL , 5WL Case 1: 	  { 4

5

0.6 0.6 0.6
0.6 0.6 0.6

DL AL WL
DL AL WL

+ +
+ +
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Figure 7 2 Schematics of Purlin/Girt/Eave strut 
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The peak local pressures zones around the perimeter of  the roof  govern the purlin spacing these areas, and the 
purlins in end bays is usually adopted for the rest of  the roof  because of  the difference in loads and bending 
moments between end bays and internal span purlins. It is therefore advantageous for economical design to 
consider:
-	 Increased wall thicknesses in end span purlins, or
-	 Reduced end bay spacing, or
-	 Extra purlin spacing, extra purlins, or increase lapped length in end spans, provided this increases the 
design strength of  the purlins. 
It is necessary to provide bridging between purlins to reduce the effective lengths to control flexural-torsion 
buckling. BMB recommends at least one row or purlin bracing in every span, and that un-braced length be 
restricted to less than 20 times the section depth, or 4000 mm, whichever is less.

Standard purlins and girts cleats are generally used without analysis or design. Purlin cleats are subjected not only 
to axial load but also to bending moments. Angel cleats also provide greater robustness during transport and 
erection. One yardstick for robustness is that girt cleats should not yield when stood on by a heavy worker. This 
would equate to a 1.1 kN load applied to the tip of  the cleat with a 1.5 load factor to allow for dynamic effects as 
the worker climbs the steel work.
The standard bolt is an M12 Type 4.6. Refer Figure 7 6 for more details.

Flange Brace of  Purlin/Girt provide full restraint to the bottom flange of  the rafter, the effective length of  the 
rafter is taken as the distance between the flange braces in the calculation of  its member moment capacity. 
Using “Flange Bracing	Calculation Sheet” to check typical Flange Brace section V60x60x2.5 as below example:

The lapped length for Z-section purlins is a minimum of  10 percent of  the span.

Bay Spacing
< 8m

8 ÷ 9m
> 9m

Number of  purlin bracing
01
02
03

Table 7 1 Recommended purlin bracing each bay

7.1.2.3 Lapped Length

7.1.2.4 Purlin bolts

7.1.2.5 Flange Brace Checking
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Input 

Section properties

Checking ratio of  slenderness: (compressive member with  pin connection double end)

1 2.3
121 200

0.019
kL
r

×
= = < 	 	

Checking capacity the compression 

Flange Brace section

Yield strength: 235yF MPa=
Elastic modulus: 200000E MPa=

V60x60x2.5

Bending moment h 1057 kN

Height of  rafter h 1.65 m

Length of  Flange Brace 2l h= 2.33 m

Length coefficient k 1.00

Area 2.938E-4 m² 

Radius of  Gyration r 0.019 m

Elastic buckling stress

( )

2 2
2

2 2

3.14 2 8
1.3 5( / )

121/e
E EF E kN m

kL r
π ×

= = =
(AISC E3-4)

Critical stress
200000

4.71 4.71 113
345

kL E
r Fy

< = =

/ 20.658 1.14 5( / )y eF F
cr yF F E kN m= × =

(AISC E3-2, E3-3)

Capacity of  the 
compression member 1.14 5 2.938 4

[ ] 20
1.67 1.67

cr gu
F AP E EP kN

× × −
= = = =
Ω

(AISC E3-1)

The Transverse 
Compression load [ ]2% 0.02 1057/1.65 12.81

MP kN P
h

= = × = <
(AISC Section J1.4)

A
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7.1.3. Detailing Requirement

Figure 7 3 Flange Brace and Lapped Length Detail

Figure 7 4 Alternative Flange Brace at Expansion Joint Detail

Figure 7 5 Typical Purlin Bracing Details 
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Figure 7 6 Typical Purlin Cleat Details 
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NOTE	
For purlin Z300, C300, use X sag rod bridging. 
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Figure 7.7 Detail A – Sag rod at wall

Figure 7.9 Detail C – Sag rod at ridge

Figure 7.11 X - Sag rod

Figure 7.10 Detail D – Sag rod at roof

Figure 7.8 Detail B – Sag rod at eave
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The purpose of  this section is to provide information for gutter capacity, the spacing of  drainage downspouts 
(conductors), and secondary emergency overflow design for the roofs of  metal buildings.

Basic equation for rectangular gutter capacity:

Basic equation for downspout capacity:

Emergency overflow

Where roof  drains are required, secondary (emergency overflow) roof  drains or scuppers shall be provided where 
the roof  perimeter construction extends above the roof  in such a manner that water will be entrapped if  the 
primary drains allow buildup for any reason. 

Multiplier to modify drainage area based on roof  pitch

Roof  Drainage Area: L W B× ×

where:
Width of  roof  to be drained, ft.
Length of  gutter to be drained, ft.
Gutter width, ft.
Gutter depth, ft.
Rainfall intensity, in./hour. As per BMB&A standard I=250 mm/h.

R
L
w
d
I

B

(2012 MBSM, Eq. A4.3)

(2012 MBSM, Eq. A4.4)

[ ]

28
5 133 3

14
7 7 43200

0.481

w d
R IL

 
  × × ×  =  

 
  

[ ]
1200

I R LA × ×
=

Pitch Factor “B”
Level to 25% 1.00

> 25% to 40% 1.05
> 40% to 65% 1.10
> 65% to 90% 1.20
> 90% to 100% 1.30
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7.2.2. Example
Building Dimensions: 80m wide x 80m long (10 @ 8m bays). 

Symmetrical gable roof  configuration. Roof  slope: 5%.

Rainfall intensity: I=250 mm/h= 9.84 in./h

Solve

Width of  roof  to be drained:  8 26.25L m ft= =
Length of  gutter to be drained:  8 26.25L m ft= =
Factor:  1.00B =
Gutter Size 720(width x height): 0.18 0.202 0.59 0.66m m ft ft× = ×  
Gutter capacity:

Downspout capacity: Diameter 220mm thickness 6.6mm

[ ]

28
5 133 3

14
7 7 432000.59 0.66

131.23 9.84 0.3048 9 8 :
0.481

BL m L m OK

 
  × × × ×  = × = ≥ = 

 
  

[ ]
2

2 29.84 131.23 26.25 1 0.214
0.00064516 0.018 0.036 :

1200 4
A m A m OKπ× × ×

= × = > = =
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APPENDIX A: HOT ROLLED SECTION -

Table A.1 I Section

Table A.2 Channel Section

Section Weight (kg/m) Section Weight (kg/m)
I 150 × 75 × 5 ×7 14.0 H100 × 100 × 6 × 8 17.2

I 198 × 99 × 4.5 × 7 18.2 H125 × 125 × 6.5 × 9 23.8

I 200 × 100 × 5.5 × 8 21.3 H 150 × 150 × 7 × 10 31.5

I 248 × 124 × 5 × 8 25.7 H 194 × 150 × 6 × 8 30.6

I 250 × 125 × 6 × 9 29.6 H 175 × 175 × 7.5 × 11 40.4

I 298 × 149 × 5.5 × 8 32.0 H 200 × 200 × 8 × 12 49.9

I 300 × 150 × 6.5 × 9 36.7 H 244 × 175 × 7 × 11 44.1

I 346 × 174 × 6 × 9 41.4 H 250 × 250 × 9 × 14 72.4

I 350 × 175 × 7 × 11 49.6 H 294 × 200 × 8 ×12 56.8

I 400 × 200 × 8 ×13 66.0 H 300 × 300 × 10 × 15 94.0

I 450 × 200 × 9 × 14 76.0 H 350 × 350 × 12 × 19 137.0

I 496 × 199 × 9 × 14 79.5 H 390 × 300 × 10 × 16 107.0

I 500 × 200 × 10 × 16 89.6 H 400 × 400 × 13 × 21 172.0

I 600 × 200 × 11 × 17 106.0 H 482 × 300 × 11 × 15        114.0 

I 700 × 300 × 13 ×24 185.0 H 582 × 300 × 12 × 17        137.0 
H 588 × 300 × 12 × 20        151.0 

Section Weight 
(kg/m)

U 200 x 80 x 7.5 x 11 x 12m 24.60
U 250 x 90 x9 x 13 x 12m 34.60
U 300 x 90 x 9 x 13 x 12m 38.10
U 100 x 50 x5 x 6m 9.36
U 120 x 53 x 5.5 x 12m 12.06
U 140 x 58 x 6 x 12m 14.50
U 150 x 75 x 6.5 x 12m 18.60
U 160 x 56 x 5.2  x12m 12.50
U 160 x 65 x 8,5 x 12m 19.80
U 180 x 67 x 5.4 x 12m 15.00
U 200 x 73 x 7 x 12m 22.60
U 200 x 75 x 9 x 12m 23.60

U 250 x 78 x 7 x 12m 24.60

U 300 x 87 x 9.5 x12m 39.10
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Table A.3 Angle Section

Table A.4 Pipe Section

Section Weight (kg/piece) Section Weight (kg/piece)

V 25 x 3 x 6m 6.72 V 90 x 6 x 6m 51.0

V 30 x 3 x 6m 8.16 V90 x  7 x 6m 57.7

V 40 x 3 x 6m 11.10 V 90 x 8 x 6m 65.4

V 40 x 4 x 6m 14.52 V 100 x 7 x 6m 64.8

V 50 x 3 x 6m 13.92 V 100 x 8 x 6m 73.2

V 50 x 4 x 6m 18.30 V 100 x 10 x 6m 87.0

V 50 x 5 x 6m 22.62 V 120 x 8 x 12m  14.2

V 63 x 4 x 6m 23.40 V 120 x 10 x 12m 18.3

V 63 x 5 x 6m 28.86 V 120 x 12 x 12m 21.6

V 63 x 6 x 6m 34.32 V 130 x 10 x 12m  19.75

V 70 x  6 x 6m 38.34 V 130 x 12  x12m 23.4

V 70 x 7 x 6 m 44.34 V 150 x 10 x 12m  22.9

V 75 x 6 x 6m 41.34 V 150 x 12 x 12m   27.3

V 75 x 8 x 6m 54.12 V 150 x 15 x 12m   33.6

V 80 x 6 x 6m 44.16

V 80 x 8 x 6m 51.06

Section Weight (kg/piece) Section Weight (kg/piece)

Ø60 x 2.3 Ø76 x 5 Ø114 x 3.2 Ø168.3 x 5.4

Ø60 x 2.6 Ø90 x 2.3 Ø114 x 3.6 Ø168.3 x 5.56

Ø60 x 2.9 Ø90 x 2.5 Ø114 x 4 Ø168.3 x 6.35

Ø60 x 3 Ø90 x 2.7 Ø114 x 4.5 Ø168.3 x 6.55

Ø60 x 3.2 Ø90 x 2.9 Ø114 x 5 Ø168.3 x 7.11

Ø60 x 3.6 Ø90 x 3 Ø114 x 5.4 Ø219.1 x 3.96

Ø60 x 4 Ø90 x 3.2 Ø141.3 x 3.96 Ø219.1 x 4.78

Ø60 x 4.5 Ø90 x 3.6 Ø141.3 x 4.78 Ø219.1 x 5.16

Ø76 x 2.5 Ø90 x 4 Ø141.3 x 5.16 Ø219.1 x 5.56

Ø76 x 2.7 Ø90 x 4.5 Ø141.3 x 5.56 Ø219.1 x 6.35

Ø76 x 2.9 Ø90 x 5 Ø141.3 x 6.35 Ø219.1 x 6.55

Ø76 x 3.2 Ø114 x 2.5 Ø141.3 x 6.55 Ø219.1 x 7.11

Ø76 x 3.6 Ø114 x 2.7 Ø168.3 x 3.96 Ø219.1 x 8.18

Ø76 x 4 Ø114 x 2.9 Ø168.3 x 4.78

Ø76 x 4.5 Ø114 x 3 Ø168.3 x 5.16
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Table A.5 Tube in Square Section

Section W(kg/m) Section W(kg/m) Section W(kg/m)

□ - 20x20x1.2 0.7 □ - 80x80x4.5 10.3 □ - 250x250x9 66.5

□ - 20x20x1.6 0.87 □ - 90x90x2.3 6.23 □ - 250x250x12 86.8

□ - 25x25x1.2 0.87 □ - 90x90x3.2 8.51 □ - 250x250x16 112.4

□ - 25x25x1.6 1.12 □ - 90x90x4.5 11.7 □ - 300x300x6 54.7

□ - 25x25x2.3 1.53 □ - 90x90x6 15.1 □ - 300x300x9 80.6

□ - 25x25x3.2 1.98 □ - 100x100x2.3 6.95 □ - 300x300x12 106

□ - 30x30x1.2 1.06 □ - 100x100x3.2 9.52 □ - 300x300x16 138

□ - 30x30x1.6 1.38 □ - 100x100x4 11.7 □ - 300x300x19 160

□ - 30x30x2.3 1.73 □ - 100x100x4.5 13.1 □ - 350x350x6 64.1

□ - 30x30x3.2 2.48 □ - 100x100x6 17 □ - 350x350x9 94.7

□ - 40x40x1.6 1.88 □ - 100x100x9 24.1 □ - 350x350x12 124

□ - 40x40x2.3 2.62 □ - 100x100x12 30.2 □ - 350x350x16 163

□ - 40x40x3.2 3.49 □ - 125x125x3.2 12 □ - 350x350x19 190

□ - 50x50x1.6 2.38 □ - 125x125x4.5 16.6 □ - 400x400x9 109

□ - 50x50x2.3 3.34 □ - 125x125x5 18.3 □ - 400x400x12 143

□ - 50x50x3.2 4.5 □ - 125x125x6 21.7 □ - 400x400x14 166

□ - 50x50x4.5 60.2 □ - 125x125x9 31.1 □ - 400x400x16 188

□ - 50x50x6 7.56 □ - 125x125x12 39.7 □ - 400x400x19 220

□ - 60x60x2.3 4.06 □ - 150x150x4.5 20.1 □ - 400x400x22 251

□ - 60x60x3.2 5.5 □ - 150x150x6 26.4 □ - 450x450x9 122

□ - 60x60x4.5 7.43 □ - 150x150x9 38.2 □ - 450x450x12 160

□ - 60x60x6 9.45 □ - 175x175x4.5 23.7 □ - 450x450x16 209

□ - 75x75x2.3 5.14 □ - 175x175x6 31.1 □ - 450x450x19 250

□ - 75x75x3.2 7.01 □ - 200x200x4.5 27.2 □ - 450x450x22 286

□ - 75x75x4.5 9.55 □ - 200x200x6 46.9 □ - 500x500x12 181

□ - 75x75x6 12.3 □ - 200x200x9 52.3 □ - 500x500x16 238

□ - 80x80x2.3 5.5 □ - 200x200x12 67.9 □ - 500x500x19 280

□ - 80x80x3.2 7.51 □ - 250x250x6 45.2 □ - 500x500x22 320
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Table A.6 Tube in Rectangular Section

Table A.7 Downspout 

Section W(kg/m) Section W(kg/m) Section W(kg/m)

□ - 30x20x1.6 1.38 □ - 75x45x2.3 4.06 □ - 150x75x6 19.34 

□ - 30x20x2.3 1.53 □ - 75x45x3.2 5.50 □ - 150x100x3.2 12.00 

□ - 30x20x3.2 1.98 □ - 75x45x4.5 7.43 □ - 150x100x4.5 16.60 

□ - 40x20x1.6 1.38 □ - 75x50x2.3 4.24 □ - 150x100x6 21.70 

□ - 40x20x2.3 1.73 □ - 75x50x3.2 5.75 □ - 150x100x9 31.10 

□ - 40x20x3.2 2.47 □ - 75x50x4.5 7.79 □ - 200x100x4.5 20.10 

□ - 50x20x1.6 1.63 □ - 75x50x6 9.92 □ - 200x100x6 26.40 

□ - 50x20x2.3 2.25 □ - 100x50x2.3 5.14 □ - 200x100x9 38.20 

□ - 50x30x1.6 1.88 □ - 100x50x3.2 7.01 □ - 200x150x4.5 23.70 

□ - 50x30x2.3 2.62 □ - 100x50x4.5 9.55 □ - 200x150x6 31.10 

□ - 50x30x3.2 3.49 □ - 100x50x6 12.30 □ - 200x150x9 45.30 

□ - 50x30x4.5 4.61 □ - 125x75x2.3 6.95 □ - 250x150x6 35.80 

□ - 60x30x1.6 2.13 □ - 125x75x3.2 9.52 □ - 250x150x9 52.30 

□ - 60x30x2.3 2.98 □ - 125x75x4.5 13.10 □ - 250x150x12 67.90 

□ - 60x30x3.2 3.99 □ - 125x75x6 17.00 □ - 300x200x6 45.20 

□ - 60x40x1.6 2.38 □ - 150x50x2.3 6.95 □ - 300x200x9 66.50 

□ - 60x40x2.3 3.34 □ - 150x50x3.2 9.53 □ - 300x200x12 86.80 

□ - 60x40x3.2 4.50 □ - 150x50x4.5 13.10 □ - 400x200x6 54.70 

□ - 75x20x1.6 2.25 □ - 150x50x6 17.00 □ - 400x200x9 80.60 

□ - 75x20x2.3 3.16 □ - 150x75x3.2 10.80 □ - 400x200x12 106.00 

□ - 75x45x1.6 2.88 □ - 150x75x4.5 14.90 

Size Diameter (m) Thickness (m)

[]110x95 0.110 x 0.095 -

Ø90 x 2.9 0.090 0.0029

Ø114 x 3.8 0.114 0.0038

Ø168 x 4.3 0.168 0.0073

Ø220 x 6.6 0.220 0.0066

Ø250 x 7.3 0.250 0.0073

Ø280 x 8.2 0.280 0.0082

Ø315 x 9.2 0.315 0.0092

Ø400 x 11.7 0.400 0.0117
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Capacity 2,500 MT/month
Binh Duong - Viet Nam

Capacity 750 MT/month
Binh Duong - Viet Nam

Capacity 750 MT/month
Hung Yen - Viet Nam

Capacity 1,000 MT/month
Binh Duong - Viet Nam

Philippines office 

54 Sukhumvit Road (Asoke), North Klongtoey, 
Wattna, Bangkok 10110                        
+66 2664 4493 
+66 2664 4492 

Tel
Fax

Tel

14th Floor, Unit 1415 AIC Burgundy Empire Tower,
ADB Avenue Corner, Garnet Road, Ortigas Center,
Pasig City, Philippines

(+632) 470 7633 / 33 / 34


